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Copyright
This manual is copyrighted by Canon Computer Systems, Inc. (CCSI)
with all rights reserved. Under the copyright laws, this manual may not
be reproduced in any form, in whole or part, without prior written
consent of CCSI.

©1997 Canon Computer Systems, Inc.

Disclaimer
Canon Computer Systems, Inc. has reviewed this manual thoroughly in
order to make it an easy to use guide for your Canon MultiPASS C5000
system. All statements, technical information, and recommendations in
this manual and in any guides or related documents are believed reliable,
but the accuracy and completeness thereof are not guaranteed or
warranted, and they are not intended to be, nor should they be
understood to be, representations or warranties concerning the products
described.

Your MultiPASS C5000 and the software media included with your
system have been sold to you subject to the limited warranties set forth
in the warranty and license agreement enclosed with the respective
product. All software is licensed AS IS, as described in the license
agreement enclosed with the software media. Further, CCSI reserves the
right to make changes in the specifications of the products described in
this manual at any time without notice and without obligation to notify
any person of such changes.

Trademarks
Canon and BJ are registered trademarks and MultiPASS, ScanGear,
UHQ, and Bubble Jet are trademarks of Canon Inc.

HALO Imaging Library is a trademark of Media Cybernetics, L.P.
HIL © Copyright 1994 Media Cybernetics, L.P.

Other brand and product names may be trademarks or registered
trademarks of their respective companies.

As an ENERGY STAR® Partner, Canon U.S.A., Inc. has determined that the 
MultiPASS C5000 meets the ENERGY STAR guidelines for energy
efficiency.
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USERS IN U.S.A.

PRE-INSTALLATION REQUIREMENTS FOR CANON
FACSIMILE EQUIPMENT
A. Location

Supply a suitable table, cabinet, or desk. See Appendix A for the unit’s
dimensions and weight.

B. Order Information
1. Only a single line, touch-tone or rotary telephone set is to be used.

2. Order an RJ11-C modular jack (USOC code), which should be
installed by the phone company. If the RJ11-C jack is not present,
installation cannot occur.

3. Order a normal business line from your telephone company’s business
representative. The line should be a regular voice grade line or
equivalent. Use one line per unit.

DDD (DIRECT DISTANCE DIAL) LINE
or
IDDD (INTERNATIONAL DIRECT DISTANCE DIAL) LINE IF YOU
COMMUNICATE OVERSEAS

N Canon recommends an individual line following industry standards [e.g., the
2500 (touch-tone) or 500 (rotary/pulse dial) telephones]. A dedicated extension
off a PBX unit without “Call Waiting” can be used with your MultiPASS C5000.
Key telephone systems are not recommended because they send non-standard
signals to individual telephones for ringing and special codes, which may cause
a fax error.

C. Power Requirements
This equipment should be connected to a standard 120 volt AC, three-wire
grounded outlet only. Do not connect this unit to an outlet or power line
shared with other appliances that cause “electrical noise.” Air conditioners,
electric typewriters, copiers, and machines of this sort generate noise which
often interferes with communications equipment and the sending and
receiving of documents.

CONNECTION OF THE EQUIPMENT
This equipment complies with Part 68 of the FCC rules. On the rear panel of
this equipment is a label that contains, among other information, the FCC
Registration Number and Ringer Equivalence Number (REN) for this
equipment. If requested, this information must be given to the telephone
company. This equipment may not be used on coin service provided by the
telephone company. Connection to party lines is subject to state tariffs.
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IN CASE OF EQUIPMENT MALFUNCTION
Should any malfunction occur which cannot be corrected by the procedures
described in this User’s Manual, disconnect the equipment from the telephone
line or unplug the power cord. The telephone line should not be reconnected or
the power cord plugged in until the problem is completely resolved. Users
should contact Canon Authorized Service Facilities for servicing of equipment.
Information regarding Authorized Service Facility locations can be obtained by
calling the Canon Computer Systems Customer Care Center. (See page 1-4 for
details.)

RIGHTS OF THE TELEPHONE COMPANY
Should the equipment cause harm to the telephone network, the telephone
company may temporarily disconnect service. The telephone company also
retains the right to make changes in facilities and services which may affect the
operation of this equipment. When such changes are necessary, the telephone
company is required to give adequate prior notice to the user.

WARNING
Do not make any changes or modifications to the equipment unless otherwise
specified in the manual. If such changes or modifications should be made, you
could be required to stop operation of the equipment.

N This equipment has been tested and found to comply with the limits for a Class
B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed
to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency
energy and, if not installed, and used in accordance with the instructions, may
cause harmful interference to radio communications.

However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off
and on, the user is encouraged to try to correct the interference by one of the
following measures:
● Reorient or relocate the receiving antenna.
● Increase the separation between the equipment and receiver.
● Connect the equipment into an outlet on a circuit different from that to

which the receiver is connected.
● Consult the dealer or an experienced radio/TV technician for help.

The Telephone Consumer Protection Act of 1991 makes it unlawful for any
person to use a computer or other electronic device to send any message via a
telephone fax machine unless such message clearly contains in a margin at the
top or bottom of each transmitted page or on the first page of the transmission,
the date and time it is sent and an identification of the business or other entity,
or other individual sending the message and the telephone number of the
sending machine or such business, other entity, or individual.

To automatically enter this information into your MultiPASS C5000, follow the
instructions in your Quick Start Guide.
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USERS IN CANADA

PRE-INSTALLATION REQUIREMENTS FOR CANON
FACSIMILE EQUIPMENT
A. Location

Supply a suitable table, cabinet, or desk. See Appendix A for the unit’s
dimensions and weight.

B. Order Information
1. Provide only a single-line to touch-tone or rotary telephone set

terminated with a standard 4-pin modular phone plug. (Touch-tone is
recommended if available in your area.) 

2. Order an RJ11-C modular jack (USOC code), which should be
installed by the phone company. If the RJ11-C jack is not present,
installation cannot occur.

3. Order a normal business line from your telephone company’s business
representative. The line should be a regular voice grade line or
equivalent. Use one line per unit.

DDD (DIRECT DISTANCE DIAL) LINE
or
IDDD (INTERNATIONAL DIRECT DISTANCE DIAL) LINE IF YOU
COMMUNICATE OVERSEAS

N Canon recommends an individual line following industry standards [e.g., the
2500 (touch-tone) or 500 (rotary/pulse dial) telephones]. A dedicated extension
off a PBX unit without “Camp On” signals is also permissible with your
MultiPASS C5000. Key telephone systems are not recommended because they
send non-standard signals to individual telephones for ringing and special
codes, which may cause a fax error.

C. Power Requirements
The power outlet should be a three-prong grounded receptacle (Single or
Duplex). It should be independent from copiers, heaters, air conditioners,
or any electric equipment that is thermostatically controlled. The rated
value is 120 volts and 15 amperes. The RJ11-C modular jack should be
relatively close to the power outlet to facilitate installation.

NOTICE
The Industry Canada label identifies certified equipment. This certification
means that the equipment meets telecommunications network protective,
operational and safety requirements as prescribed in the appropriate Terminal
Equipment Technical Requirements document(s). The Department does not
guarantee the equipment will operate to the user’s satisfaction.
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Before installing this equipment, users should ensure that it is permissible to be
connected to the facilities of the local telecommunications company. The
equipment must also be installed using an acceptable method of connection.
The customer should be aware that compliance with the above conditions may
not prevent degradation of service in some situations.

Repairs to certified equipment should be coordinated by a representative
designated by the supplier. Any repairs or alterations made by the user to this
equipment, or equipment malfunctions, may give the telecommunications
company cause to request the user to disconnect the equipment.

Users should ensure for their own protection that the electrical ground
connections of the power utility, telephone lines and internal metallic water
pipe system, if present, are connected together. This precaution may be
particularly important in rural areas.

CAUTION
Users should not attempt to make such connections themselves, but should
contact the appropriate electric inspection authority, or electrician, as
appropriate.

The Ringer Equivalence Number (REN) assigned to each terminal device
provides an indication of the maximum number of terminals allowed to be
connected to a telephone interface. The termination on an interface may consist
of any combination of devices subject only to the requirement that the sum of
the Ringer Equivalence Numbers of all the devices does not exceed 5.

CANON CANADA INC.
1-800-263-1121

24 HOURS A DAY, SEVEN DAYS A WEEK
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Using Your Documentation
The following documentation is supplied with the MultiPASS™ C5000
to help you use your new Canon multi-talented color printer.

Quick Start Guide
This booklet describes how you unpack, set up, and start using your
MultiPASS C5000. It includes how to install the software that comes
with the MultiPASS C5000, including the MultiPASS Printer Driver,
MultiPASS Desktop Manager for Windows, ScanGear™ for MultiPASS,
and Pagis™ for MultiPASS. The software enables you to use all the
features of the MultiPASS C5000—color printing, color scanning, color
copying, and PC faxing.

User’s Manual
This manual offers detailed information on how to operate your
MultiPASS C5000. It includes how to use the MultiPASS C5000 as a
monochrome or color printer, stand-alone plain paper fax, PC fax, color
scanner, and color copier. It also includes maintenance, troubleshooting,
and specifications.

Conventions
This User’s Manual uses the following conventions to alert you to
information that will help you operate the MultiPASS C5000 correctly
and safely:

N Notes provide advice or suggestions regarding the use of the 
MultiPASS C5000.

C Cautions alert you to operations that could cause damage to your
hardware or software, or cause injury to yourself.
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Distinctive typefaces identify the buttons you press, the lights on the
operator panel, and any commands you enter at your computer.

❍ The buttons you press appear in this typeface: START/COPY.

❍ The names of lights you see appear in this typeface: ALARM.

❍ What you see in the LCD display appears in this typeface:
REGISTRATION.

❍ When you type something on your computer, it appears in this
typeface: DIR/P .

In general, the MultiPASS Desktop Manager screens and the MultiPASS
Printer Driver screens you see in this manual are from Microsoft® 
Windows® 95.
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Thank you for purchasing the Canon MultiPASS™ C5000—the multi-
talented color printer for your home office and the whole family. We 
are sure that your MultiPASS C5000 will provide all you need in one
machine: Color Bubble Jet™ printer, color scanner, color copier, plain
paper fax, and PC fax.

This chapter introduces you to the MultiPASS C5000. It includes:

❍ Supplies and accessories

❍ Getting help from Canon

❍ Important safety instructions

❍ Examining the main components of the unit

❍ Using the operator panel

❍ Loading paper in the sheet feeder

❍ Preparing documents for faxing, copying, or scanning

❍ Identifying your documents

In
tr

od
uc

tio
n

1Introduction



1-2 Introduction Chapter 1

Supplies and Accessories
Your MultiPASS C5000 supports excellent and unique print media
options that will allow you to produce dazzling, professional, and fun
presentations. All of these print media are specially designed and
manufactured to work with your Canon MultiPASS C5000 so you can
produce the finest output possible.

Canon has an extensive dealer network equipped to offer you supplies as
you need them. To find a dealer near you, call the Canon Referral
Service at 1-800-848-4123.

If supplies are not available from your local dealer, you can order
directly from Canon by calling 1-800-385-2155.

BJ Cartridges and BJ Tanks
Your MultiPASS C5000 comes with:

❍ One BC-21e Color BJ® Cartridge

❍ One SB-21 Ink Cartridge Storage Box

❍ One extra BCI-21 Black BJ Tank

You can also purchase the following BJ cartridges for use with the
MultiPASS C5000:

❍ BC-20 Black BJ Cartridge 

❍ BC-22e Photo BJ Cartridge 

❍ BC-29F Neon BJ Cartridge 

You can purchase the following BJ tanks for use in the BC-21e Color 
BJ Cartridge:

❍ BCI-21 Black BJ Tank (one extra BJ tank comes with the printer)

❍ BCI-21 Color BJ Tank
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N BJ cartridges contain the Bubble Jet print head and ink, while BJ tanks
contain ink only. Some BJ cartridges, like the BC-21e Color BJ
Cartridge, contain replaceable BJ tanks; when you run out of ink, you
can replace the empty tank. Some BJ cartridges, like the BC-20 Black BJ
Cartridge, contain both the print head and ink; when you run out of
ink, you replace the entire BJ cartridge. See Chapter 9, Maintaining the
MultiPASS C5000, for details on replacing BJ cartridges and BJ tanks.

N Canon has more engineers dedicated to creating quality ink for
providing the best results for output on Bubble Jet products than any
other organization. Canon does not prohibit the use of third-party inks
and the use of third-party inks does not invalidate the product’s limited
warranty. However, Canon cannot guarantee the quality or performance
of your MultiPASS C5000 when you are using inks from other suppliers.

Canon’s limited warranty does not cover damage caused to Canon’s
Bubble Jet products that is attributable to the use of third party parts or
supplies, including inks. The limited warranty remains in effect for its
life once that particular damage has been properly repaired.

For optimum printing results, Canon recommends that you use only
Canon ink cartridges.

Canon Specialty Papers
Canon manufactures numerous specialty papers, including:

❍ Glossy Photo Paper GP-201

❍ High Resolution Paper HR-101

❍ T-Shirt Transfers TR-101

❍ Greeting Cards GC-101

❍ Bubble Jet Paper LC-301 (water resistant)

❍ Fabric Sheet FS-101

❍ Back Print Film BF-102

❍ High Gloss Film HG-101

❍ CF-102 Transparencies

See Chapter 2, Printing With the MultiPASS C5000, for details on
Canon’s Specialty Papers.
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You can also purchase the optional Canon BC-22e Photo Kit, which
includes everything you need to produce photo-realistic images:

❍ BC-22e Photo BJ Cartridge 

❍ SB-21 Ink Cartridge Storage Box

❍ Canon High Resolution Paper HR-101 (60 sheets)

Getting Help From Canon
Canon Computer Systems, Inc. offers a full range of customer technical
support options including*:

❍ 24-hour, 7-day-a-week, toll-free automated support for troubleshooting
issues on most current products (1-800-423-2366)

❍ Speak to a technician free of service charge (currently Monday
through Friday, 8:00 A.M. to 10:00 P.M. EST and Saturday,
12:00 P.M. to 6:00 P.M. EST, excluding holidays) for products 
still under warranty** (1-757-413-2848)

❍ Speak to a technician (currently $24.99) during holidays and
days/hours not listed above regarding urgent product questions or
for products no longer under warranty (1-800-423-2366)

❍ E-mail support via the Canon Computer Systems, Inc. Web site
(www.ccsi.canon.com)

❍ 24-hour, toll-free Fax Retrieval System (1-800-526-4345)

❍ 24-hour Bulletin Board Service (1-757-420-2000)

*Support program specifics subject to change without notice.
**Refer to individual product information for warranty details.

Canon Canada
Customer support for Canadian residents is available 24 hours a day
(seven days a week) at 1-800-263-1121.

In other countries, please contact your Canon dealer.
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Servicing the MultiPASS C5000
The Canon MultiPASS C5000 is designed with the latest technology to
provide trouble-free operation. The warranty card that comes with your
system describes Canon’s limited warranty, which includes the
InstantExchange warranty program. Be sure to read the warranty
information to find out about the different service options available to
you.

Save the warranty and keep your sales receipt for proof of purchase. In
the event that your MultiPASS C5000 needs servicing, you will need 
your proof of purchase to obtain warranty service.

Be sure to fill out the Registration card and send it in. This will help
Canon give you better support and warranty service.

If you seem to have a problem, try to solve it by referring to the
troubleshooting information in Chapter 10. If you cannot solve the
problem, contact the Canon Computer Systems Customer Care Center
(see previous page for details).

Important Safety Instructions
Read these safety instructions and refer to them later if you have any
questions.

C Except as explained in this manual, do not attempt to service the
MultiPASS C5000 yourself. Opening and removing interior covers may
expose you to dangerous voltage points or other risks. Refer all servicing
to a Canon Authorized Service Facility (ASF). Call the Customer Care
Center for details.

❍ Follow all warnings and instructions marked on the MultiPASS
C5000 and inside the printer cover.

❍ Place the MultiPASS C5000 on a sturdy level surface. Do not place it
on an unstable cart, stand, or table. If the unit falls, it could be
seriously damaged.

❍ Do not use the MultiPASS C5000 near water. If you spill liquid on 
or into the unit, unplug it immediately and call the Customer Care
Center.
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❍ Slots and openings in the cabinet and the back or bottom are
provided for ventilation. To ensure reliable operation of the
MultiPASS C5000 and to protect it from overheating, do not block
or cover these openings. Do not block the openings by placing the
unit on a bed, sofa, rug, or other similar surface. Do not place the
unit near a radiator, nor in a closet or built-in cabinet unless proper
ventilation is provided.

❍ Operate the MultiPASS C5000 only from the type of power source
indicated on the unit’s label. If you are not sure of the type of power
available, consult your dealer or local power company.

❍ Do not allow anything to rest on the power cord, and do not locate
the MultiPASS C5000 where the cord will be walked on. Make sure
the power cord is not knotted or kinked.

❍ Do not push metal objects of any kind into the slots or openings on
the cabinet. This could result in a risk of fire or electric shock.

❍ Do not allow small objects (such as pins, paper clips, or staples) to
fall into the MultiPASS C5000. If something does fall into it that you
cannot remove, unplug the unit immediately and call the Customer
Care Center.

❍ Unplug this product from the wall outlet and call the Customer Care
Center if any of the following conditions exist:

• The power cord or plug is damaged or frayed.

• Liquid is spilled into the unit, or if the unit is exposed to rain 
or water.

• Smoke, unusual noises, or odors come from the unit.

• The unit has been dropped or the cabinet has been damaged.

• The unit does not operate normally when you have followed the
operating instructions. Adjust only those controls that are
covered by the operating instructions in the Quick Start Guide
and this User’s Manual. Improper adjustment of other controls
may result in damage and may require extensive work by a
qualified technician to restore the product to normal operation.
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Main Components of the MultiPASS C5000
Before using the MultiPASS C5000, it’s a good idea to familiarize
yourself with the components and understand their functions.

Front View
SENDING DOCUMENT SUPPORT
HOLDS DOCUMENTS AS THEY FEED
INTO ADF

PAPER GUIDES
ADJUST TO WIDTH
OF DOCUMENT TO
BE SCANNED

AUTOMATIC DOCUMENT
FEEDER (ADF) AND
PRINTER COVER
HOLDS DOCUMENTS 
TO BE SCANNED (UP
TO 20 SHEETS)

OPERATOR PANEL
USE TO CONTROL
THE MultiPASS C5000

SHEET FEEDER
HOLDS 100 SHEETS
OF PLAIN PAPER

OUTPUT TRAY
HOLDS PRINTED DOCUMENTS AS
THEY EXIT THE MultiPASS C5000

PAPER OUTPUT GUIDES
HOLD HIGH RESOLUTION
PAPER WHEN USING THE 
BC-22e PHOTO BJ CARTRIDGE

OUTPUT TRAY EXTENSION
HOLDS PRINTED DOCUMENTS AS
THEY EXIT THE MultiPASS C5000

DOCUMENT SUPPORT
HOLDS SCANNED
DOCUMENTS AS 
THEY EXIT THE
MultiPASS C5000

PAPER REST
SUPPORTS PAPER
STACKED IN THE
SHEET FEEDER



Back View

Inside the Printer Area
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LINE JACK TELEPHONE/
ANSWERING
MACHINE
JACK

PARALLEL CABLE
CONNECTOR

MANUAL FEED
SLOT

POWER CORD
CONNECTOR

PAPER THICKNESS LEVER

CARTRIDGE HOLDER

PRINTER COVER
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Using the Operator Panel
This section presents a brief description of the operator panel on the
MultiPASS C5000.

Document feed lever
Set this lever to the left ( ) for automatic feed or to the right ( ) for
manual document feed.

COLOR COPY button
Use this button to change the resolution when making color copies using
the operator panel. This button is in operative for fax transmissions. For
color scanning, change the resolution from Pagis for MultiPASS.

LCD display
Displays messages and prompts during operation. Displays selections,
text, numbers, and names when registering information.

9

11

3

4

5

6

7
8

1

1

2

2

3

ONE-TOUCH SPEED DIAL/
FUNCTION BUTTONS

B&W FAX/COPY

LCD
DISPLAY

ALARM

STOP

START/STOP
CODED DIAL

10 REDIAL/PAUSE

DOCUMENT FEED
LEVER

NUMBER BUTTONS

COLOR COPY
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B&W FAX/COPY button
Use this button when sending faxes or making copies in black and white
only. For black and white scanning, set the resolution from the
MultiPASS Desktop Manager.

One-touch Speed Dial/Function buttons
Use for one-touch speed dialing, entering user information, printing
documents stored in memory, and cleaning the print head. (See page 
1-11 for details.)

STOP button
Press to cancel sending, receiving, or any other operation.

ALARM light
Flashes when an error occurs, when the MultiPASS C5000 is out of
paper or ink, or when received faxes are stored in memory.

START/COPY button
Press to begin sending, receiving, copying, or other operations, or to
select functions when registering information.

CODED DIAL button
Press this button (followed by a two-digit code) to dial a number that
you have registered for coded speed dialing.

REDIAL/PAUSE button
Press to redial the last number that was dialed using the number
buttons, or to enter pauses between digits when dialing fax numbers.

Number buttons
Use these buttons to enter numbers and names when registering
information, and to dial fax/telephone numbers that are not registered
for automatic dialing.

5

6

7

8

9

10

11

4
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Special Function Buttons

FUNCTION button
Use to register user settings, to run the print head cleaning process, or to
print faxes stored in the MultiPASS C5000’s memory.

CARTRIDGE button
Press to move the BJ cartridge holder to the center of the unit when
installing or replacing the cartridge. (Press again after installing the
cartridge to move the holder back to its home position on the right.)

RESUME button
Press when you want to form-feed paper when printing.

PRINTER RESET button
Press to reset the MultiPASS C5000 to Standby mode if the LCD displays
PRINTER MODE.

Arrow buttons
Use to scroll through menu selections, or to move the cursor when
registering data.
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Loading Paper in the Sheet Feeder
The paper you load in the sheet feeder is used for printing documents 
or for incoming faxes. For printing documents, you can use any of
the Canon Specialty Papers described in Chapter 2, Printing With the
MultiPASS C5000. For receiving faxes, use plain paper (such as copier
paper).

When the message LOAD PAPER appears in the LCD display, you need to
add paper to the sheet feeder.

The sheet feeder holds approximately 100 sheets of plain paper.

❍ For best results, fan the paper before loading it.

❍ Always fan a stack of paper along the edge that will feed
into the MultiPASS first.

❍ Pull the paper rest up until it stops.Make sure the
paper rest 

is extended.

Fan the paper.
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❍ Align the edge of the paper with the right edge of the
sheet feeder.

❍ Secure the stack with the paper guide.

Preparing Documents for Faxing, 
Copying, or Scanning

You can use the MultiPASS C5000 to fax, copy, or scan documents that
are printed on standard letter, legal, or A4 size paper. Follow these
guidelines to prepare your documents.

❍ Do not attempt to feed the following types of documents into the
MultiPASS C5000:

• wrinkled or creased paper

• curled or rolled paper

• torn paper

• carbon-paper or carbon-backed paper

• coated paper

• onion skin or thin paper

Slide the stack of
paper into the

sheet feeder 
until it stops.
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❍ Remove all staples, paper clips, and the like before feeding the
document.

❍ Make sure any glue, ink, or correction fluid on the paper is
completely dry before feeding the document.

❍ Make a photocopy of any document that will not feed into the
MultiPASS C5000. You can then feed the copy.

❍ Do not feed documents with pages that are different sizes or of
different thicknesses.

Loading the Document 
You can load up to 20 letter or A4 size sheets and up to 10 legal size
sheets at a time into the Automatic Document Feeder (ADF).

❍ For a multiple-page document, fan the sheets and tap the
document on a flat surface to even the stack.

Stack your
documents.
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❍ Insert the document face-down (letterhead first) into the
ADF until you hear a beep.

❍ Adjust the document guides to the width of the
document.

The MultiPASS C5000 automatically feeds the pages one by one from
the bottom.

If you have problems feeding multiple-page documents, insert the pages
one at a time into the ADF. This stacks the pages on a slant so they feed
correctly into the ADF. (Do not attempt to stack more than 20 sheets in
the ADF.)

Feed the
document.
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Adding Pages to the Document
If you want to add pages while the MultiPASS C5000 is sending a
document, wait until the last page is feeding into the MultiPASS C5000
and then insert the new sheets. Insert the first new page so it overlaps
the last page by about one inch (2.5 cm).

Always wait until the last page is being fed into the MultiPASS C5000
before you add new pages.

Setting the Document Feed Lever
You use the document feed lever on the ADF to select multiple
documents ( ) or single sheets ( ).

Always set the document feed lever to single sheets and manually feed
the following types of documents:

❍ Thick paper
❍ Thin paper
❍ Small documents (postcards, business cards)
❍ Documents with uneven surfaces
❍ Photographs
❍ Special types of paper

DOCUMENT FEED LEVER
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Identifying Your Documents
When sending a document, the following information is printed out by
the receiving fax: your fax number, your name, and the current date and
time. This information is called your TTI (Transmit Terminal
Identification) and appears at the top of the faxed document in small
type.

N In the United States, you are required by FCC regulations to include this
information every time you send a fax.

By identifying the documents you send, the receiving party will
recognize your fax messages at a glance. The illustration below shows a
sample document with the identifying information.

The top line includes the name of the receiving party if you send the
document using one-touch speed dialing, coded speed dialing, or group
dialing and you registered the party’s name. It also includes the page
number.

N You entered your fax header information during the MultiPASS
installation procedure. If you followed the installation procedure, this
information will be printed on the top of your outgoing faxes. If you did
not install the MultiPASS Desktop Manager, see Appendix B, Using the
MultiPASS C5000 as a Stand-alone Fax, for details on how to enter this
information.
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THE PAGE NUMBER
THE NAME OF THE
PARTY WHO IS
RECEIVING THE
DOCUMENT

YOUR NAME OR
COMPANY NAME

YOUR FAX/
TELEPHONE
NUMBER

THE DATE AND
TIME YOU SENT
THE DOCUMENT

04/06/96  10:10   FAX 800 526-4345    CANON FAX BACK    JOHN DOE
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This chapter describes how to use the MultiPASS C5000 to print your
documents. Once you have installed the MultiPASS Desktop Manager,
you can use the MultiPASS C5000 for all your printing needs.

This chapter describes:

❍ Paper handling

❍ Installing a printer driver

❍ Printing a document

❍ Printer setup within Windows

❍ Printing speed versus color

❍ Setting the paper thickness lever

❍ Printer settings for various print media

❍ Loading paper

❍ Printing on envelopes

❍ Printing on Canon Specialty Papers

2Printing With the 
MultiPASS C5000
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Paper Handling
One of the most important things you can do to assure the best possible
printing performance of your MultiPASS C5000 is to select the correct
paper. Your MultiPASS C5000 produces letter quality print on most
plain bond papers, including cotton bond and photocopying papers; it
does not require special ink jet papers. However, the print quality varies
with different paper types. Be sure to test a type of paper before you
purchase a large quantity.

Selecting Paper Types
Plain Paper
The MultiPASS C5000 supports paper sizes of letter, legal, and A4 in
portrait orientation. You can use regular copier paper, cotton bond
papers, and typical letterhead. Always use paper without curls, folds,
staples, or damaged edges.

Glossy Photo Paper
Canon Glossy Photo Paper GP-201 is a high gloss, thicker paper that
produces the look and feel of a photograph. Use this paper with the 
BC-22e Photo BJ Cartridge to produce photo-realistic prints from your
printer. (Select Glossy Paper in the printer driver when you have this
paper loaded.)

High Resolution Paper
The Canon High Resolution Paper HR-101 is designed to produce
photo-realistic quality output with sharp and vivid graphics. For best
results, use the optional BC-22e Photo BJ Cartridge to produce images
comparable to your favorite photographs.

T-Shirt Transfers
Use Canon’s popular T-Shirt Transfers TR-101 to create and personalize
T-shirts, sweatshirts, aprons, tablecloths, napkins, tote bags, and
anything else your imagination allows! Use on any cotton or cotton/poly
blend fabric. Your image is printed in mirror image (when you use 
T-Shirt Transfer mode through the MultiPASS printer driver for
Windows) so when you iron it onto the T-shirt, the image is viewed
correctly.

Greeting Cards
Get the most out of your Canon Creative or other card-making software
with Canon Greeting Cards GC-101. These cards give your unique,
personalized cards the look and feel of professional cards. You can create
cards, invitations, announcements, and more.
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Bubble Jet Paper (water resistant)
The Canon Bubble Jet Paper LC-301 has been developed for high quality
printing with minimal or no smearing or running when in contact with
water or damp surfaces, making it a good choice for damp or rainy
environments. The paper is specially coated and printable on both sides.
(Select Plain Paper in the printer driver when you have this paper
loaded.)

Fabric Sheets
Use Fabric Sheet FS-101 for Canon Bubble Jet products to print banners,
pillow covers, scarves, flags, and other textile items. Use these sheets for
appliqués and other craft and sewing projects. Fabric sheets are 9.5 × 14
inches.

Back Print Film
Canon Back Print Film BF-102 has been specially developed for Canon
Color Bubble Jet printers and MultiPASS products. The film is designed
to deliver brilliant, high-intensity color images suitable for business
presentations, design work, or professional reports. Back print film is
printed on the back (nonglossy) side of the film in mirror image and
then viewed from the front (glossy) side using a backlighting device. For
more details, ask a Canon Authorized Dealer for information or refer to
the manual supplied with the film.

High Gloss Film
The Canon High Gloss Film HG-101 features a bright white finish that
lends striking visual power to charts, graphs, and photographic images.
Use this film to make your presentation materials and graphics look
professional.

Transparencies
CF-102 Transparencies from Canon are recommended. These
transparencies produce excellent contrast, sharpness, and color.

Assorted Paper Starter Kit
If you would like to try some of the papers described above, look 
for Canon’s Starter Kit (SK-101). It contains an assortment of five 
paper types.

N If you are printing in an application outside Windows, your software
application or printer driver must support mirror image printing in
order to use Back Print Film or T-Shirt Transfers.
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Paper Guidelines
When selecting or loading paper, please remember the following:

❍ Attempting to print on damp, curled, wrinkled, or torn paper can
cause paper jams and poor print quality.

❍ Use cut-sheet paper only. You cannot use multipart paper.

❍ When using graph paper, the lines may not match because the 
1/6-inch line spacing of the printer is slightly less than that of
graph paper.

❍ If the print density of your page is very high, light paper stock may
curl slightly due to the large amount of ink. If you need to print
dense graphics, try printing on heavier stock.

❍ Do not use thicker paper than meets the specifications for this
printer. Printing with a paper that is thick enough to come in
contact with the print head nozzles may damage the BJ cartridge.

Installing a Printer Driver
Before you can use any type of printer with your computer, you must
install a printer driver. The printer driver tells the computer what kind
of a printer you are using. The printer driver also controls the various
settings, such as print quality and paper type. You define these settings
within the printer driver, and the printer driver then communicates the
settings to both the computer and the printer.

You must install the MultiPASS Printer Driver for Windows and the
MultiPASS Desktop Manager before you can use the MultiPASS C5000
as a printer for your computer. See your Quick Start Guide for details on
how to install this software.
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Printing a Document
This procedure describes the general steps required for printing from
various Windows applications. The exact steps for printing a document
may vary depending on the application program you are using. Refer 
to your software application’s documentation for the exact printing
procedure.

❍ Start the program you are using to create the document,
and open the document you want to print.

❍ Choose Print Setup from the File menu.

❍ Click on the Properties or Setup button if you want to
make any adjustments as appropriate for printing your
document. (See Printer Setup Within Windows on the
following page for details.)

❍ Select OK to close the Print Setup dialog box.

❍ After making any necessary changes to the printing
parameters, select OK to start the print job.

Choose Print 
from the

File menu.

Make sure  the
Canon MultiPASS
C5000 Printer is 
selected as your
default printer.

Start your
application.
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Printer Setup Within Windows
You can use the MultiPASS C5000 with all your Windows 95
applications. Be sure to set the MultiPASS C5000 as the default printer
for all your Windows operations.

Most of your printing operations are controlled by your software
application. The following sections describe how you set certain options
directly from the printer driver; you only need this information if your
application does not control printing.

Opening the Printer Properties Dialog Box 
in Windows 95

You can open the Properties dialog box in one of the following ways:

❍ From within any Windows application, you can select the Print or
Print Setup command.

❍ From the Printers folder, you can select the printer and then select
the Properties command from the File menu.

❍ From the Printers folder, you can select the printer, click the right
mouse button, and then select Properties from the drop down list.

Using the Printer Driver in Windows 95
The printing options are displayed on these Windows 95 tabs: General,
Details, Paper, Graphics, and Setting. See Using the Windows Tabs section
(page 2-7) for details.

N For detailed information on any of the printing options, you can use the
Windows 95 on-line Help in the following ways:

❍ Use the right mouse button to click an item on the screen; then 
click the What’s This? command.

❍ Click ? and then click an item.

❍ Press F1.
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Using the Windows Tabs
The MultiPASS printer driver for Windows has several tabs from which
you can select your printing options and learn about your printer driver
as well as your MultiPASS C5000.

❍ General
This tab allows you to add comments regarding the printer driver
and print a test page or a separator page. (You see this tab when 
you open the Properties dialog box from the Printers folder, not 
from within a Windows application.)

❍ Details
This tab allows you to specify printer port settings, spool settings,
and time-out settings. (You see this tab when you open the
Properties dialog box from the Printers folder, not from within a
Windows application.)

DEFINE THE
PRINTER’S PORT

SPECIFY THE
PRINTER DRIVER

SPECIFY TIMEOUT
SETTINGS

SPECIFY PORT
SETTINGS

SPECIFY SPOOL
SETTINGS

ADD COMMENTS
HERE

PRINT A
SEPARATOR
PAGE

PRINT A TEST PAGE
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❍ Paper
This tab allows you to specify page orientation, paper size, and type
of print media.

❍ Graphics
This tab allows you to specify print quality, color model, and print
model.

SPECIFY TYPE
OF PAPER

SPECIFY PAGE
ORIENTATION

SPECIFY SIZE
OF PAPER

SPECIFY
PAPER FEED
METHOD

ENABLE OR
DISABLE IMAGE
COLOR MATCHING 

ENABLE OR
DISABLE FINE
MODE 

ENABLE OR
DISABLE IMAGE
OPTIMIZER

SPECIFY PRINT
QUALITY

SELECT A
COLOR MODEL

SELECT A
PRINT MODEL
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❍ Setting
This tab allows you to turn on or off the Setup Analyzer. It also
allows you to save up to four custom print settings.

Specifying Your Printing Options
Be sure to use your on-line help to find out about the settings available
for each printing option.

❍ To move between the Windows tabs, click on any of the tabs.

❍ To select the settings and exit, click the OK button.

❍ To cancel your setting selections on a tab, click the Cancel button.

❍ To save your settings without exiting, click the Apply button.

❍ To access the Help file, click on the Help button.

❍ When you move the mouse cursor over one of the printing options,
a help message appears at the bottom of the tab.

ENABLE OR
DISABLE SETUP
ANALYZER

SAVE YOUR
CUSTOM PRINT
SETTINGS
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Recommended Graphics Settings
You can select the following printing options from the Graphics tab to
achieve the specified results.

Driver settings
To achieve Print Quality Color Model Results
Fastest B&W Draft Monochrome Uses less ink. Output 
output possible 180 × 180 dpi quality is draft.

Fast letter quality Standard Monochrome Slightly slower than 
output 360 × 360 dpi draft. Quality is standard.

Fast B&W photograph Standard and Fine Monochrome Slower than B&W but
and graphic output 360 × 360 dpi better grayscale quality.

High quality High and Fine Monochrome Slower than Standard but
photograph and 720 × 360 dpi optimizes B&W grayscale
graphic output quality.

Fast color output Draft Color Uses less ink. Output
180 × 180 dpi quality is draft.

Color ouptut Standard Color Fast color printing but
360 × 360 dpi quality is not optimized.

High quality High and Fine Color Optimizes color print
color output 720 × 360 dpi quality but the print

speed is slower.

Photo-realistic — Photo Color Produces unsurpassed
color printing photo-realistic color printing.

(Requires the optional BC-22e
Photo BJ Cartridge and High
Resolution Paper HR-101
or Glossy Photo Paper
GP-201.)
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Using the Setup Analyzer
The Setup Analyzer allows the printer driver to evaluate your choice of
printing settings. On the Setting tab, you click on the green ✔ to enable
the Setup Analyzer. Click on the red symbol to disable it.

When you exit the printer driver and accept your printing settings by
clicking the OK button, the Setup Analyzer (if enabled) checks to see if
any of your settings are contrary to the recommended settings. If there
are inconsistencies, a dialog box similar to this appears:

The inconsistencies appear with check boxes. You can use the dialog box
buttons to select or deselect the inconsistencies and to fix or ignore the
inconsistencies.
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Printing Speed Versus Color
The MultiPASS Printer Driver for Windows can interpret and translate
the full spectrum of colors, up to 16.7 million colors. When printing
color, there is a significant increase in the amount of information that
the driver has to interpret and translate. When printing black ink only,
the driver has only one color to interpret.

By decreasing the amount of colors that the printer driver has to
interpret, you can significantly decrease the time needed to translate the
information. This will speed up the overall printing process.

For Quick Color Printing
In the MultiPASS Printer Driver for Windows, choose the following
printing operations. These selections allow the printer driver to interpret
and translate 256 colors, which will increase your printing speed.
However, your print quality will not be optimized.

❍ Media Type—Plain Paper

❍ Print Quality—Standard; Fine is off

❍ Color Model—Color

❍ Print Model—Custom

❍ Color Selection—Fast Color

For High Quality Color Printing
For the MultiPASS C5000, select the printing options shown below to
allow the printer driver to interpret and translate up to 16.7 million
colors. Keep in mind that your print speed will be slower than with
other setting combinations.

❍ Print Quality—High; Fine mode is on

❍ Color Model—Color

❍ Print Model—Automatic
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For Monochrome Printing
Use the optional BC-20 Black BJ Cartridge to optimize the printer’s
performance when you are printing black text and graphics only.

In the printer driver, choose the following printing options to tell your
MultiPASS C5000 to print using black ink only.

❍ Media Type—Plain Paper

❍ Print Quality—Standard

❍ Color Model—Monochrome

❍ Print Model—Automatic

Other Ways to Improve Print Speed in Windows
To improve printing speed, you can try the following:

❍ Avoid diffusion halftones
In the Custom Settings dialog box, choose Diffusion for halftoning
only when printing final output or photographic images. Choosing
Fine allows documents to print as much as 20% faster because the
computer does not need to compute to “best possible position” for
each dot.

❍ Avoid screen matched color
In the Custom Settings dialog box, avoid Match as the Color
Adjustment setting. The screen matching feature takes longer to
process in the computer because it requires special information.

❍ Avoid automatic settings
Although the automatic settings are easy to use, the computer must
interpret the printed page. This takes more time than if you select
each setting.

❍ Free up your memory
Use only one software program at a time and unload any screen
saving utilities or programs stored in Windows background; this
frees up more memory for Windows processing.



2-14 Printing With the MultiPASS C5000 Chapter 2

❍ Use Monochrome when possible
If you will be printing text in black ink only, choose a Color
Selection of Black and White rather than Grayscale. Print draft
documents in Monochrome rather than Color, or use Draft print
quality when printing color.

❍ Limit the number of colors on each page
The computer will need to calculate and transmit fewer dots. Too
many colors can make the image confusing and less effective as well
as cause the print speed to slow down.

❍ Use primary colors when printing presentation graphics
Use black, cyan, yellow, magenta, blue, green, and red when possible.
The computer will need to calculate and transfer less dot
information.

❍ Use the Draft print quality
The printer will need to image fewer dots.

❍ Use Plain Paper as the Media Type
The print head will make only one pass for each printed line.

❍ Use smaller graphics and more white space in your documents
The computer will be able to prepare the print file faster.

❍ Add RAM to your computer
The computer will be able to prepare the print file faster.

❍ Use a computer with a faster processor
The computer will be able to prepare the print file faster.
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Setting the Paper Thickness Lever
To ensure trouble-free paper handling, you’ll want to set the paper
thickness lever before loading paper.

❍ Center for color BJ cartridges

❍ Left for black BJ cartridges

❍ Right for heavier-weight print media or envelopes

N Be sure to check this lever when you change BJ cartridges, and before
and after printing on heavier-weight print media or envelopes.

Open the
printer cover by

grasping the
paper guides 

and lifting up.

DO NOT TOUCH THE
GUIDE RAIL

DO NOT TOUCH THE
RIBBON CABLE

DO NOT TOUCH THE
ROUND SHAFT
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❍ Set the paper thickness lever to left, center, or right
according to the BJ cartridge and paper type. See 
page 2-17 for details.

❍ Press CARTRIDGE again to move the cartridge holder
back to its home position.

❍ Close the printer cover.

Complete the
operation.

Set the paper
thickness lever.

Press the
CARTRIDGE

button to move
the cartridge
holder to the

center of the unit.

CARTRIDGE
BUTTON
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Printer Settings for Various Print Media
Paper
thickness lever Paper feed

Media BC-21e BC-20 Method Limit (Sheets)
Plain Paper Center Left Auto Approx. 100

Glossy Photo Paper Center Auto 1
GP-201

High Resolution Center Auto Approx. 10
Paper HR-101

T-Shirt Transfers Right Auto or 1
TR-101 Manual

Greeting Cards Right Manual 1
GC-101

Bubble Jet Paper Center Left Auto Approx. 100
LC-301

Fabric sheet Right Auto or 1
FS-101 Manual

Back Print Film Center Auto 10
BF-102

High Gloss Film Center Manual 1
HG-101

CF-102 Center Auto 50
Transparencies

Other heavier-weight Right Manual 1
print media

Envelopes
Single Right Manual 1
Stack Right Auto 10
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Loading Paper
You can stack paper in the sheet feeder to load it automatically, or you
can manually feed one sheet at a time through the manual feed slot.

You can place approximately 100 sheets of plain paper (20 lb or 
75 g/m2) in the sheet feeder at a time.

You can stack approximately 50 sheets of transparency film or 10 sheets
of back print film in the sheet feeder. However, these special media may
not advance correctly under unusual environmental conditions (such as
extreme temperatures or humidity). If you have trouble with special
papers becoming skewed or feeding multiple sheets, do not stack them
in the sheet feeder. Load them one sheet at a time.

Automatically Feeding Paper

❍ Center for color BJ cartridges.

❍ Left for black BJ cartridges.

Set the paper
thickness lever.
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❍ For best results, fan the paper before loading it.

❍ Always fan a stack of paper along the edge that will feed
into the printer first.

Fan the paper.

Pull the paper
support up

until it stops.
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❍ Align the edge of the paper with the right edge of the
sheet feeder.

❍ Secure the stack with the paper guide.

❍ Start your print operation.

Auto Feed Guidelines
When automatically feeding stacks of paper, follow these guidelines:

❍ Do not leave paper stacked in the printer for long periods of time;
longer sheets of paper may become bent or curled over time. This
may cause the paper to misfeed or jam.

❍ If your printed page contains lots of graphics, the ink on the page
may be damp due to the print density. Remove the page right away
and allow the ink to dry.

❍ The capacity of the paper output tray is 20 sheets of paper. To
reduce paper jams, remove paper from the output tray before the
count reaches 20.

❍ If paper curls after printing, remove it immediately; otherwise, paper
jams may occur.

Slide the stack 
of paper into 

the sheet feeder
until it stops.
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Manually Feeding Paper
You use the manual feed function when printing on heavier-weight print
media (24 lb to 28 lb or 90 g/m2 to 105 g/m2).

❍ If you are manually feeding heavier-weight print media,
set the paper thickness lever to the right.

❍ If you are using Windows, you must select Manual Feed
in the MultiPASS Printer Driver for the printer to accept
manually fed paper.

❍ You will see this screen:

❍ Remove any paper in the sheet feeder and click Continue.

Start your 
print operation.

Check the paper
thickness lever.

DO NOT TOUCH
THE GUIDE RAIL

DO NOT TOUCH
THE RIBBON
CABLE
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❍ Slide the paper into the manual feed slot in the back of
the printer.

❍ Make sure the print side is facing up.

❍ Align the sheet with the left edge of the manual feed slot.

❍ Hold the sheet for about two seconds until it feeds
automatically.

❍ The printer will automatically load the paper into
position.

❍ When ready, click Continue in the Add Paper dialog box.

After printing on thick paper or envelopes, set the paper thickness lever
(inside the printer) back to the left or center position before printing on
other paper types.

When you are
prompted, insert
the single sheet.
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Printing On Envelopes
You can stack up to 10 envelopes in the sheet feeder or you can manually
feed envelopes one at a time.

U.S. Commercial number 10 (COM10) envelopes and European DL
envelopes are recommended. You may be able to stack envelopes of
other sizes in the sheet feeder; however, Canon cannot guarantee
consistent performance on envelope sizes other than COM10 and DL.

The following envelopes are not recommended because they may cause
jams or smears, or may damage your printer.

❍ Envelopes with windows, holes, perforations, cutouts, and 
double flaps.

❍ Envelopes made with special coated paper or deeply 
embossed paper.

❍ Envelopes using peel-off sealing strips.

❍ Envelopes in which letters have been enclosed.

When you are ready to print on envelopes, follow these steps to stack
envelopes in the sheet feeder. (You can also manually feed envelopes one
at a time.)

❍ Close the printer cover.

Make sure that
the paper

thickness lever is
set to the right

(A).

DO NOT TOUCH
THE GUIDE RAIL

DO NOT TOUCH
THE RIBBON
CABLE
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❍ Arrange the stack of envelopes on a firm surface and 
press down firmly on the edges to make the folds crisp.

❍ Press all the way around the envelopes to remove any
curls and expel air from inside the envelopes.

❍ Remove any curling from the envelopes by holding the
edge of the envelopes diagonally and bending them
gently.

❍ Make sure the flaps of the envelopes are flat and not
curled.

Prepare the
envelopes.

PRESS DOWN FIRMLY ON
THE EDGES OF THE FLAP
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❍ Slide a stack of envelopes into the sheet feeder until it
stops.

❍ Align the edge of the paper guide with the left edge of the
stack of envelopes.

❍ Insert the envelopes with the print side up.

❍ Feed the top of the envelope (return address portion) 
into the sheet feeder first.

❍ Make sure the back flap is toward the sheet feeder.

Now you can start your print operation.

Insert the
envelopes.
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Using Canon’s Specialty Papers
This section provides guidelines for printing on Canon’s Specialty Papers
and describes special procedures required for High Resolution Paper and
Fabric Sheets.

Specialty Paper Guidelines

N Be sure to read any instructions that come with your Canon Specialty
Paper. These instructions provide important information regarding how
to achieve the highest print quality with these papers.

For transparency film, back print film, high gloss film, and glossy photo
paper, follow these guidelines:

❍ When automatically feeding transparencies or back print film,
remove each sheet after it is delivered. Do not allow film sheets to
stack up.

❍ Let the printed sheets of film or paper dry completely before storing
them.

Paper type Drying time
Canon Glossy Photo Paper GP-210 10 minutes
Canon Fabric Sheet FS-101 1 hour
Canon CF-102 Transparencies 15 minutes
Canon Back Print Film BF-102 15 minutes

❍ When a sheet of film has dried completely, cover its printed side
with a sheet of plain (not coated) paper before storing it; this is
recommended even if you place the sheets of film in a clear file or
plastic holder.
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❍ Do not leave the film in the sheet feeder for long periods of time.
Dust and dirt may accumulate on the film resulting in spotty
printing.

❍ To avoid smudging caused by fingerprints, use a pair of thin cloth
gloves while loading and handling the film.

❍ To avoid fading, do not expose the printed film to prolonged
sunlight.

❍ Store unused papers and films flat. Do not remove papers from their
protective packaging until you are ready to use them.

❍ Store unused film at temperatures between 59°F to 86°F (15°C to
30°C). The relative humidity should be between 10% and 70%.

Uncurling Back Print Film

If Back Print Film becomes curled, follow these steps to uncurl it:

❍ Do not roll the film too tight.

❍ The film and paper rolled together should be about one
inch (2.5 cm) in diameter.

Roll the film 
and paper up in

the direction
opposite the curl. 

Cover the
nonglossy side 

of the film 
with a sheet 

of plain paper.
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❍ You may want to fasten the roll with a small piece of tape.

High Resolution Paper HR-101

Using the Paper Output Guides

The output tray on your MultiPASS C5000 is equipped with paper
output guides. When using the optional BC-22e Photo BJ Cartridge or
BC-29F Neon BJ Cartridge to print on Canon’s High Resolution Paper
HR-101, lift the paper output guides on both sides of the output tray.

These guides help support the document as it exits the MultiPASS
C5000. The guides keep the sheet from sagging as it exits and pulling
through the unit, which can lead to poor print quality.

❍ Lift both paper output guides until they are vertical. Always lift both
output guides.

Keep the film
rolled up for

about five
minutes.
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❍ When the output guides are raised, the output tray can hold a
maximum of 20 sheets.

❍ When you finish using the BC-22e Photo or BC-29F Neon 
BJ Cartridge with High Resolution Paper, lower the output 
guides to their original position.

❍ Always lower the paper guides when using the MultiPASS C5000 as 
a fax machine. The guides may cause paper to pile up and jam.

Using the Cleaning Sheet

Canon’s High Resolution Paper HR-101 is designed for high quality
printing. This paper is specially coated to produce delicate color output.
After using a package of High Resolution Paper (200 sheets), you need
to use the cleaning sheet enclosed with the paper to remove paper dust
from the printer’s rollers; this will help prevent paper feed problems.

❍ Make sure the paper thickness lever is to the center.Set up 
the printer.
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❍ Insert the sheet with the sticky side out (toward you) and
down (going into the sheet feeder).

❍ Adjust the paper guide to the edge of the cleaning sheet.

Insert the
cleaning sheet.

Remove the two
pieces of tape

from the sheet.
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❍ Press the < or > button until ROLLER CLEANING
appears.

❍ Press START/COPY.

The cleaning sheet feeds through the
unit and ejects.

Fabric Sheet FS-101
Fabric Sheet FS-101 for Canon printers comes with a booklet that
describes special handling procedures. Be sure to look through this
booklet for special information regarding the Fabric Sheet. This section
describes specific steps for using Fabric Sheets with the Canon Bubble
Jet products.

Be sure to follow these guidelines:

❍ To avoid paper jams, smearing, and other problems, do not open the
printer’s cover during printing.

❍ Do not touch newly printed fabric sheets until the ink is completely
dry. This takes about one hour.

N Do not use the fixing agent that comes with the Fabric Sheet FS-101. This
agent is NOT needed when printing with the MultiPASS C5000.

ROLLER CLEANING

FUNCTIONTo feed the sheet,
press FUNCTION 

on the one- 
touch speed 
dial keypad.
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Printing On a Fabric Sheet

❍ Make sure the paper thickness lever is to the right
position.

❍ Make sure the paper support and paper output tray are
extended.

❍ Insert the sheet with the cloth side out (toward you) and
the open end up (away from the sheet feeder).

❍ Adjust the paper guide to the edge of the fabric sheet.

Insert the 
fabric sheet.

Set up 
the printer.

DO NOT TOUCH
THE GUIDE RAIL

DO NOT TOUCH
THE RIBBON
CABLE

OPEN END AT THE TOP
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The MultiPASS Desktop Manager is a full-featured Windows application
that enables you to use your MultiPASS C5000 from your computer. The
MultiPASS Desktop Manager coordinates the printing, PC faxing, and
monochrome scanning functions of the MultiPASS C5000. Its features
include:

❍ Printing, PC faxing, and monochrome scanning control functions

❍ Manipulating and editing the faxed or scanned documents

❍ An Address Book where you store the names and fax numbers for
individuals and groups to whom you repeatedly send faxes

❍ Folders that hold your faxes and scanned documents

This chapter describes:

❍ Starting the MultiPASS Desktop Manager

❍ Exploring the MultiPASS Desktop Manager window

❍ Using the Desktop Manager folders

❍ Viewing documents in the Desktop Manager

❍ Setting up the Address Book

❍ Setting up speed dialing

❍ Using the Fax Log

N Your MultiPASS C5000 is designed to be used with the MultiPASS
Desktop Manager. To use all the outstanding features of the MultiPASS
C5000 requires use of the Desktop Manager. To use the unit as a stand-
alone fax machine, see Appendix B.

3Using the MultiPASS
Desktop Manager
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Starting the MultiPASS Desktop Manager
When you start Windows or open the Desktop Manager, the MultiPASS
Background is automatically started as well. The MultiPASS Background
enables and monitors the communication between the Desktop Manager
and the MultiPASS C5000.

When you exit the Desktop Manager, you close only the Desktop
Manager window. Any documents you have set up to PC fax or print
remain active. If open, the MultiPASS Status Monitor, which tracks the
progress of your active jobs, also remains open and active.

Windows 95 Users
After it is installed, the MultiPASS Desktop Manager is an option on the
Canon MultiPASS C5000 menu.

❍ Click the Start button and point to Programs.

❍ Point to Canon MultiPASS C5000 and then click MultiPASS
Desktop Manager.
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Exploring the MultiPASS Desktop 
Manager Window

When you start the MultiPASS Desktop Manager, you see a screen
similar to this:

Menu Bar
The menu bar contains commands that enable you to perform the
various Desktop Manager tasks. Some of the commands can also be
accessed by their corresponding icons on the toolbar or command bar.

Toolbar
The toolbar provides quick access to certain Desktop Manager tasks.
When a task is unavailable, the toolbar button appears dimmed.

Pause the mouse over a button to see a description of the button. These
are called ToolTips.

MENU BAR

TOOLBAR

FOLDERS LIST

COMMAND BAR

STATUS LINE

WORK
AREA

FAX MEMO SETUP
ADDRESS
BOOK

CONTENTS-
SENSITIVE
HELP

HELP
CONTENTS

STOPSCAN FAX LOG

DELETE
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Folders List
The folders list contains folders that store your fax and scan documents.
The list contains both system-defined folders, provided automatically
when you install the software, and user-defined folders.

System-defined folders include In Box, Out Box, Scan, Sent Fax, and
Trash. User-defined folders are folders you can create yourself.

Work Area
The work area appears to the right of the folders list and displays one of
the following:

❍ Documents within the open folder
Displays a list of the documents.

❍ Address Book
Displays the names, fax numbers, and phone numbers for your
business and personal contacts.

You can adjust the width of the work area using the mouse pointer to
move the border between the work area and folders list.

Command Bar
The command bar contains command icons, which enable you to
perform a variety of tasks.

VIEWER—DISPLAYS
THE SELECTED ITEM

E-MAIL

FAX—SENDS A PC
FAX TO A NUMBER
YOU SELECT

PRINT—PRINTS
THE SELECTED
DOCUMENT

PHONE—
DISPLAYS IF A
TELEPHONE
IS ATTACHED
TO THE
MultiPASS
C5000

SAVE AS—SAVES
THE SELECTED ITEM
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You can use the command icons as follows:

❍ Drag a document to the command icon
For example, you can drag a document to the Print command icon
to start printing the document. The command icon signals its
acceptance of the item by lighting up.

If a document is dragged to a command icon that cannot perform
the task, the mouse pointer displays as a no-entry icon (a red circle
with a diagonal bar drawn through it).

❍ Click a document and then click the command icon
This method activates the command for the selected document, as
though the item had been dragged to the command icon.

Status Line
The status line displays information about the selected folder or
document, such as the name of the folder or document and its creation
date. You cannot edit this information.

If the Address Book is open, the status line displays information about
the selected Address Book entry.

Closing the Desktop Manager
When you exit the Desktop Manager, you close only the Desktop
Manager window. Any documents you have set up to PC fax or print
remain active. If open, the MultiPASS Status Monitor, which tracks the
progress of your active jobs, also remains open and active.

To close the Desktop Manager, click Exit from the File menu.

N The MultiPASS Background will remain open.
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Using the Desktop Manager Folders
The Desktop Manager stores and organizes your fax and scan
documents in folders. Only one folder can be open at a time. When you
open another folder, the current folder automatically closes.

System-defined Folders
When you install the Desktop Manager, these system-defined folders are
automatically available: In Box, Out Box, Scan, Sent Fax, and Trash.

❍ With the exception of the Trash folder, only the Desktop Manager
can place documents in the system-defined folders, based on faxes
sent or received, or images scanned. You can only rename, copy,
move, or remove documents from the folders.

❍ Including the Trash folder, the system-defined folders cannot be
deleted or renamed.

A document remains in a system-defined folder until you move it to a
user-defined folder, or delete it.

In Box 
The In Box folder stores all incoming faxes received by the Desktop
Manager. Each received fax displays a system-assigned name—fax nnnn,
where nnnn is a number of up to four digits which is unique within the
Desktop Manager. You can later change the name to something more
descriptive.

Out Box 
The Out Box folder is a chronological list of jobs you want to process.
The jobs consist of faxes to be sent, or fax or scan documents to be
printed from the Desktop Manager. A job in the Out Box folder is a copy
of the original document, not the original document itself.

The list of jobs in the Out Box folder is sorted by order of action, with
the next document to be printed or faxed at the head of the list. The job
currently being processed—the active job—displays in a separate row at
the top of the list, above the column titles.

You can select a job in the list to review information about that job in
the Status Bar, including the original document from which the job
came and a reason if the job failed.
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Each job in the Out Box folder displays a system-assigned name: fax
nnnn for a fax job, and print nnnn for a print job, where nnnn is a
number of up to four digits which is unique within the Desktop
Manager. You cannot rename a job in the Out Box folder.

Scan 
The Scan folder stores all images you scan with the MultiPASS C5000
from the Desktop Manager. Each document displays a system-assigned
name: scan nnnn, where nnnn is a number of up to four digits which is
unique within the Desktop Manager. You can later change the name to
something more descriptive.

N The Desktop Manager scans in black and white only. To scan in color,
you must use Pagis for MultiPASS or some other TWAIN-compliant
application that supports color.

Sent Fax
The Sent Fax folder contains all documents that have been successfully
sent as faxes. If the fax had not been marked for deletion after sending,
the sent fax is automatically moved from the Out Box folder (where 
the fax job is processed) to the Sent Faxes folder. By having sent faxes
moved to their own folder, you can better track your completed fax
communications and reserve the Out Box folder for jobs to be processed.

Trash 
The Trash folder holds any documents that you want to delete. Once you
drag a document from anofther folder to the Trash folder, you can hold
the document until you are ready to delete it.

N If you select a document and press the Delete key, or if you drag a
document to the Delete icon, the document is deleted immediately.
It is not stored in the Trash folder.

User-defined Folders
You can create up to 255 folders for your own use. These folders are
listed immediately following the system-defined folders.
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When you install the Desktop Manager software, you are automatically
provided an initial user-defined folder named My Folder. You can use
this folder immediately for storing documents moved from the system-
defined folders.

If you create additional folders that cause the folder list to grow beyond
the visible list area, a vertical scroll bar displays. The scroll bar scrolls the
entire list of system- and user-defined folders as a single entity.

Viewing Documents in the Desktop Manager
When you open a folder, you can view the documents contained within
the folder. To open a folder, simply click the desired folder in the folders
list.

If the number of documents within a folder exceeds the available work
area, horizontal and/or vertical scroll bars appear. You can then scroll the
work area to view your documents.

The documents are presented within the open folder as a list. Each
document on the list displays an icon representing the document type,
along with other pertinent information about the document (such as the
name, page count, disk storage size, and date and time it was created).
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The icon designates the document type as fax, scan, or modified. A
modified document is a document where the fax cover page has been
removed from a fax, or a multipage document that has been split into
multiple documents.

Sorting the Documents in the List
Documents in the Out Box folder are listed by a combination of the date
and time they were submitted for processing, any future scheduling
time, and processing status. Documents in the other system-defined
folders are listed in order of date and time. You cannot change the
displayed order of the list in a system-defined folder.

However, you can change the order of the listed documents in the user-
defined folders. Typically, documents in user-defined folders are sorted
alphabetically by name. You can sort the documents based on criteria
corresponding to the column labels displayed at the top of the list (such
as type, name, number of pages, size, and date). Sorting by page, size, or
date and time displays the documents with the largest document or
most current document last. The list continues to display in the order
you chose each time you open the folder.

To change the order of the list, click the title of the appropriate column
at the top of the list.

Setting Up the Address Book
You set up the Address Book to create an easily accessible list of names
and fax and/or phone numbers for your business and personal contacts.
You use the entries in the Address Book to:

❍ Send a PC fax

❍ Assign one-touch speed dialing

❍ Assign coded speed dialing

❍ Assign group dialing
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To display the Address Book, select Tools from the Desktop Manager
menu bar.

Now click Address Book. The MultiPASS Desktop Manager displays the
Address Book window:

❍ Address Book Entries
Address Book entries are listed by row. The columns indicate the
Address Book entry type (individual or group), name and address
information, and phone and fax numbers. Address Book entries can
be sorted based on a chosen column of information.

❍ Status Line
The status line displays additional information about the selected
Address Book entry, based on whether the selected entry is an
individual entry or group entry.

❍ Command Buttons
You use the command buttons to perform various tasks in working
with your Address Book.

ADDRESS
BOOK
ENTRIES

STATUS LINE

COMMAND
BUTTONS
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Working With Address Book Entries
When open, the Address Book displays a list of the address entries you
currently have set up, along with the corresponding information for
each entry. The Address Book contains two types of entries:

❍ Individual
An individual entry enables you to identify each individual to whom
you repeatedly send faxes. When you send a fax, you can then specify
the recipient for your fax from the entries listed in the Address
Book.

❍ Group
A group entry identifies the two or more individual Address Book
entries to whom you repeatedly send the same fax. For example, you
can set up a group to include those individuals involved in a
particular business project. When you specify the group entry as the
fax recipient on your fax, the fax is sent to each individual in the
group.

Sorting the Address Book
The Address Book is sorted alphabetically by last name. You can change
the order of the list based on the column titles for the list. For example,
you can sort the list based on the fax number.

To change the order of the Address Book entries, click the appropriate
column title.

CLICK HERE TO SORT BY
COMPANY NAME
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Adding and Editing an Individual Entry
When setting up an individual Address Book entry, you must specify the
contact’s first and last names, and fax number. Optionally, if you want
the information available for a fax cover page, you can provide the
contact’s phone number, title, company, address, and any comments.

To add an individual entry, click the New Individual button on the
toolbar:

To edit an individual, select the Address Book entry and click the Edit
button:
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Enter the appropriate information.

❍ You must type at least a First Name or Last Name and a Phone or
Fax number before you can click Add.

❍ You can enter 20 characters in the First and Last Name text boxes,
40 characters in the Company Name text boxes, and 32 characters 
in the Phone and Fax Number text boxes.

❍ You can use the following:

Characters Activity

0 to 9 * # + Dialing digits
, p Pause (2 seconds)
P Last pause (10 seconds, at end of number only)
- ( ) Space Display-only characters; space cannot be used at

the beginning of a number

❍ Be sure to include all numbers that need to be dialed, for example,
1-714-555-2222.

❍ If you entered an Outside Line Prefix number (such as 9) in the
Phone/Fax Setup dialog box, do not enter it here.

If adding a new entry, click Add. If editing an entry, click Replace.

Adding and Editing a Group Address
A group address contains addresses previously set up in the Address
Book, either individual addresses or other group addresses.

The New Fax Group dialog box displays two lists—a list of all Address
Book entries previously set up, and the list of addresses included in the
group. You select addresses from the Address Book to include in the
group.

You’ll want to add addresses to a group when you will be PC faxing to
this group. If you will be sending plain paper faxes, you’ll want to set up
the group in the speed dial list. See page 3-20 for details.

N You cannot assign a group address to a speed dial code.
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To add a group entry, click the New Group button on the toolbar. To
edit a group, select the entry in the Address Book and click the Edit
button.

❍ Enter or edit the name you want assigned to this group.

❍ In the Address Book list box, click the individual entry you want to
add to the group and click Add.

❍ To remove an entry from the group, click the entry in the group list
box and click Remove.

❍ In the Comments box, you can enter a note for this group entry.

❍ If adding a new group, click Create.

❍ If editing a group, click Replace.

Using a Group Address
When you specify a group address when sending a fax, the individual
addresses for the contained group are listed. If you specify more than
one group address for a fax, and each group contains the same
individual address, the duplicate address is removed. Separate fax jobs
are created for each recipient in the group.
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Importing an Address Book
You may have an address book in another program that you want to use
in the MultiPASS Desktop Manager. You can import your address book
and use it in the Desktop Manager.

You can import addresses from any ASCII text file containing
information that is separated by a comma or tab. If the fields in the text
file are separated by commas, the text file extension must be .CSV. If the
fields in the text file are separated by tabs, the text file extension must be
.TXT. You must save your text file as a comma- or tab-separated text file
before you import it into the MultiPASS Desktop Manager. For more
information about saving your text file, see your application’s
documentation. If you attempt to import information from an
improperly formatted text file, the system alerts you to a problem with
importing.

When you import the text file, you assign the appropriate field names to
each column of information. For example, the column containing the
contact’s name must be titled as the name.

❍ You see this screen:To import
addresses from a
text file, click on

the Import button. 
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❍ In the Assign Field Names dialog box, the address
information is listed in columns, with a column title that
identifies the type of information within the column. The
button above the column titles enables you to reassign the
column titles where necessary.

❍ To remove a field name from the column heading, drag
the column heading text off the dialog box.

❍ To assign the correct name, drag the titled button to the
column title.

❍ When the appropriate names appear at the top of each
column, click Import.

Click Import.

Assign the
appropriate name

to each column 
as the title.

In the Import
Address Book

dialog box, 
specify the

location and
filename to

import. Then 
click OK.
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Exporting the Address Book
You can export the Address Book from the MultiPASS Desktop Manager
to an ASCII text file. The address information can be separated by either
commas or tabs. If you choose to have the address information
separated by commas, the text file extension is .CSV. If you choose to
have the address information in the text file separated by tabs, the text
file extension is .TXT.

❍ You see this screen:

❍ In the Assign Field Names dialog box, the address
information is listed in columns, with a column title that
identifies the type of information within the column. You
can reassign the column titles where necessary.

❍ To remove a field name from the column heading, drag
the column heading text off the dialog box.

❍ To assign the correct name, drag the titled button to the
column title.

Assign the
appropriate name

to each column 
as the title.

To export the
Address Book,

click on the
Export button.
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❍ When the appropriate names appear at the top of each
column, click Export.

❍ In the Export Address Book dialog box, select the file type
(.CSV or .TXT), location, and filename for saving the file.
Then click OK.

Setting Up Your Speed Dial Assignments
To set up speed dialing, you use the fax recipients set up in your Address
Book, and assign the desired individual recipients to speed dial codes. If
you have not set up the recipient in the Address Book, you can add the
recipient while creating speed dial assignments. You can also set up a
group speed dial by assigning two or more individual speed dial
assignments to a single speed dial assignment.

N You cannot assign a group address from the Address Book to a speed
dial code.

Click Export.
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To set up your speed dialing assignments, select Setup from the Desktop
Manager menu bar, and then click on the Speed Dial tab.

Assigning an Individual Recipient to a Speed Dial Code
To assign a fax recipient to a speed dial code:

❍ In the Address Book list box, select the recipient that you want to
assign to a speed dial code.

❍ Select the speed dial code to which you want to assign the Address
Book, and click Add.

To remove a recipient from a speed dial code:

❍ In the speed dial list box, select dial assignment, and then click
Remove.

To print the speed dial assignment list:

❍ Click the Print List button.

To add a recipient to the Address Book:

❍ Click New.

❍ In the New Individual Entry dialog box, complete the appropriate
information for the recipient and then click Add.
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Defining a Group Speed Dial Code
You’ll want to assign multiple recipients to a speed dial code when you
will be sending plain paper faxes to this group. If you will be PC faxing,
you can set up the group in your Address Book. See page 3-13 for
details.

To assign two or more recipients to a speed dial code:

❍ On the Speed Dial tab, make sure the desired recipients for your
group are set up as individual speed dial assignments.

❍ Select the speed dial code to which you want to assign the group of
recipients, and click Group Dial.

❍ In the Group Dial dialog box, enter a name for the group
assignment in the Group Name box.
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❍ In the Speed Dial list box, select the first recipient and click Add.
Repeat this procedure until the desired recipients are included in the
Member(s) list box.

❍ To remove a member from the group, select the member in the
Member(s) list box and click Remove.

❍ When all the desired members are listed in the Member(s) list box,
click OK to save your group.

❍ To close the dialog box without saving your group, click Cancel.

Using the Fax Log
The Fax Log contains a list of the fax activity (faxes sent and received)
for the last two months. Each fax is listed with historical information,
such as transmission status, date and time the fax was sent or received,
the recipient of the fax, and the number of pages. You can use the Fax
Log for a variety of reasons, such as reviewing the error status of a PC
fax that failed.

While reviewing the Fax Log, you can view a specific fax document (if it
has not been deleted) or you can print the log.

Displaying the Fax Log
In the Desktop Manager, click Fax Log on the Tools menu.

❍ In the Fax Log dialog box, click a specific fax document to review
additional information in the status bar.
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Viewing a Fax Listed in the Fax Log
In the Fax Log dialog box, double-click the fax document listed.

The document displays in the Desktop Manager Document Viewer.
For information on using the Document Viewer, refer to Chapter 7,
Working With Documents in the Desktop Manager.

Printing the Fax Log
In the Fax Log dialog box, click Print.

In the Print dialog box, specify the desired print options and click OK.

The report provides a hard copy of the Fax Log information displayed in
the Fax Log dialog box.
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You can use the MultiPASS C5000 to send paper faxes or PC faxes.
PC faxing is the ability to send a fax from an application without first
printing the document. Using the MultiPASS C5000 and the MultiPASS
Desktop Manager, you can PC fax documents from any Windows
application that supports printing.

Before sending faxes, you may want to set up the numbers you plan to
use for automatic dialing methods such as one-touch speed dialing.
To do this, you first set up your Address Book; then you assign speed-
dialing numbers. See Setting Up the Address Book on page 3-9.

This chapter describes:

❍ Sending a document

❍ Sending a document to more than one location

❍ Adjusting the quality of your faxes

❍ Sending PC faxes

❍ Creating a fax memo in the MultiPASS Desktop Manager

❍ Designing a fax cover page

N Because the MultiPASS C5000 is a multitasking device, you can send a
fax and print a document at the same time.

4Sending Faxes With
the MultiPASS C5000
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Sending a Document
The MultiPASS C5000 starts sending a document while it is being
scanned into memory. When scanning a multipage document, the unit
calls the other party after the first page is scanned. Once connection is
made, the MultiPASS C5000 begins to transmit the information while
the remaining pages are being scanned. This is called Memory Sending.

Regular Dialing

❍ Place the document face down in the Automatic
Document Feeder (ADF). See page 1-14.

❍ The LCD display shows how much of the unit’s memory
is in use, then displays the current resolution, and then
the message DOCUMENT READY.

❍ Change the resolution if necessary. See page 4-13.

❍ Use the numeric buttons to dial the number.

TEL=       555  7899

Dial the other
party’s fax

number.

DOCUMENT READY

FAX STANDARD

MEMORY USED 0%

Feed the
document.



Chapter 4 Sending Faxes With the MultiPASS C5000 4-3

The MultiPASS C5000 begins
scanning the document, and dials
the number.

❍ After a few seconds, the display shows the transaction
number for the fax. This is a unique number the
MultiPASS C5000 assigns to the document and uses to
identify the document in transaction reports:

The display continues to show these displays in order
while the fax is being sent.

❍ When the document has been sent successfully, the
display shows this message.

TRANSMITTING OK

TEL = 11234567899

CALLING

SCANNING      P.001

TX/RX NO.      0001

TX

Press START/COPY.
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The MultiPASS C5000 automatically redials if the receiving
fax does not answer, if the line is busy, or if a transmission
error occurs. You can specify the number of times it redials
using the Automatic Retries option in the Send Fax dialog box
of the MultiPASS Desktop Manager (see page 8-4). If all redial
attempts fail, the MultiPASS C5000 beeps intermittently for a
few seconds. If this happens, check the fax number and try
sending the fax again.

If the ALARM light is flashing, correct the error described in
the LCD display, and then press STOP. You may need to open
the operator panel to remove the document from the ADF
(see page 10-3).

Automatic Dialing
You can send a document using one-touch speed dialing, coded speed
dialing, or group dialing. You must register the one-touch speed dialing
numbers, the coded speed-dialing numbers, and the group dialing
numbers using the MultiPASS Desktop Manager before you can send
documents using these automatic dialing methods. See Setting Up Your
Speed Dial Assignments on page 3-18.

❍ Place the document face down in the ADF.

DOCUMENT READY

Load the
document.
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❍ Press the one-touch speed dialing button (1 through 6)
assigned to the number you wish to fax to; the name
assigned to that button is displayed.

OR

❍ Press CODED DIAL and enter the appropriate two-digit
coded speed dialing code.

❍ If a number is not registered for the button or codes, the
LCD displays NO TEL # message. Make sure you pressed
the correct button or entered the correct code and that
the number you want to dial is entered correctly.

❍ If you make a mistake, press STOP. Then press the correct
one-touch speed dialing button or press CODED DIAL and
re-enter the code.

❍ If you do not press START/COPY within five seconds, the
MultiPASS C5000 starts sending you document
automatically.

❍ If the ALARM light is flashing for any reason, correct the error
and press STOP. You may need to open the operator panel to
remove the document from the ADF (see page 10-3).

DIALINGPress START/COPY.

CCSI/MKT

CANON FAX BACK

Use automatic
dialing.
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Sending a Document Using Group Dialing
If you frequently send plain paper faxes to the same group of people,
you can use the MultiPASS Desktop Manager to assign a “group” of
numbers to a speed dial code. See page 3-20.

❍ Place the document face down in the ADF.

❍ Press the one-touch speed dialing button or press
CODED DIAL and the code under which you registered
the group.

❍ The MultiPASS C5000 starts scanning your document
into memory five seconds after you select the group to
which you will send the fax, even if you do not press
START/COPY (ten seconds if you are sending to more
than one group).

❍ After scanning the document into memory, the
MultiPASS C5000 automatically dials each number in the
group.

SCANNING       P.001Press START/COPY.

02 CANON GROUP

Choose the 
group you wish 

to  send to.

DOCUMENT READY

Feed the
document.
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❍ If there is no group registered under the one-touch speed
dialing button or the two-digit code, the LCD displays the
NO TEL # message. Make sure you entered the correct
number and that the group has been registered correctly
to a speed dial code. See page 3-20.

❍ If you make a mistake when dialing, press STOP. You can
then try again.

Redialing

Manual
To start dialing again, just press REDIAL . The MultiPASS C5000 redials
the previous number you dialed with the numeric buttons. Make sure
the document is in the ADF.

Automatic
The MultiPASS C5000 automatically redials if the first attempt at
sending fails (for example, if the line is busy). The unit redials twice, and
the time between redials is two minutes. (These are the default settings.)
The LCD displays AUTO REDIAL and the transaction number while the
MultiPASS C5000 is redialing.

If the MultiPASS C5000 fails to make a connection after the last redial, it
beeps. The LCD displays BUSY/NO SIGNAL; try sending again later.

You can change the number of redials and the time between redials. The
redialing options are set in the Send Fax dialog box of the MultiPASS
Desktop Manager; see page 8-4.

BUSY/NO SIGNAL

TX/RX NO.       XXXX

AUTO REDIAL
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To Cancel Automatic Redialing
To cancel automatic redialing, press the STOP button. However, you
cannot cancel redialing while the LCD displays AUTO REDIAL (the unit is
waiting to redial). In this case, wait until dialing begins and then press
STOP to cancel redialing. The MultiPASS C5000 asks you to confirm:

To cancel the redialing, press *. The MultiPASS C5000 beeps and the
LCD displays:

The unit then prints an error report:

Resending a Fax After an Error
If you get an error while sending a fax from memory, the MultiPASS
C5000 can resend it to the same destination without having to rescan 
it. To do this, the On Error Resend option must be set in the Advanced:
Send Fax dialog box of the MultiPASS Desktop Manager. See page 
8-5 for details.

You can also set how much of the fax is sent again:

❍ The pages following the page on which the error occurred (ERROR
PAGES)

❍ The first page of the document and the pages following that on
which the error occurred (ERROR & FIRST PAGES)

❍ The entire document (ALL PAGES)

N The fax is erased from memory after it is successfully sent or after the
resending fails.

PRINTING REPORT

TX/RX NO.       XXXX

TX/RX    CANCELLED

CANCEL?  *YES  #NO
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Manual Sending
If you would like to speak with the other party before sending a fax to
them, you may do so; this is called manual sending. To use manual
sending, you must have a teleph one connected to the MultiPASS C5000.

❍ Place the document face down in the ADF.

❍ You can use regular dialing or any of the automatic
dialing methods.

❍ If a person answers, you can converse normally. When
you are ready to send the fax, ask them to press the start
button on their fax machine. Then press START/COPY on
your unit and hang up the telephone.

Faxing starts.

❍ Be sure to press START/COPY before you hang up, or you
will disconnect the call.

Converse with the
other party.

TEL=         4567899

Pick up the
telephone and 
dial the other

party’s fax 
number. 

DOCUMENT READY

Feed the
document.
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Messages Displayed During Sending
When sending a document, the MultiPASS C5000 displays the following
messages as the call progresses.

When it is finished sending the document, the MultiPASS C5000 beeps
once; the LCD displays:

Cancel Sending
To stop sending before a fax is complete, follow these steps:

❍ If you are sending manually, the transmission is cancelled
immediately.

❍ If you are sending from memory, the LCD displays:

❍ Press * to cancel or press # to continue the transmission.

Transmission continues.

If you press STOP while the document is being scanned, you may need
to open the operator panel to remove the document (see page 10-3).

TX/RX CANCELLED

Press *
or #.

CANCEL    *YES  #NO

Press STOP.

TRANSMITTING OK

TX/RX NO.      XXXX

TRANSMIT



Chapter 4 Sending Faxes With the MultiPASS C5000 4-11

Sending a Document to More Than One
Location (Sequential Broadcasting)

Sequential broadcasting sends one document to more than one location.
You can send to a total of 57 destinations as follows:

One-touch speed dialing = up to 6 destinations
Coded speed dialing = up to 50 destinations
Regular dialing (numeric 
buttons dialing) = 1 destination only

You can enter the one-touch and coded speed dialing numbers in any
order. You simply press the one-touch speed dialing button, or press
CODED DIAL followed by the two-digit code.

You can also include one destination using regular dialing. This must be
the last number you enter because you must press START/COPY after
entering the number.

N If you often send to the same group of destinations, use group dialing
(see page 4-6).

Transmitting the Document

❍ Place the document face down in the ADF.

DOCUMENT READY

Feed the
document.
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❍ Simply enter the numbers one after the other: press the
desired one-touch speed dialing button or press CODED
DIAL followed by the two-digit code.

❍ If you are sending to group dialing destinations, use the
one-touch speed dialing buttons and the CODED DIAL
button (along with the two-digit codes) to enter the
groups.

❍ You must press the second speed dialing number within
five seconds of pressing the first one. Each subsequent
speed dialing number must be entered within ten seconds
of the preceding one.

❍ You can enter only one number directly from the numeric
keypad using regular dialing. This must be the last
number you enter.

❍ The MultiPASS C5000 scans the entire document into
memory and begins sending.

TX
Press 

START/COPY.

TEL= 4567899

Dial the other
party’s number.
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❍ The MultiPASS C5000 begins the operation approximately
ten seconds after you press the last button (five seconds if
you press only one button) even if you do not press
START/COPY.

❍ The MultiPASS C5000 dials the destinations in numerical
order starting with the coded dial numbers, then the one-
touch numbers, and finally the regular-dial number
(regardless of the order in which you entered the
numbers).

❍ To cancel a transmission, press STOP during the dialing
or transmission. All subsequent transmissions in the
sequence are cancelled. (You may need to open the
operator panel to remove the document; see page 10-3.)

N If the memory becomes full while scanning your document, the LCD
displays MEMORY FULL. (You may need to open the operator panel 
to remove the document; see page 10-3.) You can split the document
into two or three different jobs, or you can try sending the document to
one location at a time.

Adjusting the Quality of Your Faxes
Canon’s Ultra High Quality (UHQ™) imaging technology enables you
to send faxes that have a print quality very close to that of the original
document. The MultiPASS C5000 also allows you to adjust the
resolution and contrast it uses in sending faxes to best suit your
particular document.

Setting the Resolution
Resolution is a measure of the fineness or clarity of a printout and is
usually expressed in horizontal and vertical dots per inch (dpi). Low
resolutions may cause text and graphics to have a jagged appearance,
while higher resolutions provide smoother curves and lines, crisp text
and graphics, and a better match to traditional typeface designs.

S
en

di
ng

 F
ax

es



4-14 Sending Faxes With the MultiPASS C5000 Chapter 4

The MultiPASS C5000 has three resolution settings:

❍ FAX STANDARD
Fax standard resolution (203 × 98 dpi) is adequate for most text
documents.

❍ FAX FINE
Fax fine resolution (203 × 196 dpi) is suited for documents with fine
print (smaller than the print in this sentence).

❍ FAX PHOTO
Fax photo resolution (203 × 196 dpi, with halftones) is for
documents that contain photographs. With this setting, areas of the
document that contain photos are automatically scanned with 64
levels of gray, rather than just two (black and white) which it uses
otherwise. This gives a much better reproduction of the photos,
though transmission time is longer.

You use the B&W FAX/COPY button to set the resolution for faxing
documents.

N The COLOR COPY button is used only for making color copies; it is
inoperative when sending faxes.

B&W FAX/COPY
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❍ The LCD shows the current resolution.

❍ Press B&W FAX/COPY once or twice more to display the
resolution you want (FAX STANDARD, FAX FINE, or
FAX PHOTO).

❍ After about five seconds, the LCD returns to Standby
mode.

Setting the Contrast
Contrast is the difference in brightness between the lightest and darkest
parts of a printed document. You can adjust the contrast the MultiPASS
C5000 uses for sending faxes (Darker, Standard, or Lighter) through the
Advanced: Send Fax dialog box in the MultiPASS Desktop Manager. (See
page 8-5 for details.) Standard is the default, and is adequate for most
documents. To darken a light original, choose Darker; to lighten a dark
original, use Lighter.

12/11/97 FaxTel

FAX PHOTO

FAX FINE

FAX STANDARD

Press the
B&W FAX/COPY

button again.

FAX STANDARD 

Press the
B&W FAX/COPY

button.
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Sending PC Faxes
You can create and send a PC fax from any Windows application that
supports printing or you can create a fax in the MultiPASS Desktop
Manager. You can PC fax the document immediately, send it at a specific
time, or hold it in the Out Box to be sent at a future time.

Sending a PC Fax From a Windows Application

❍ Open the Windows application.

❍ Create and save the document.

❍ It varies between Windows applications but is generally
found in one of two ways:

• From the File menu, choose Print Setup.

OR

• From the File Menu, choose Print. In the Print
Dialog box, click Print Setup.

❍ Select and set up the Canon MultiPASS C5000 Fax as the 
current printer.

Open the Print
window in the

application. 

Create a PC 
fax document.
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❍ The Send Fax dialog box appears:

❍ Choose individuals or fax groups from the Address Book
list on the left by clicking a name and clicking the Add
button.

• To remove a name from the Recipients list, click the
name and click the Remove button.

• To add a new entry to the Address Book, click New.

❍ For a single, one-time recipient, enter the appropriate
information in the Last Name, First Name, Company,
Prefix, and Fax Number boxes.

❍ To attach a coversheet, enter the name of the coversheet
from the drop-down list or click None.

❍ To revise the name and phone number indicating from
whom the fax is being sent, enter the changes in the From
and Phone boxes.

❍ To add comments or notes for the fax on the cover page,
enter the text in the Memo box.

Complete the
information in the

dialog box. 

Print your
document using

the Canon
MultiPASS Fax
printer driver.
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❍ To have the fax deleted after you send it, click Delete after
Sending.

❍ To send the fax with any annotations that were added to
the document using the MultiPASS Desktop Manager
Document Viewer, click Include Annotation.

❍ To add a reference comment for the fax log, enter the text
in the Log Note box.

❍ Send Now
Sends the document right now.

❍ Send Later
Saves the document in the Out Box.

❍ Hold
Places the document in the Out Box until you select it
and specify a time for it to be sent. The MultiPASS
Background must be open for the PC fax to be sent at the
specified time.

❍ Cancel
Closes the dialog box without sending the fax and cancels
the specified options.

Defining Send Fax Options
Attaching a Cover Page
You can attach a cover page to your fax. The MultiPASS Desktop
Manager contains a library of predefined fax cover pages, designed with
different styles and suggested uses. In addition, you can design your own
cover page, thereby adding it to the library. The available cover pages are
listed alphabetically by name in the Coversheet drop-down list box.

Previewing the Cover Page
To check the appearance of the cover page you have chosen, click
Preview. The cover page displays, including the recipients and other fax
information you have specified; you cannot edit the cover page during
Preview.

To send the 
PC fax, click 

Send Now, 
Send Later,

or Hold.
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Identifying the Fax Sender
You can enter your name and phone number in the From and Phone
boxes. After sending the first PC fax, this information is automatically
displayed the next time you send a PC fax. You can change the fax sender
information as needed.

Entering a Memo
You enter a memo to be included on the fax cover page. The memo
appears on the cover page if the cover page is designed to include it. The
font, style, and size of the memo text is determined by the particular
design of the cover page you select.

Deleting the Fax After Sending
If you select the Delete After Sending option, the fax is automatically
deleted from the Out Box folder after it is successfully transmitted. This
option enables you to more easily clear your system of unneeded
documents, thereby freeing disk space.

If the option is not selected, the sent fax is moved from the Out Box
folder to the Sent Fax folder after successful transmission.

Including Annotations
Using the editing capabilities within the MultiPASS Desktop Manager
(described in Chapter 7, Working With Documents in the Desktop
Manager), you may have modified your document—for example, by
adding text annotations, stamps, or highlighting. In this case, you can
choose to include the modifications by clicking the Include Annotation
option.

If the option is not selected, the original version of the document is
faxed, without any annotations.

Entering a Fax Log Comment
The Fax Log maintains a history of each fax sent. By providing a log
note, you can include descriptive text on the fax log that has particular
meaning to you. The log note may be an account number for billing
purposes, or a personal note about the particular document, recipient,
or fax transmission. S
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Creating a Fax Memo in the MultiPASS
Desktop Manager

You can create and send a Fax Memo that consists of a coversheet with a
message you type. This allows you to quickly send a memo without
using another Windows application.

Simply choose Fax Memo from the File menu. The Send Fax dialog box
appears:

Specify this information exactly like you do for a regular PC fax.
See page 4-17.

Designing a Fax Cover Page
In addition to the set of predefined fax cover pages that are installed
with your system, you can design your own fax cover page. You can 
edit any existing cover page—one installed with your system or created
by you.

When you create a new cover page, you use a previously designed
background as your base page, and then place the fax information fields
on the page. The fax information fields, or variable fields, provide areas
where you place recipient and sender information for a specific fax. You
can specify the size, font, and style of the text displayed in each field.
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Preparing the Cover Page Background
The cover page background provides the permanent information and
any graphics you want included on your cover page. You then position
the variable fields in the appropriate locations on the background. For
example, for your background, you may want to include heading text
that provides your company name and address information, labels for
the variables fields (such as To: and From:), and one or more graphics
that may represent your company logo or your signature. The
background you plan to use with the Cover Page Designer must be 
black and white, and must be saved in a TIFF file format.

The following instructions provide the recommended procedure for
preparing a cover page background. Using the recommended
procedures, you process a document (created by a word processing
application) as a held fax. Once the document is in the Desktop
Manager, you export the document to save it in a TIFF file format. The
TIFF file can then be used as the background for a new cover page.

❍ In a word processing application (such as Word for
Windows), create a full-page, black-and-white document
that includes the desired features of your background:
heading text, field labels, and any graphics or pictures.

❍ When you have completed the document, print the
document using the Canon MultiPASS C5000 Fax driver.

To do so, click the Print command. In the Print dialog
box, select Canon MultiPASS C5000 Fax as the printer,
and click the command to print (usually OK or Print).

❍ In the Send Fax dialog box, enter any name and fax
number as the fax recipient. Select None as the cover page
to attach. Then click Hold.

❍ Once the fax document is placed on hold, open the Out
Box Folder in the Desktop Manager.

Specify and 
hold the fax.

Create and 
print your

background.
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❍ Locate the held fax document and open it in the
Document Viewer.

• Double-click the document, select the document and
click Open Document on the File menu, or drag the
document to the Open Document button on the
toolbar.

❍ With the document open in the Document Viewer, export
the document in a TIFF file format.

• On the File menu, click Export. In the Export dialog
box, specify the drive, directory, filename, and file type
for saving the document. Click OK.

Once you have exported the document in a TIFF file format, you can use
the TIFF file as the background of your new cover page.

Another way to prepare the cover page background is to use a graphics
application (such as Paint or Photoshop) to prepare the cover page
background. The background graphic you prepare must be a black-and-
white image, 1728 pixels wide, saved in a TIFF file format.

Opening the Cover Page Designer
You open the Cover Page Designer from either the Windows desktop or
the MultiPASS Desktop Manager.

❍ From the Windows desktop:

• Click Start, then click Programs. On the Programs menu, click
Canon MultiPASS C5000, then click Cover Page Designer.

Open and 
save the

document.
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❍ From the MultiPASS Desktop Manager:

On the Tools menu, click Cover Page Designer.

Using the Cover Page Designer
The Cover Page Designer window consists of the following components.

Menu Bar
The menu bar contains commands that enable you to create, edit,
and print your fax cover page. Some commands can also be accessed
by their corresponding buttons on the toolbar.
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MENU BAR

TOOLBAR

VARIABLES BIN

LAYOUT AREA
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Toolbar
The toolbar provides you quick access to commands needed to
create, edit, and print a fax cover page.

In addition to the buttons, the toolbar also provides you with drop-
down list boxes that enable you to select a font and font size for the
text of a variable field.

Variables Bin
The variables bin contains the fields of information you want to
include on the cover page for your fax. When you use the cover page
for sending a fax with the Desktop Manager, these fields are
automatically filled in with the appropriate information for that
specific fax transmission.

Layout Area
The layout area allows you to visually create and edit the features of
your cover page. The size of the layout area corresponds to the size
of a standard fax page. You use the horizontal and vertical scroll bars
to view different portions of the cover page.

Creating a New Cover Page

❍ Prepare or have available a black-and-white background,
in TIFF file format, to use as the template of your new
cover page. (See page 4-21 for details.)

❍ With the Cover Page Designer open, click New Cover on
the File menu or toolbar.

❍ In the displayed dialog box, specify the drive, directory,
and name of the TIFF file for your cover page
background.

Have your
background

template ready.

NEW 
COVER SAVE BOLD

UNDER-
LINE

ALIGN
RIGHT

ALIGN
BOTTOM

OPEN PRINT ITALIC
ALIGN
LEFT

ALIGN
TOP
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❍ In the layout area, where the black-and-white background
is now displayed, insert the variable fields you want to
include with the fax. (See below for details.)

❍ Position the fields in the desired locations on your
background.

❍ Optionally, adjust the appearance of each field as
necessary. (See page 4-26 for details.)

❍ When you have completed the cover page design, click
Save on the File menu or toolbar.

❍ In the Save Cover Page Template dialog box, enter the
name of your cover page and click OK.

Inserting Variable Fields
You insert variable fields that are filled in with actual data when you
attach the cover page to a particular fax you are sending. You can choose
any or all of the available fields, and place each at the desired location in
the layout area. A field is placed on top of any cover page background.
Each field displays sample text to illustrate the current font, font size,
and text attributes used.

Only the variable fields that display in the variables bin or on the Insert
menu are available for you to use on your cover page. You cannot add or
delete a field to or from the existing set. You cannot use a single field
more than once on a cover page.

Save your 
cover page.

Add variable
fields.
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To insert a field:

❍ Drag a field from the variables bin to the desired location in the
layout area.

❍ On the Insert menu, click the field you want to insert. Then position
the cursor at the desired location in the layout area and click to place
the field.

Adjusting the Appearance of the Fields
Once you have placed the desired variable fields into the layout area, you
can adjust the appearance of any field. You can resize, move, or delete a
field. When you delete a field, the field is removed from the layout area
and returned to the variables bin.

Additionally, you can set the text attributes for a field and align two or
more fields on the right, left, top, or bottom. Text attribute changes are
reflected in the sample text shown in the field.

❍ To select a field in the layout area:

• To select a single field, click the field.

• To select more than one field, hold down the Ctrl key and click
the desired fields.

• To select all fields, on the Edit menu, click Select All.

❍ To move a field, drag the selected field to a new location.

❍ To delete a field, select the field and click Delete on the Edit menu
or press the Delete key.
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Resizing a Field
With the exception of the Memo field, most of the variable fields consist
of a single line of text. If the variable information to be placed in the
field is longer than the field size, the text does not automatically wrap
onto a next line. The text is truncated to fit the length of the field. For
this reason, you may want to resize a field to ensure the full line of text is
visible on the cover page for the fax.

Because the Memo field typically contains multiple lines of information,
this variable field does provide automatic text wrapping. However, make
sure the size of the Memo field is large enough to accommodate the
length of memo text that you may enter in the Send Fax dialog box. If
the Memo field is not large enough, not all the lines of a memo text may
be visible when the fax cover page is sent.

To resize the field, click the field and drag any sizing handle.

Changing the text attributes
Once you have placed fields in the layout area, you can change the font
and font size for the text to be displayed in the field. You can also choose
a text style (bold, italic, underline). If you have multiple fields to which
you want to assign the same attributes, you can select the fields together
and make the change to all the selected fields. You can change the text
attributes assigned to predefined cover pages installed with the Desktop
Manager.

You choose the desired font and font size from drop-down list boxes on
the toolbar. The sample text in the variable field reflects the font and
font size you choose.

To change the text attributes, select the field you want to change in the
layout area. Now choose the appropriate text attributes:

❍ Select the font and font size from the drop-down list boxes on the
toolbar.

❍ Click Bold, Italic, and/or Underline on the toolbar.
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Aligning fields
When placing the variable fields in the layout area, you can align two or
more selected fields, based on the position of the first field you select.
The first field selected in the set of fields to be aligned is the anchor for
the alignment.

Fields that are placed in a column can be aligned on the right or left
border of the first field you select. Fields that are placed in a row (one
next to the other) can be aligned on the top or bottom border of the
first field you select.

For example, if you want to align a column of fields on the right, the
right border of the first field selected is used as the anchor. The other
selected fields are lined up with the right border of the first field
selected.

To align fields:

❍ Select the two or more fields you want to align on the right or left,
or on the top or bottom.

❍ Click Align Left, Align Right, Align Top, or Align Bottom on the
toolbar.

Editing an Existing Cover Page
You can edit any existing cover page to change the variable fields placed
on it. You can add, move, or remove fields, or adjust the existing fields.

To edit an existing cover page:

❍ With the Cover Page Designer open, click Open on the File menu or
toolbar.

❍ In the Open Cover Page Template dialog box, specify the name of
the cover page you want to edit, and click OK.

❍ In the layout area, make the appropriate changes.

❍ Save your changes.
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To save the changes under the same name:

❍ Click Save on the File menu or toolbar.

To save the changes under a different name:

❍ On the File menu, click Save As. In the Save Cover Page Template
dialog box, specify the name of the cover page, and click OK. (This
retains the opened cover page under its original name.)

To rename the originally opened cover page:

❍ On the File menu, click Rename. In the Rename dialog box, specify
the new name and click OK.

Deleting a Cover Page
You can delete a cover page that you no longer need. You do not need to
open the cover page to delete it.

❍ With the Cover Page Designer open, on the File menu, click Delete.

❍ In the Delete Cover Page Template dialog box, click the name of the
cover page you want to delete. Then click OK.

Printing a Fax Cover Page
You can print a cover page to produce a hard copy for review or to use
when sending a fax directly from the MultiPASS C5000. The hard copy
includes the name of the cover page and the date last modified, printed
at the uppermost edge of the page.

S
en

di
ng

 F
ax

es



4-30 Sending Faxes With the MultiPASS C5000 Chapter 4

❍ In the Print Setup dialog box, specify your print options
and click OK.

❍ With the cover page open, on the File menu, click Print
Preview.

❍ To print the cover page, click Print.

❍ To enlarge or reduce the view size, click Zoom In or
Zoom Out.

❍ To close the preview window, click Close.

❍ Because a cover page is not typically more than one page,
you will not use the remaining commands.

Preview before 
printing.

With the Cover
Page Designer
open, on the 

File menu, click
Print Setup.
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❍ With the cover page open, click Print on the File menu or
toolbar.

❍ Complete the Print dialog box and click OK.

Print the 
cover page.
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The MultiPASS C5000 has four Receive Modes:

❍ Fax Only Mode

❍ Fax/Tel Mode

❍ Manual Mode

❍ Answer Machine Mode

You set the Receive Mode during the MultiPASS installation procedure.
(See your Quick Start Guide for details.)

You can change the Receive Mode and the Receive Fax options through
the MultiPASS Desktop Manager. See page 8-7 for details.

Receiving Documents
During reception of a fax:

❍ If the unit runs out of paper or if the BJ cartridge runs out of ink,
the MultiPASS C5000 receives the remainder of the document in
memory.

❍ To stop receiving before the document is complete, press STOP.

❍ If the ALARM light is flashing for any reason, correct the error and
then press STOP. If necessary, see Chapter 10, Troubleshooting.

❍ If an error occurs, the MultiPASS C5000 beeps intermittently for a
few seconds. If this happens, contact the other party and have them
resend the document.

Chapter 5 Receiving Faxes 5-1

5Receiving Faxes
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Receiving Documents Automatically—Fax Only Mode
When you set up the MultiPASS C5000 for a dedicated fax line, the unit
automatically receives the document whenever a call comes over the fax
line. If a voice call comes in, the caller will hear the fax tone.

Receiving Both Documents and Telephone Calls
Automatically—Fax/Tel Mode

In Fax/Tel Mode, the MultiPASS C5000 monitors all incoming calls over
the telephone line. When the MultiPASS C5000 receives an incoming
call, it checks to see if the call is from another fax machine trying to send
a document or from someone wanting to talk to you. You must have a
telephone connected to the MultiPASS C5000 to use this mode.

How Fax/Tel Mode Works
In Fax/Tel Mode, the MultiPASS C5000 does not ring when it receives 
a call from another fax machine that is trying to send a document.
This is so that you are not disturbed when your MultiPASS C5000 is
communicating with another fax machine. The unit automatically
receives the document.

If the call is from a person, the MultiPASS C5000 rings to alert you to
pick up the phone. You must pick up the telephone connected to the
MultiPASS C5000.

If you do not pick up the telephone connected to the MultiPASS C5000
within 15 seconds (set by the Ring Time option), the unit stops ringing.
It checks again to make sure the call is not from a fax machine and then
hangs up.

N The MultiPASS C5000 does not recognize an extension telephone
connected to another phone jack (that is, not connected to the
MultiPASS C5000).

If a call comes in and you pick up an extension phone, the MultiPASS
C5000 will continue to ring for 15 seconds, check for a fax, and then
hang up.
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Receiving Documents Manually—Manual Mode
You will want to set your MultiPASS C5000 to receive documents
manually when you want to personally check each incoming call to see if
it is from a fax or from a person. You must have a telephone attached to
the MultiPASS C5000.

When the MultiPASS C5000 rings, pick up the telephone.

❍ If you hear a person’s voice, start your conversation. If the caller
wants to send a document after talking to you, wait on the line until
you hear a slow beep or silence (depending on the sending fax unit),
then press START/COPY to receive the document.

❍ If you hear a slow beep or silence, another fax is trying to send you a
document. Press START/COPY.

Your MultiPASS C5000 begins receiving the
document.

❍ Hang up the telephone after the MultiPASS C5000 displays RECEIVE.
If you don’t hang up, the MultiPASS C5000 beeps intermittently for
a few seconds after you receive the document. To disable the beeping,
turn off the Off Hook Alarm option in the Advanced: Send Fax
dialog box. (See page 8-5 for details.)

Using the Telephone to Receive a Fax
If you have a telephone connected to the MultiPASS C5000, you can
start receiving a document manually by entering a two-digit ID code
from the phone. This is particularly convenient if you are using a
cordless phone and you answer the phone away from the MultiPASS
C5000.

To use this feature, the telephone must be plugged into the telephone
jack of the MultiPASS C5000 (see your Quick Start Guide for details).
The Remote Receive option must be enabled in the Advanced: Receive
Fax dialog box. (The default is enabled.) For details, see page 8-8.
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Use the telephone to receive manual calls as follows:

1. When you answer a call and hear a long beep or silence, a fax is
being sent.

2. Enter the two-digit ID code on your telephone (the default code is
25). Wait for five seconds, then hang up. The MultiPASS C5000 then
begins receiving the document.

N If you have an answering machine connected to your MultiPASS C5000
and you can control your answering machine from a remote telephone,
make sure the security code for this function is different than the two-
digit ID code described above. You change the two-digit ID code used by
the MultiPASS C5000 to make it distinct from the answering machine’s
security code. See page 8-10.

Using an Answering Machine—Ans. Machine Mode
Connecting an answering machine to the MultiPASS C5000 allows you
to receive faxes and phone messages while you are out of the office.

In Answer Machine Mode, the MultiPASS C5000 allows the answering
machine to answer incoming calls, then listens for a fax tone or for four
seconds of silence (also an indication that a fax is coming in), and
automatically receives the fax if it detects the tone or a four-second
silence. (Four seconds is the default; you can change this value.)

N Canon does not recommend using an “answering service” (like those
offered by local telephone companies that provide voice mail) on the
telephone line you are connecting to the MultiPASS C5000. If you do
subscribe to an answering service, you may want to dedicate a separate
line for fax communication only and connect that line to the MultiPASS
C5000. Or, you can see if your telephone company offers a Distinctive
Ring Pattern (DRP) service (see page 5-9 for details).
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Using the MultiPASS C5000 With 
an Answering Machine
Follow these guidelines when using the MultiPASS C5000 with an
answering machine:

❍ Set the answering machine to answer on the first or second ring.

❍ If the MultiPASS C5000 runs out of paper or ink in Answer Machine
Mode, it receives all faxes into its memory. The faxes then print
automatically when you add paper or replace the BJ cartridge.

❍ When recording the outgoing message on the answering machine:

• The entire message must be no more than 15 seconds long.

• In the message, tell your callers how to send a fax. For example:

“Hello. I can’t answer the phone right now, but please leave a
message after the beep. I’ll return your call as soon as possible. If
you would like to send a fax, press the start button on your fax
machine after you leave your message. Thank you.”

Printing Documents Received in Memory
If one of the following errors occurs while the MultiPASS C5000 is
receiving a document, the unit stores the document in memory:

❍ BJ cartridge runs out of ink

❍ BJ cartridge is not installed

❍ Sheet feeder runs out of paper

❍ Paper jam occurs
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The MultiPASS C5000 can store up to 42 letter-size pages (based on the
CCITT No. 1 chart) or 20 separate documents.

The LCD display shows REC’D IN MEMORY alternating with the error
message when the memory contains documents. The MultiPASS C5000
will automatically print the contents of memory when you correct the
problem.

After printing the document(s) stored in memory, the MultiPASS C5000
erases the document(s) from memory.

N If you are using the MultiPASS Desktop Manager and it is set to Save in
memory, the MultiPASS C5000 stores incoming faxes in its memory
when the computer is off. In this case, you will see the REC’D IN FILE
message. See page 5-7 for details on receiving faxes with the MultiPASS
Desktop Manager.

Receiving While Copying, Printing,
or Registering

Because the MultiPASS C5000 supports multitasking, you can receive a
document or a phone call while you are:

❍ Making a copy

❍ Printing a document

❍ Entering information

If you are making copies or printing a document and the MultiPASS
C5000 receives a fax, it stores the document in its memory. It then prints
the document as soon as you finish making copies or printing. If you are
entering information into the LCD menu system and the MultiPASS
C5000 receives a fax, it prints the document immediately (it does not
store the document in memory).
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Receiving Faxes to the MultiPASS 
Desktop Manager

When your computer is on, you can automatically receive incoming
faxes to the MultiPASS Desktop Manager.

When your computer is off, the MultiPASS C5000 stores received faxes
in its memory until you either print them or you turn on the computer.
When you turn on the computer, you can send the faxes to the
MultiPASS Desktop Manager.

The MultiPASS C5000 can also print incoming faxes directly. If your
computer is going to be off for a while and you are expecting incoming
faxes, it’s a good idea to set the MultiPASS C5000 to automatically print
incoming faxes.

Receiving a Fax Into the In Box
To receive a fax into the In Box of the MultiPASS Desktop Manager, your
computer must be on and MultiPASS Background must be running. You
must also have selected Upload Fax in the Receive Conditions of the
Desktop Manager. (See page 8-7 for details.)

The Receive Options determine how your faxes are received by the
MultiPASS C5000.

❍ When the Computer is Off

• Set this to Print Fax to always print an incoming fax.

• Set this to Save in memory to save an incoming fax in the
MultiPASS C5000’s memory. You can then print the fax, or
upload it to the MultiPASS Desktop Manager after you turn 
on the computer.

❍ When the Computer is On

• Set this to Upload Fax to receive all your faxes to the 
MultiPASS Desktop Manager.

• Set this to Print Fax to always print an incoming fax.
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Printing a Received Fax When Your Computer Is Off
When a document is in its memory, the MultiPASS C5000 displays the
message REC’D IN FILE and alternately flashes the date.

To upload the fax to the MultiPASS Desktop Manager, simply turn on
the computer.

If you want to print a fax that is stored in memory in the MultiPASS
C5000 without turning on the computer, follow these steps:

The MultiPASS C5000 begins printing the
document.

N Once the MultiPASS C5000 prints a fax, it erases the fax from its
memory.

Press START/COPY.

FILE PRINTPress < or > on
the one-touch 
speed dialing

keypad.

FUNCTION
On the MultiPASS
C5000, press the

FUNCTION key.
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Using the Distinctive Ring Pattern Detection 
(DRPD) Feature

Some phone companies offer a distinctive ring pattern (DRP) service
whereby they assign two or more telephone numbers with distinctive
ring patterns to a single telephone line. If your phone company offers
such a service, you can have both a fax number(s) and a telephone
number(s) for your MultiPASS C5000 using only one telephone line.

Your MultiPASS C5000 will automatically detect incoming calls. Based
on the distinctive ring pattern, the MultiPASS C5000 knows if the call is
from a fax machine trying to send a document or from a telephone
trying to make a voice call.

Use the information in this section to set up the MultiPASS C5000 for
use with a DRP service. For more details on the DRP service, contact
your local telephone company. (Your telephone company may have a
different name for this service. Also, this service may not be offered in all
areas.)

Types of Ring Patterns
Your telephone company will assign a distinctive ring pattern to each
number when you order the DRP service. The setting you make in the
MultiPASS C5000 must match the setting assigned by the telephone
company.

You can set the MultiPASS C5000 for the following ring patterns:

❍ Normal ring—Ring type of normal telephone line
(Recommended for voice calls)

❍ Double ring—Two short rings at regular intervals
(Recommended for fax calls)

❍ Triple ring—Short-short-long at regular intervals
❍ Triple ring—Short-long-short at regular intervals
❍ Other ring type—Patterns other than those described above

You set the DRPD Switch Options in the Advanced: Receive Fax dialog
box (see page 8-10 for details).

You must set all DRPD ring numbers in the MultiPASS C5000. You
select the ring pattern and then specify whether the pattern is for
telephone calls, faxes, or both (fax/tel switching). See the next section 
for details. R
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How DRPD Responds to Calls
When there is an incoming call, the MultiPASS C5000 checks the
incoming ring pattern and determines the type of pattern being
received. The MultiPASS C5000 may require up to 10 seconds to
determine the pattern type. During this time, any telephone device
connected to the MultiPASS C5000 will not ring if Silent Receive is
enabled. After the pattern is detected, the MultiPASS C5000 reacts
according to how you registered the setting.

Incoming Call Incoming Call
Your Setting From Fax From Telephone 

Fax Receives the fax document Answers as a fax 
without ringing. machine.

Tel Rings to alert you to pick Rings to alert you to pick 
up the telephone. Press up the telephone and 
START/COPY to receive the take the call.
fax (Manual Mode).

Fax/Tel Switches to receive mode Rings to alert you to pick 
for fax transmission signals up the telephone and 
and does not ring. take the call.

Communicating Using the Distinctive Ring Pattern
Detection (DRPD) Feature

Using the MultiPASS C5000 with a DRP service is almost the same 
as using it with a normal telephone line.

When you turn on DRPD, the Receive Mode defaults to Fax/Tel Mode.
(You cannot change this Receive Mode.)

When someone calls using the number assigned for telephone
communication, the MultiPASS C5000 rings in the pattern you
registered for telephone calls. When you hear this pattern, simply pick
up the telephone connected to the MultiPASS C5000 and talk.
If you do not pick up the telephone, the MultiPASS C5000 continues 
to ring until the other party hangs up.

When someone sends a fax using the number assigned for fax
communication, the MultiPASS C5000 does not ring. It receives the
document automatically.
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You can use the MultiPASS C5000 as a color scanner and a color copier.
This chapter describes:

❍ Setting the document feed lever

❍ Scanning documents with the MultiPASS C5000

❍ Copying documents using the operator panel

❍ Copying documents using Pagis

Setting the Document Feed Lever
To scan or copy, you set the document in the Automatic Document
Feeder (ADF). See the instructions starting on page 1-13 for details.

You use the document feed lever on the ADF to select multiple
documents ( ) or single sheets ( ). Always set the document feed 
lever to single sheets and manually feed the following types of
documents:

❍ Thick paper
❍ Thin paper
❍ Small documents (postcards, business cards)
❍ Documents with uneven surfaces
❍ Photographs
❍ Special types of paper
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Scanning With the MultiPASS C5000
You can use the MultiPASS C5000 to scan in either color or black and
white. To scan in color, you must use Pagis for MultiPASS or another
TWAIN-compliant software application that supports color scanning. To
scan in black and white, you use Pagis for MultiPASS or the MultiPASS
Desktop Manager.

Using Pagis to Scan
To scan using Pagis for MultiPASS, you can select the Scan option from
the Pagis toolbar:

You can also select Pagis for MultiPASS from the Programs list—click
Start, Programs, and then Pagis for MultiPASS. From the Pagis drop-
down list, you select Pagis Scan Tool.

Pagis Scan Tool Window

You now see the Pagis Scan Tool—Scanner window:

SCAN BUTTON



Chapter 6 Scanning and Copying With the MultiPASS C5000 6-3

In this window you specify:

❍ Page Type
Specifies the type of page you are scanning. The default is
Photograph.

❍ Save In
Specifies where you want to store the scanned image.

❍ File Name
Specifies the name of the file to be assigned to the scanned image.

Click on Properties to specify additional scanning attributes. The
Scanner tab looks similar to this:

The Page Refinements tab looks like this:
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After specifying the scanning properties, click on the Scan button to scan
the image. You see a screen similar to this:

When scanning is complete, Pagis displays the image in the Scanner
window. You can Save the image in the Pagis Inbox, Discard the image,
or send the image (SendTo) to an item in your Windows 95 Send To
menu.

Scanning a Document Into the MutliPASS
Desktop Manager

You can also use the Monochrome Scan option of the MultiPASS
Desktop Manager to scan in black and white.

The MultiPASS Desktop Manager scans each document page, gives it a
system-assigned name, and places it in the Scan folder as a TIFF
document. You can review, annotate, print, or send as a fax each scan
document. For more information on these tasks, refer to Chapter 7,
Working With Documents in the Desktop Manager.

A document remains in the Scan folder until you move or delete it.
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❍ Place the document face down in the ADF.

❍ You can also click Monochrome Scan from the Tools
menu.

❍ Scan Mode
Selects the type of image you are scanning:

Black and White—Scans an image at one bit per pixel.

Grayscale—Scans an image at eight bits per pixel; when
scanning a color image in black and white, this option
retains the greatest tonal range.

Text Enhanced—Scans an image in grayscale, converted
to black and white using Canon Image Trust technology.

In the Main tab,
you specify the

scan options for
your document.

Click the 
Scanner icon.

Feed the
document.
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❍ Scan Resolution
Selects the resolution in dots per inch:

150 dpi
200 dpi
300 dpi
400 dpi
Custom

Generally, a higher resolution provides better image 
quality.

❍ Selection
Defines the size of the image you are scanning and the
scale (enlarging or reducing).

❍ Use Text Enhanced instead of Black and White 
for OCR software
This option is designed for use with OCR (Optical
Character Recognition) software. Set this option to
increase the contrast in black and white scanning to
promote the accurate recognition of characters in OCR
software. For OCR scans, set the resolution to at least 
300 dpi.

❍ Canon ColorGear™ Color Matching
This option provides the universal color matching system
that makes predictable color available and provides RGB
to CYMK conversion. ColorGear automatically ensures
the optimum color input and output.

In the Preferences
tab, you specify

preferred options.
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❍ Page Size
Specifies the size of image you are scanning.

❍ Black & White Options
Specify the Threshold, Brightness, and Contrast of the
image.

In the Black & White Options list box, select the desired
option:

Threshold
Provides a high contrast evaluation of the image in terms
of black and white only.

Halftone
Simulates the tonal range of an image with a precise
pattern of lines and dots.

In the C5000 
tab, you 

specify options 
for a Black &

White scan.
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❍ If you click Preview, the image is displayed in the
ScanGear window. You can adjust the properties of the
images as needed for the final scan, such as:

• Crop the image

• Reverse the color or tone

• Mirror the image

• Rotate the image

• Scale the output size 

• Adjust the tone

• Adjust the contrast/brightness of a black and white
image

When you click Scan, the scanned image is stored in the
Scan folder with an assigned number such as SCAN_19.
From the Scan folder, you can save (Export), rename,
print, or delete the scanned image—just like any other
file.

❍ You can PC fax a scanned document. For information on
PC faxing, see Chapter 4, Sending Faxes With the
MultiPASS C5000.

To start the scan,
click the Preview
or Scan button.
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Scanning From a Windows Application
You can use the MultiPASS C5000 to scan documents directly into a
Windows application that supports a TWAIN interface (such as Adobe®

PageMaker®). Some applications allow multiple page scans, while others
do not. If you are unsure whether your Windows application supports
this feature, refer to your user documentation for the application.

The following instructions summarize the procedures for scanning an
image. For specific information about scanning with your Windows
application, refer to the user documentation for the application.

❍ Place the document face down in the ADF.

❍ Normally, you select Acquire and then Select Source from
the File menu. Now you select the MultiPASS.

❍ Then you select Acquire and then Image.

❍ For information on the scan options, see page 6-5.

The scanned image appears in your application.

In the ScanGear
window, specify

the scan options,
and then click

Preview or Scan.

In your Windows
application, specify
the MultiPASS as 
the scan device.

Feed the
document.
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Copying Documents Using the Operator Panel
One of the convenient features of the MultiPASS C5000 is its ability to
make high-quality copies. You can make up to 99 copies of one
document at a time.

N ❍ It’s a good idea to use the optional BC-20 Black BJ Cartridge when 
you make black and white copies.

❍ Make sure the optional BC-22e Photo Color BJ Cartridge is not
installed in the MultiPASS C5000 when you are making copies.

❍ Place the document face down in the ADF. The LCD
displays these messages:

❍ The display shows the size of the copy (the default is
100%) and the number of copies (the default is 1).

COPY    100%     01
Press 

START/COPY.

DOCUMENT READY

FAX FINE

MEMORY USED    0%

Feed the
document.
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❍ To change the copying resolution for color copying, press
the COLOR COPY button.

❍ To change the copying resolution for black and white
copying, press the B&W FAX/COPY button.

N ❍ When copying in color:
• Use COLOR FINE resolution for 360 x 360 dpi; this results in a 

much better quality reproduction, but takes longer than other 
settings.

• Use COLOR DRAFT resolution for 180 x 360 dpi.
• Use COLOR SNAPSHOT when scanning photos that 

are less wide than a letter-size page.

❍ When copying in black and white:
• Use B&W FINE resolution for copying most text documents.
• Use B&W PHOTO resolution when copying documents that 

contain photographs. This scans areas of the document that 
contain photos with 256 levels of gray, and results in a much 
better reproduction of the photograph.

❍ You cannot use the BC-22e Photo Color BJ Cartridge nor the 
BC-29F Neon BJ Cartridge for making copies. These cartridges are
only to be used for printing color documents from your computer.

B&W PHOTO

B&W TEXT

COLOR SNAPSHOT

COLOR DRAFT

COLOR FINE

Change the
resolution if

necessary.
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❍ To reduce the size of the copies, use the < and > buttons
to select the reduction percentage you want (70%, 80%,
90%, or 100%):

❍ To make multiple copies, use the number buttons to enter
the number of copies (up to 99).

❍ To stop copying at any time, press STOP. You may need to
lift the operator panel to remove the document (see page
10-3 for details).

❍ If an error occurs and the LCD displays START AGAIN,
reload the document and start copying again.

N If the LCD displays MEMORY FULL while making multiple copies 
of a document, do not use the multiple copy feature for copying the
document. Make single copies of the document instead (as many times
as required).

You may be able to make multiple copies if you first print out any faxes
that are stored in memory (see page 5-5).

COPY 
Press 

START/COPY.

COPY    100%     02

Enter the 
number 

of copies.

COPY      80%     01

Select 
Reduction mode 

if necessary.
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Copying Documents Using Pagis
You can copy documents in color or in black and white using Pagis for
MultiPASS.

You can select the Copy option from the Pagis toolbar:

You can also select Pagis for MultiPASS from the Programs list—Click
Start, Programs, and then Pagis for MultiPASS. From the Pagis drop-
down list, you select Pagis Scan Tool.

When the Pagis Scan Tool window is displayed, click on the Copier tab.
You see this screen:
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You can specify these options:

❍ Reduce/Enlarge
Specifies a reduction or enlargement of the original image.

❍ Enhance Text and Pictures
Uses page segmentation on the scanned original to optimize the text
and picture quality in the copies.

❍ Collate Copies
Collates copies when copying multiple pages.

❍ Color Copy
Selects a color copy. If not checked, copy is black and white.

After specifying the copier properties, click on the Copy button to scan
the image. You see a screen similar to this:

Pagis displays the image in the Copier window. Click the Print Copy
button to print the scanned image.



Chapter 7 Working With Documents in the Desktop Manager 7-1

D
oc

um
en

ts
 in

D
es

kt
op

 M
an

ag
er

This chapter contains information and instructions for managing,
manipulating, and modifying your documents in the MultiPASS
Desktop Manager. It includes:

❍ Managing your documents in the Desktop Manager

❍ Annotating a document

The MultiPASS Desktop Manager screen looks similar to this:

7Working With Documents 
in the Desktop Manager

MENU BAR

TOOLBAR

FOLDERS LIST

COMMAND BAR

STATUS LINE

WORK
AREA
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Managing Your Documents in the 
Desktop Manager

Once you send a PC fax, receive a fax, or scan an image, the resulting
document is available in the Desktop Manager. You can perform a
variety of tasks with and on your documents, as described in this
chapter.

Selecting Documents in the Desktop Manager
To work with a document, you select it in the open folder. Simply click
the document name in the list.

Printing a Document in the Desktop Manager
You can print a document from any folder in the Desktop Manager.

❍ Click the document you want to print. Then on the File
menu, click Print.

OR

❍ Drag the document to the Print button on the 
command bar.

Select the
document.
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❍ A copy of the document to be printed is sent to the Out
Box folder. The job is assigned a unique name. When
printing is complete, the copy is automatically deleted
from the Out Box folder.

N Annotations will not be printed. To print a document with
annotations, you must print from the Viewer. See page 7-11
for details on Annotating a Document.

Working With Jobs in the Out Box Folder
For each PC fax you send, fax you receive, or document you print in the
Desktop Manager, a job is created in the Out Box folder. The job
currently being processed—the active job—displays at the top of the list.

In the Print dialog
box, specify the 

number of copies
and click OK.
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Each job in the Out Box folder displays with a system-assigned name. A
job remains in the Out Box folder until it is successfully processed or
deleted. You cannot rename a job in the Out Box folder, or move the job
to another folder.

You can select a job in the list to review information about that job in
the status bar. This information includes the name of the original
document from which the job came, as well as the reason the job failed
(if it did).

The Out Box folder displays the current status of each job. While in the
Out Box, you can work with your jobs in the following ways:

❍ Stop an active job from PC faxing or printing

❍ Send a PC fax that has been scheduled for sending later, held, or has
failed

❍ Print a job

❍ Delete a job that is not active

Job Status
Each job in the Out Box folder is assigned a status:

❍ Active
The active job is the job currently being PC faxed or printed using
the Desktop Manager. When an active fax job completes successfully,
it is automatically moved to the Sent Faxes folder or deleted (based
on whether you specified to delete after sending in the Send Fax
dialog box). When an active print job completes successfully, it is
automatically deleted.

❍ Queued
A queued job is a job waiting to be PC faxed or printed. Queued
jobs are processed in chronological order.

❍ Scheduled
A scheduled job is a PC fax you chose to send at a later time. You
can select a scheduled fax job at the appropriate time to have it sent.
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❍ Retry
A PC fax job receives the Retry status if:

• The MultiPASS C5000 is busy with another task, and thus
unable to transmit the PC fax, or

• The receiving fax line is busy.

The Desktop Manager continues to try sending the fax until the
transmission is successful or the Desktop Manager exceeds the
defined number of retries. If a job cannot be completed successfully
within the specified number of retries, the job is marked with a
Failed status. The job remains in the Out Box folder until you
reprocess or delete it.

❍ On Hold
A held job is a PC fax you chose to place on hold, rather than send
immediately. The held fax job remains in the Out Box folder until
you choose to send or delete it. You can print a job that is on hold.

❍ Failed
A job receives a Failed status because a PC fax could not be sent
successfully. This occurs because the Desktop Manager exceeded the
defined number of retries. For example, a PC fax may have failed
because of a continuously busy fax line or an incorrect fax number.
The failed job remains in the Out Box folder until you attempt to
reprocess or delete it.

❍ Stopped
A stopped job is an active job that you stopped from processing
before it was completed. The stopped job remains in the Out Box
folder until you attempt to reprocess or delete it.

❍ Error
An error results for a job if there is a problem with the MultiPASS
C5000, such as a loss of communication with the Desktop Manager
or memory is full. You can display the nature of the error in the
status line by selecting the job or reviewing the Fax Log.
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Stopping an Active Job
If necessary, you can stop the active job from processing. When you do
so, the Desktop Manager retains the job in the Out Box folder as a
stopped job. You can later reprocess or delete the job.

To stop an active job, open the Out Box folder and click Stop on the Edit
menu or toolbar.

Sending a Scheduled, Held, Failed, or Stopped PC Fax
A PC fax job continues to reside in the Out Box folder if it is scheduled
for sending later, if it is on hold, if it failed to transmit in the specified
number of retries, or it was stopped. You can reprocess the PC fax job
for sending now or you can reschedule it for a different time.

When you send a PC fax from the Out Box folder, the Send Fax dialog
box displays the information initially entered for the PC fax. You can
change the information as needed. For example, for a PC fax that failed
because of a wrong fax number, you can correct the fax number. For a
scheduled PC fax, you can specify a different time for transmission.

If a cover page is attached, the Desktop Manager displays the style and
any memo text and you can edit it.

❍ In the Out Box folder, drag the document to the Send Fax
button on the command bar.

OR

❍ Select the document and click Send Fax on the File menu.

❍ In the Send Fax dialog box, change any fax options as
needed.

❍ To process the fax for immediate sending, click Send Now.

❍ To schedule the fax for a later time that you specify, click
Send Later.

Process 
the fax.

Send 
the fax.
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Creating a Folder
To better organize your documents in the MultiPASS Desktop Manager,
you can create additional folders. When you create a new folder, you
assign a unique name.

❍ In the Create Folder dialog box, enter the desired name of
your new folder and click OK.

Moving a Document
You can move a document from:

❍ System-defined folder (except the Out Box folder) to a user-defined
folder

❍ System-defined folder (except the Out Box folder) or user-defined
folder to the Trash folder

❍ One user-defined folder to another user-defined folder.

You cannot move a document into a system-defined folder other than
the Trash folder.

Simply open the folder containing the document you want to move.
Then drag the document to the desired folder. The document is placed
in the appropriate sort order.

Name the 
folder.

From the File
menu, click 
New Folder.
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Renaming a Document or Folder
You can rename a user-defined folder or a document at any time. Folder
names must be unique within the Desktop Manager. Document names
must be unique within a folder.

Whenever you attempt to rename a folder or document, the system
verifies whether the new name is unique. In the event of a conflict, the
system alerts you of the conflict. A folder or document name can
contain blank spaces.

❍ To rename a document, click the document. Then, on the File menu,
click Rename. In the Rename dialog box, enter the new name and
then click OK.

❍ To rename a folder, simply click the folder name and enter the new
name in the highlighted rectangle.

Deleting a Document or Folder
You can delete a document or user-defined folder when it is no longer
needed.

When deleting a document, you can delete the document permanently,
which removes the document from the Desktop Manager immediately.
You can also move it to the Trash folder where it is stored until you later
decide you want to delete it permanently, or empty the Trash folder.

When deleting a folder, you must first delete all documents from the
folder. You can delete only user-defined folders.

❍ To delete a document permanently, open the folder with the
document you want to delete and click the document. Then, on the
Edit menu, click Delete.

❍ To delete a folder, delete all documents from the folder you want to
delete. Then click the folder. On the Edit menu, click Delete.
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Emptying the Trash Folder
If you moved documents to the Trash folder, the documents remain in
the folder until you move them again to a user-defined folder, delete
them individually, or empty the Trash folder.

As you move more documents to the Trash folder, more space is used 
on your hard disk for storing the documents. To prevent out-of-date
documents from unnecessarily using space on your disk, you should
periodically review your Trash folder and remove the documents no
longer needed.

To empty the Trash folder, click Empty Trash on the File menu. If
prompted, confirm that you want to empty the Trash folder.

Importing a Document
If you have a document residing on your hard disk or a diskette, you 
can import the document into a user-defined folder in the Desktop
Manager. To be imported and usable in the Desktop Manager, the
document must be in monochrome TIFF file format.

To import a document:

1. Open the user-defined folder into which you want to import a
document.

2. On the File menu, click Import Tiff.

3. In the Import Tiff File dialog box, specify the drive, directory, and
name of the file you want to import, and click OK.

N The Desktop Manager examines the file before importing it. If any page
in the file is more than 400 dpi, the Desktop Manager will not import
the file.
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Exporting a Document
You can export a document in the Desktop Manager, saving it to a drive
and directory you specify. When you export a document, you save a copy
of the original document. You can save the document in monochrome
TIFF file format.

To export a document:

1. Open the folder with the document you want to export.

2. Drag the document to the Export Tiff File button on the command
bar.

OR

Click the document you want to export and, on the File menu, click
Export Tiff.

3. In the Export Tiff File dialog box, specify the drive and directory
where you want to place the exported file, and click OK.

Attaching a Document to Electronic Mail (E-mail)
If you have an e-mail application installed on your system, you can
attach a document in the Desktop Manager to an e-mail message.
When you select a document and use the E-mail command, the 
Desktop Manager opens your e-mail application, attaching the 
selected document to a blank e-mail message.

To attach a document to an e-mail message, select the document you
want to attach and drag the document to the E-mail button on the
command bar. Or, on the File menu, click E-mail.
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Annotating a Document
You can open a document to view its contents, and annotate it with
notes, highlighting, stamps, or graphics (line/arrow, rectangle, circle).
Although you can save the document with your annotations, any
annotations you make are only added markings placed on the original
document. The original contents of the document remain intact. If you
choose to fax or print the modified document, you have the option not
to include the annotations with the document. Following are some
sample annotations you can add to your document.

For example, if you insert a whiteout on your document (such as over a
paragraph of text), the area is no longer visible. However, the paragraph
is still part of your document. You can fax or print the document with
or without the whiteout annotation. You can later remove the whiteout
annotation from the document, restoring the hidden area.

When you open a document for annotations, the document displays in
the MultiPASS Document Viewer. You can open one document at a time.
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STICKY NOTE

WHITEOUT

STAMP

HIGHLIGHT

DRAWN
GRAPHIC
(CIRCLE AND
ARROW)
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❍ Double-click the document.

❍ Select the document you want to open. On the File menu,
click Open Document.

❍ Drag the document to the Open Document button on the
toolbar.

❍ With the document open in the Document Viewer, adjust
the size of your view of the document as needed.

❍ Create the desired annotations on your document.

❍ On the File menu, click Save to save the annotations with
your document in the Desktop Manager.

❍ On the File menu, click Exit.

❍ If you have not saved your annotations, you are prompted
to do so.

Close the
Document

Viewer.

Annotate
the document.

Open the
document in the

Document Viewer.
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Features of the Document Viewer Window

❍ Menu Bar
The menu bar contains commands that enable you to perform
various tasks with your document. Some of the commands can also
be accessed by their corresponding buttons on the toolbar.
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MENU BAR

TOOLBAR

ANNOTATION
PANEL

DOCUMENT
DISPLAY AREA

PAGE PANEL

STATUS BAR

SAVE

CUT

COPY

PASTE

PRINT

PREVIOUS
PAGE

PAGE
PANEL

NEXT
PAGE
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❍ Toolbar
The toolbar provides you quick access to performing certain
Document Viewer tasks. In circumstances where a task is not
possible, the toolbar button is unavailable, appearing dimmed.

In addition to the buttons, the toolbar also provides you with a
drop-down list box that enables you to select a display size for your
document.

❍ Document Display Area
The document itself is displayed and modified in the Document
Display Area. You can page or scroll through the document, enlarge
or reduce the view of the document, or change the orientation. The
display area contains the results of any annotations you may make.

❍ Annotation Panel
The annotation panel is a set of tools for annotating your open
document. When you select a tool on the panel, an additional panel
may open enabling you to specify specific features for the tool. You
can move the panel around the window to position it for working
on your document. You can also hide the display of the panel.

FIT TO
WINDOW

FIT TO
WIDTH

ROTATE
RIGHT

ROTATE
LEFT

ROTATE 180°

ZOOM
OUT

ZOOM 
IN

ANNOTATION
PANEL

SCROLL

SELECT
ANNOTATION

SELECT
REGION

STICKY
NOTE

WHITE OUT

STAMP

HILITE

ARROW/
LINE

RECTANGLE

CIRCLE
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❍ Page Panel
The page panel contains a number of buttons, one for each page in
the document you are currently viewing. The page panel provides a
quick visual indication of the number of pages in the document and
a method for moving to another page. The page panel normally
displays along the bottom edge of the Document Viewer window,
above the status bar.

❍ Status Bar
The status bar appears at the bottom of the window, and contains
useful information about the document that you are currently
viewing.

Adjusting Your View of the Document
You can adjust your view of the open document in a number of ways,
to provide a more workable display area for making annotations. For
example, you can hide or show the different components of the
Document Viewer.

To show/hide the components of the window:

❍ On the View menu, click Toolbar, Status Bar, Annotation Panel,
and/or Page Panel. Clicking the same command turns the display 
of the item on and off.

❍ For the annotation panel, you can also click the Annotation Panel
button on the toolbar.

Changing the Document Orientation
You may need to rotate a document for easier reading. For example, the
document may represent a fax you received that was originally sent in
landscape mode or was fed into a fax machine in an inverted position.
The change in orientation applies to the entire document, not just a
currently displayed page.

To change the document orientation:

❍ On the View menu, click Rotate. On the Rotate menu, click Right,
Left, or 180 to rotate the document right by 90°, left by 90°, or 180°
(flipping the document upside down).

❍ On the toolbar, click Rotate Right, Rotate Left, or Rotate 180.
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Adjusting the Display Size
The Document Viewer offers different levels of magnification to enable
you to work at the most comfortable size for your document. You can
zoom in and out at predefined increments, or specify a particular size or
scale.

You can use the Fit to Width option which fills the width of the window
with your page display, or Fit to Window which adjusts the document
image size so that the entire document is visible within the window.

To enlarge or reduce the size:

❍ To enlarge the document by increments, click Zoom In on the View
menu or the toolbar.

❍ To reduce the size of the document by increments, click Zoom Out
on the View menu or the toolbar.

❍ To select a specific size or scale for enlarging or reducing the
document, click Zoom on the View menu. On the Zoom menu, click
the desired size. Or, click the size or scale from the drop-down list
box on the toolbar.

Adjusting the Image Display
For ease of viewing and better visibility, you can adjust or invert the
light and dark levels of your displayed document. When you invert the
display colors, you change the black areas to white and vice versa. Any
colors you use for annotations are not changed, although highlight
annotations may be difficult to see against a black background.

You may find that the Gray Scale setting is more pleasing to the eye;
however, it is slower to generate an image. For speed and reasonable
image display, consider the Darkest setting.

To lighten or darken the image:

❍ On the View menu, click Image Enhancement. On the Image
Enhancement menu, click the desired setting.

To reverse the colors of the image:

❍ On the View menu, click Invert.
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Paging Through Your Document
For multipage documents, you can move to the next or previous page, or
a particular page you specify.

To page through your document:

❍ Click Next Page or Previous Page on the View menu or toolbar.

❍ On the View menu, click Go to Page. On the Go To Page dialog box,
enter the page number you want to display and click OK.

❍ Click the page on the Page Panel.

Reviewing Information About the Document Image
As a reference, you can display information about the document
currently displayed in the Document Viewer. This information includes
the name and size of the file, when the file was created, the number of
pages, the width and height, the resolution (pixels per inch), the number
of bits used to represent each pixel (thus, the number of colors that can
be displayed), and the scaling.

To review information about the image, click Image Info on the 
View menu.
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Adding Annotations to Your Document
The following sections describe the various ways you can annotate your
document.

Adding a Sticky Note
You can add a text note on any portion of your document. When you do
so, you can choose the text attributes: font, font size, and special effects
(boldface, italic, underline, strikeout). Sticky notes always appear as
black text on a yellow background.

You can type any text that you want for the note, editing the note later if
necessary. If you select a font, font size, or special effect, it affects the
entire note. If you change any of the attributes while editing a note, or
while the note is selected, it changes all the text in the note.

If you switch away from the note to do something else (such as change
the text size or switch to a different tool) before entering your text, the
sticky note is removed. This is to prevent you from creating unwanted
blank sticky notes.

To add a sticky note:

1. Click the Sticky Note tool on the annotation panel.

2. Select the font, font size, and any special effects.

3. At the desired location on the displayed page, drag the cursor to
draw the size of the sticky note. A dotted line displays to show you
where the sticky note will be placed. When you release the mouse
button, the sticky note is created.

4. Type the text of your note.

STICKY NOTE
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To edit the text in a sticky note:

1. Make sure the Sticky Note tool is selected on the annotation panel.

2. Move your mouse pointer over the sticky note. The cursor changes
to an insertion point.

3. Click at the location where you want to make your changes.

4. Edit the text as needed.

Concealing a Region
You can conceal a region of your document to hide certain areas. For
example, you can hide a paragraph before you fax the document to a
business contact. You can conceal the paragraph with either an opaque
whiteout or blackout annotation, which is always a rectangle. Once
applied, the whiteout or blackout annotation can be moved, resized,
or deleted.

To conceal a region:

❍ On the annotation panel, click the White Out tool.

At the desired location on the displayed page, drag the cursor to
draw the whiteout annotation. A dotted line displays to show you
where the whiteout annotation will be placed. When you release the
mouse button, the annotation is drawn.

❍ On the annotation panel, click the Select Region tool.

At the desired location on the displayed page, drag the cursor to
draw the outline of the region. A dotted line displays the region. On
the Edit menu, click White Out or Black Out.
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Inserting a Stamp
You insert a stamp to place a bitmap image on the displayed page of
your document. The Desktop Manager contains a library of available
stamp images, stored as .BMP files that were installed with the Desktop
Manager. You can use only those stamps installed with the Desktop
Manager.

To insert a Stamp:

1. On the annotation panel, click the stamp tool. You see this dialog
box:

2. In the Choose Stamp dialog box, select the desired stamp from the
list box and click Accept.

3. Click the cursor in the desired location for placing the stamp. The
stamp is placed at that location.
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Highlighting Your Document
You can add a color highlight to the text or other images in your
document. You select a color and draw a rectangular highlight over the
desired area. All highlight colors are transparent and display as the color
you selected. When you print the document, the highlighted region
prints as gray shadings.

To highlight your document:

1. On the annotation panel, click the Hilite tool.

2. Select the color of the highlighting.

3. At the desired location on the displayed page, drag the cursor to
draw the highlight region. A dotted line displays to show you where
the highlight region will be placed. When you release the mouse
button, the highlight is created.

Creating a Drawing Graphic
You can annotate your document with one or more drawing objects 
that include a straight line, single- and double-headed arrow, hollow
rectangle, and a hollow circle or ellipse. When you draw the object, you
can select the color and width of the line for the object.

To create a drawing object:

1. On the annotation panel, click the drawing object tool: Arrow/Line,
Rectangle, or Circle.
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ANNOTATION PANEL FOR
AN ARROW OR LINE

ANNOTATION PANEL FOR A
RECTANGLE OR CIRCLE

HILITE TOOL



7-22 Working With Documents in the Desktop Manager Chapter 7

2. Select the color and width of the line for the object you are drawing.
For an arrow or line, also select the particular style you want to use.

3. At the desired location on the displayed page, drag the cursor to
draw the object. A dotted line displays to show you where the drawn
object will be placed. When you release the mouse button, the object
is created.

Showing and Hiding Your Annotations
As you add annotations to your document, you can turn the display of
the annotations on and off for viewing.

To show or hide your annotations, click Annotations on the View menu.
On the Annotations menu, click the command to hide or show your
annotations. For color annotations, click B&W Preview to display the
annotations in black and white.

Revising Your Annotations
Once you have created annotations in your document, you can revise the
annotations as needed. For example, you may want to resize, move,
delete or cut, or copy and paste an annotation.

Selecting One or More Annotations
To revise an annotation, you must first select it. In most situations, you
can select one or more annotations at a time.

❍ To select a single annotation, click the Annotation Select button on
the annotation panel. Then click the annotation.

❍ To select all annotations, click Select All on the Edit menu. This
method selects all the annotations in the open document on all
pages. You cannot resize an annotation using this method.

❍ To select annotations within a specified region, click the Region
Select tool on the annotation panel. At the desired location on the
displayed page, drag the cursor to draw a rectangle enclosing the
annotations you want included within the region. A dotted line
displays to indicate the region. On the Edit menu, click Select in
Region. Graphic handles display for the annotations that are selected.

❍ To select the base page of your document, click Select Base Image
on the Edit menu.



Chapter 7 Working With Documents in the Desktop Manager 7-23

Moving an Annotation
You can move an annotation currently displayed from its present
position in your document to another. You can also change the layering
order of annotations that occupy the same position. Normally, an
annotation you add to the document in the same position as a
previously added annotation is layered on top. As needed, however, you
can move the background annotation to the front, or the foreground
annotation to the back.

❍ To move an annotation, select the annotation and drag it to the
desired location.

❍ To change the layered position of an annotation, select the
annotation and do one of the following:

• To bring the annotation to the foreground, click Bring to Front
on the Edit menu.

• To place the annotation on the background, click Send to Back
on the Edit menu.

Resizing the Annotation
When you create an annotation, you draw it to the desired size. If the
original size proves unsuitable, you can resize the annotation either
smaller or larger.

❍ To adjust the size, click the border of the annotation and drag any
sizing handle.

Copying and Pasting an Annotation
If you want an annotation to appear more than once within your
document, you can create the first annotation, and then copy and paste
it any number of times. When you copy an annotation, it is placed on
the Document Viewer clipboard. From the clipboard, it can be pasted to
any location on any page of your document.
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To copy and paste an annotation:

1. Select the annotation to be copied and click Copy on the Edit menu
or toolbar.

2. With the annotation copied, click Paste on the Edit menu or toolbar.

3. Move the pasted annotation to the desired location in your
document.

Saving All or Part of a Base Page of Your Document
You can select the original base page, or a region of the page, and save
the selection to a bitmap (.BMP) file. Once it is saved as a bitmap file,
you can import the file into another Windows application as needed.

1. Select either the base page or a region of the page in your document.

2. Click Copy on the Edit menu or toolbar.

3. Once copied, on the Edit menu, click Paste to File.

4. When prompted, specify the drive, directory, and name of the file
for saving.

A REGION OF
THE PAGE
SELECTED
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Removing an Annotation
If you decide you no longer want an annotation to appear in your
document, you can remove the annotation, either permanently or by
moving it to the clipboard.

To remove an annotation, select the annotation and do one of the
following:

❍ To delete the annotation permanently, press the Delete key.

❍ To remove the annotation to the clipboard, click Cut on Edit menu
or toolbar.

Exporting the Document
You can save a copy of the document currently open in the Document
Viewer to a file on a specified drive and directory. The document is
saved as a graphic file, and can include or not include any annotations
you may have created. Typically, you would save the document to use in
a graphics application of your choice. To determine the appropriate file
type for saving the document, refer to the user documentation for the
graphics application to which you want to import the file.

1. On the File menu, click Export.

2. In the Export dialog box, specify the drive, directory, filename, and
file type for the file you want to save. Specify also whether you want
to save any annotations with the document. Then click OK.
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Adjusting the Document Viewer Default Options
As you work in the Document Viewer, you can change the options that
affect your view of the open document, such as the size and lightness or
darkness of the image. However, if you have view settings that you
generally prefer to use in most situations, you can define default settings.
These settings are activated when you first open the Document Viewer.

To adjust the initial Document Viewer options:

1. On the File menu, click Initial Options.

2. On the Initial Options menu, click the appropriate command to set
default options:

❍ Scale Factor
To select the appropriate view size

❍ Image Enhancement
To select the level of lightness or darkness

To return the options to their original settings when you installed the
Desktop Manager, click Reset All to Default.
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This chapter contains information and instructions on changing your
MultiPASS C5000 setup options in the Desktop Manager, and using
other Desktop Manager utilities. It includes:

❍ Setting up the MultiPASS C5000 Setup options in the Desktop
Manager

❍ Making a phone call from the Desktop Manager 

❍ Using the Status Monitor

❍ Closing the MultiPASS Background

❍ Disconnecting the MultiPASS C5000

❍ Using MultiPASS Diagnostics

❍ Uninstalling the Desktop Manager

8Setup and Other Utilities in the
Desktop Manager
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Setting Up MultiPASS C5000 Options 
in the Desktop Manager

The Desktop Manager contains Setup options that define the operation
of your MultiPASS C5000.

When you first install the Desktop Manager, the Setup options are set to
default settings that enable you to begin using your MultiPASS C5000
with the Desktop Manager immediately. However, you can change the
option settings as needed.

To change Setup options in the Desktop Manager:

1. From the Setup menu, click the group of setup options you want to
change.

2. In the Setup Options dialog box, click the appropriate tab for the 
options you want to display.

3. On the appropriate setup tab, specify your changes.

4. To save any changes and close the dialog box, click OK.

To exit the dialog box without saving your changes, click Cancel.
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Setting Up Preferences

❍ Date Format and Display Language
Select the format in which you want to enter the date and the
language you want to see in the Desktop Manager screens.

❍ Document Deletion
Select this option if you want to be prompted each time you delete a
document from the Desktop Manager.

❍ Telephone
Select this option if you have attached a telephone to your
MultiPASS C5000. With this option selected, you can use the
Desktop Manager to dial a phone number. After selecting this
option, you must close and reopen the Desktop Manager to enable
the Phone command.

❍ Volume
You can set the volume level of the various sound components of
your MultiPASS C5000 to suit your office environment. The settings
are Minimum, Medium, or Maximum.
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Setting Up Send Fax Options

❍ Fax Information
You specify the information that displays as the header for a PC fax:
your name, company name, and your fax number. Initially, this
information was set up when you installed the Desktop Manager.

❍ Phone Line
You specify the dialing method the MultiPASS C5000 will use: touch-
tone or rotary pulse. You also specify any prefix used to access an
outside phone line. Initially, this information was set up when you
installed the Desktop Manager.

❍ Automatic Retries
You specify the number of retries (1-10) the system should attempt
when sending a fax transmission, and the length of time between
each retry (2-99 minutes).

❍ Automatic Report
You specify whether or not you want a report to print with each fax
transmission, or only when there is an error with the transmission.
You can also specify if you want an image of the first page of the fax
included in the report.
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Restoring the Default Settings
If, after making changes, you decide to restore the default settings for the
options, click the Use Defaults button.

Setting Up Advanced Send Fax Options
When you click on the Advanced button on the Send Fax tab, you see
this dialog box:

❍ Speed
You set the transmission speed used to send faxes. The higher the
setting, the faster the transmission. If you experience problems when
sending faxes, try a lower speed setting.

❍ Pause Duration
You set the length of the pause that will be inserted when you enter
a pause in a phone number (1-15 seconds).

❍ Error Correction (ECM)
You select this option to reduce system and line errors when sending
a fax. With this option selected, the system checks each outgoing fax
for lost data. If data has been lost from a portion of a page, the
system transmits that portion again after confirming that all data
within that portion can be transmitted successfully.



8-6 Setup and Other Utilities in the Desktop Manager Chapter 8

❍ Auto Start Send
When you select this option, the MultiPASS C5000 starts scanning
automatically five or ten seconds after you enter a phone number.
When you don’t select this option, you must press START/COPY to
scan the document, or the unit returns to standby mode after 60
seconds.

❍ Off Hook Alarm
You select this option to turn on the alarm if the telephone’s handset
is off hook.

❍ Image
You select a contrast setting that determines the level of contrast in
the faxes you send. The Standard setting is usually appropriate for
most documents. However, based on the lightness or darkness of
your original fax document, you may prefer to lighten or darken the
contrast for the fax transmission.

❍ Fax Heading
You select the position where you want the sent fax heading
information (your fax number, your name, and date and time) to
print on the faxes you send. This information is known as the
Transmit Terminal Identification (TTI). It can be printed either
inside or outside the image area of your fax page.

❍ On Error 
You select Resend option if you want the MultiPASS C5000 to
automatically redial when an error occurs while sending a fax. You
also select which pages are to be resent: only the page on which the
error occurred, the page on which the error occurred and the first
page of the fax, or all pages.
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Setting Up Receive Fax Options

❍ Paper Size and Reduction
You specify the size of paper in the sheet feeder and whether you
want an incoming fax reduced (approximately 98%) to ensure the
contents fit on the paper on which it is printed.

❍ Answer 
You specify the Receive Mode. Initially, you set the Receive Mode
when you installed the Desktop Manager.

You use the Silent Receive option to specify whether the optional
telephone should ring when you receive a call. The type of call for
which the device will ring is determined by the Receive Mode. The
ringing will occur for a fax call only (Fax Only mode), or fax and
telephone calls (Fax/Tel mode).

You can set the number of rings (1-99) before the MultiPASS C5000
will respond to any call. If the Receive Mode is Fax Only, this is the
number of rings before the MultiPASS C5000 answers the call. In
FaxTel mode, this is the number of rings before the MultiPASS
C5000 answers to determine if the call is from a fax or a telephone.
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❍ Receive Conditions
You specify how the system should handle an incoming fax under
the following conditions:

• If your computer is turned off:
You set the MultiPASS C5000 to print the fax or save the fax in
its memory.

• If your computer is turned on:
You set the MultiPASS C5000 to move (upload) the fax to the
Desktop Manager on your computer, or to print the fax.

❍ Report 
You specify whether or not you want a report to print with each fax
reception, or only when there is an error with the fax reception.

Restoring the Default Settings
If, after making changes, you decide to restore the default settings for the
options, click the Use Defaults button.

Setting Up Advanced Receive Fax Options
When you click on the Advanced button on the Receive Fax tab, you see
this dialog box:
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❍ Speed
You set the transmission speed used to receive faxes. The higher the
setting, the faster the fax is received. If you experience problems
when receiving faxes, try a lower speed setting.

❍ Error Correction (ECM)
You select this option to reduce system and line errors when
receiving a fax. With this option selected, the system checks each
incoming fax for lost data. If data has been lost from a portion of a
page, the system receives that portion again after confirming that all
data within that portion can be received successfully.

❍ Ink Saver Mode
You select this option to print documents in the Desktop Manager
using a reduced amount of ink. When using Ink Saver Mode, the
print document may appear less bright or contrasted.

❍ Fax/Telephone Switching Options
You specify these options when your Receive Mode is Fax/Telephone
Switching.

• Listen Time Before Ringing
When a call is received, the MultiPASS C5000 checks to see if the
call is from a fax machine or a telephone. You use this option to
set the appropriate amount of time (0-30 seconds) to allow the
MultiPASS C5000 to check for the type of call. If your MultiPASS
C5000 does not have enough time to detect the fax tone, it
assumes the call is from a telephone.

• Ring Time
When your MultiPASS C5000 is set to receive both fax and
telephone calls (FaxTel mode), it rings to inform you of an
incoming telephone call. You use this option to set the
appropriate amount of time (10-45 seconds) the MultiPASS
C5000 will ring. If you do not pick up the telephone within a
certain amount of time, the MultiPASS C5000 stops ringing.

• Ring Tone
You set the tone of the ring.
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• Default Action if No Answer to Telephone
You set this option to Receive if you want the MultiPASS C5000
to handle an incoming call, detected as a telephone call that is
not answered, as an incoming fax. If no fax is received, the line is
then disconnected. If you set this option to Disconnect, the
MultiPASS C5000 automatically disconnects the unanswered call
without switching to try and receive a fax.

❍ Answering Machine Mode Options
You select this option to set the MultiPASS C5000 to automatically
switch to fax receive mode if your telephone caller does not speak
within the specified amount of time.

You can set the number of seconds (1-99) the MultiPASS C5000 will
wait before switching to fax receiving mode if the telephone caller
does not speak.

❍ Remote 
You select the Receive option so that you can receive a fax by
pressing an ID code on the telephone attached to the MultiPASS
C5000. You assign a remote Identification Number (00-99) that
signals the MultiPASS C5000 to receive the fax. The default number
is 25.

❍ DRPD Switch Options
If you select DRPD for the Receive Mode, you need to set up the
Ring Pattern, Action, Fax ID, and Fax Number. See the DPRD
description starting on page 5-9 for complete details on how these
settings work with your MultiPASS C5000.
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Setting Up Speed Dial Assignments

On the Speed Dial tab, you can set up fax numbers for speed dialing
with the MultiPASS C5000. You use the fax recipients set up in your
Address Book, and assign the desired individual recipients to speed dial
codes. If the recipient has not yet been set up in the Address Book, you
can add the recipient while creating speed dial assignments. You can also
set up a group speed dial by assigning two or more individual speed dial
assignments to a single speed dial assignment.

For reference, you can print the list of speed dial assignments.

See page 3-18 for details on setting up your speed dial assignments.
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Making a Phone Call From 
the Desktop Manager

You can use the MultiPASS C5000 and Desktop Manager to dial
telephone calls if:

❍ You have a telephone attached to the MultiPASS C5000.

❍ You enabled the Telephone Attached to Unit option on the
Preferences tab in the Setup Options dialog box in the Desktop
Manager. (See page 8-3.)

You can place a call to any individual you want, whether or not the
individual has been set up in the Address Book. At the time you are
attempting to make your call, you can set up an individual entry in the
Address Book.

In the Desktop
Manager, click
Phone on the 
File menu or

command bar.
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❍ You can enter the phone number in the Prefix and Phone
boxes, or select an Address Book entry.

❍ When you enter the phone number, you use the applicable
numeric characters and any valid characters that separate
the different segments of the phone number. For example,
you can use 0 through 9, dash (-), or parentheses (). Other
characters are also available for entering a phone number.

❍ To add an individual to the Address Book, click New
Individual and complete the New Individual Entry dialog
box. For details on completing the New Individual Entry
dialog box, refer to Chapter 3, Using the MultiPASS
Desktop Manager.

❍ When the Dialing Phone dialog box displays, you are
prompted to pick up the telephone.

❍ If you want to stop the number from being dialed, click
Stop.

❍ When you have completed your call, click Exit.

When the phone
number is entered

or selected, 
click Dial.

In the Phone
dialog box, enter

the phone 
number you 

want to call.
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Using the Status Monitor
The Status Monitor is a utility that enables you to track the current
status of the MultiPASS C5000, incoming and outgoing faxes, print and
scan jobs, and any error conditions needing your attention. You can
open the Status Monitor either from the Windows desktop or the
MultiPASS Desktop Manager.

The Status Monitor displays as a button and can also display as a
window. Whether displayed as an icon or window, the Status Monitor
alternates the status message shown for more than one activity occurring
at the same time. For example, if the sending of a fax and an out-of-
paper error condition occur at the same time, the Status Monitor
alternates the display of the corresponding messages.

Opening the Status Monitor
❍ On the Windows desktop—Click Start, and then point to Programs.

On the Programs menu, point to Canon MultiPASS C5000. Then
click MultiPASS Monitor.

❍ In the Desktop Manager, click Status Monitor on the Tools menu.

Using the Minimized Status Monitor
With Windows 95, the minimized Status Monitor appears as a button on
the Windows desktop in the taskbar.

The graphical appearance of the icon or button depicts the type of
activity it is reporting. For example, the scan graphic is used to depict
the status of scan activity.
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Status Messages
The Status Monitor reports the following statuses for the 
MultiPASS C5000.

❍ Idle
The MultiPASS C5000 is currently inactive.

❍ Scanning
The MultiPASS C5000 is scanning an image. The Status Monitor
window displays the number of the page currently being scanned.

❍ Printing
The MultiPASS C5000 is printing a document. The Status Monitor
window displays the number of the page currently being printed.

❍ Sending Fax
The MultiPASS C5000 is sending a fax document. The Status
Monitor window displays the number of the page currently being
faxed.

❍ Receiving Fax
The MultiPASS C5000 is receiving a fax document. The Status
Monitor window displays the fax number or name of the sender (if
available), and the number of the page currently being received.

❍ Attention Needed
The MultiPASS C5000 needs your attention for situations such as
being out of paper. The Status Monitor window describes the nature
of the attention required.

When you have corrected the situation, the status message
automatically clears.

❍ Error Warning
The MultiPASS C5000 has a problem that needs your immediate
attention, such as when the Status Monitor can no longer detect the
MultiPASS C5000. The Status Monitor window displays the nature
of the problem, with a comment indicating a corrective action.

When you have corrected the situation, the status message
automatically clears.
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Closing the MultiPASS Background
The MultiPASS Background is a utility that monitors and controls
activity between your computer and your MultiPASS C5000, including:

❍ Input and output (such as sent and received faxes) to and from the
Desktop Manager 

❍ Output (print and PC fax activity) from Windows applications.

When you installed the Desktop Manager, the MultiPASS Background
was placed in the Windows StartUp group and is automatically opened
when you open Windows.

If you decide you need to disconnect the MultiPASS C5000 from the
designated port and/or attach another device to the port, you should
close the MultiPASS Background first. If you close the MultiPASS
Background first, you avoid receiving error messages when the
MultiPASS Background detects it can no longer communicate with 
the MultiPASS C5000.

When you start the Desktop Manager again at a later time, the
MultiPASS Background is automatically reopened if your MultiPASS
C5000 has been reconnected to the port. You can also open the
MultiPASS Background without opening the Desktop Manager.

N If you are closing the MultiPASS Background, you may want to set the
MultiPASS C5000 to print any received faxes. With the MultiPASS
Background closed, received faxes cannot be moved to the Desktop
Manager. Received faxes can also be stored in the MultiPASS C5000
memory. However, if the memory becomes full, the MultiPASS C5000 is
unable to receive more faxes until you print the faxes stored in memory.

To close the MultiPASS Background in Windows 95:

1. Close the MultiPASS Desktop Manager.

2. On the Windows taskbar, click the right mouse button on the
MultiPASS Background button. In the displayed menu, click Close.

Do not delete the MultiPASS Background icon from the Canon
MultiPASS C5000 group.
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Removing MultiPASS Background From StartUp
Closing the MultiPASS Background does not remove it from the
Windows StartUp group. If you have disconnected your MultiPASS
C5000, the next time you start Windows, the MultiPASS Background
will try to open. At that time, the MultiPASS Background will be unable
to detect the device, displaying an error message.

Click OK to close the message dialog box. The MultiPASS Background
closes automatically, since it cannot detect the MultiPASS C5000 device.
Your port remains available for you to use with other devices.

However, if you would like to prevent the message from displaying each
time you start Windows, you can remove the MultiPASS Background
from the StartUp group.

The following instructions summarize the procedures for removing a
program from Windows StartUp. For more details, refer to your
Windows user documentation.

To remove the MultiPASS Background from StartUp in Windows 95:

1. On the Windows desktop, click the right mouse button on Start.

2. On the displayed menu, click Open.

3. In the Start Menu window, double-click the Programs icon.

4. In the Programs window, double-click the StartUp icon.

5. In the StartUp window, click the MultiPASS Background icon and
press the Delete key.
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Restarting the MultiPASS Background
If you reconnect the MultiPASS C5000 to the port and want to begin
using the Desktop Manager again, the MultiPASS Background is
restarted automatically when you open the Desktop Manager. You can
also open the MultiPASS Background without opening the Desktop
Manager.

To restart the MultiPASS Background in Windows 95:

1. On the Windows desktop, click Start and then point to Programs.

2. On the Programs menu, point to Canon MultiPASS C5000. Then
click MultiPASS Background.

The MultiPASS Background starts automatically.

Adding MultiPASS Background to StartUp
When you reconnect your MultiPASS C5000 device, you will probably
want to add the MultiPASS Background to the StartUp group again (if
you removed it as described earlier). With the MultiPASS Background in
StartUp, the MultiPASS Background automatically opens when Windows
is started.

To add MultiPASS Background to StartUp in Windows 95:

1. Open the Windows Explorer.

2. Display the contents of the \MPASS directory and click the right
mouse button on MPSERVER.EXE.

3. In the displayed menu, click Create Shortcut. (A shortcut item
appears.)

4. Click the plus (+) signs next to the Windows folder, the Start Menu
folder, and then the Programs folder.

5. Drag the shortcut item (created in Step 3) to the StartUp folder.

The MultiPASS Background will be automatically started when you start
Windows.

S
et

up
 a

nd
 U

til
iti

es
D

es
kt

op
 M

an
ag

er



8-20 Setup and Other Utilities in the Desktop Manager Chapter 8

Disconnecting the MultiPASS C5000
You can disconnect the MultiPASS C5000 if you want to use the parallel
port for another purpose. Before disconnecting your unit, be sure to
close the MultiPASS Background.

1. Turn off your computer.

2. Unplug your computer from all electrical sources.

3. Unplug the MultiPASS C5000 from all electrical sources.

4. On the back of your computer, remove the cable connector from the
parallel printer port.

5. On the MultiPASS C5000, release the wire clips and remove the
cable connector from the port.

6. Plug your computer back into the electrical source.

Using MultiPASS Diagnostics
If you have difficulties with your MultiPASS software or hardware, you
can use the MultiPASS Diagnostics. You use the MultiPASS Diagnostics
to verify your MultiPASS software and hardware installation, and
identify hardware problems.

The MultiPASS Diagnostics produces a report with information you can
use to resolve your problem. You can save the report to an ASCII text file
on your hard drive.

1. Open the MultiPASS Diagnostics.

• On the Windows desktop, click Start, and then point to
Programs. On the Programs menu, click Canon MultiPASS
C5000. Then click MultiPASS Diagnostics.

• The MultiPASS Diagnostics displays a message indicating if all
tests were performed successfully. Messages appear suggesting
solutions for any problems detected.
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2. When prompted in a dialog box, click Yes to view the log file.

3. In the MultiPASS Diagnostics window, to save the log file, choose
Save As on the File menu.

4. In the Save As dialog box, specify the drive, directory, and filename
for saving the file. Then click OK.

5. To exit the MultiPASS Diagnostics window, click Exit on the File
menu.

Uninstalling the Desktop Manager
If you are planning on reinstalling the MultiPASS Desktop Manager, you
must first uninstall the current installation of the software. When you
uninstall the software, you remove the MultiPASS Desktop Manager and
related printer driver. The following items are not removed, so that you
can reinstall the MultiPASS Desktop Manager at a later time and
continue to use your data files:

❍ MPASS directory

❍ Data folders and files (such as Fax Log and Address Book)

❍ System files shared with other applications

To uninstall the Desktop Manager:

1. Close the MultiPASS Desktop Manager and all MultiPASS-related
utilities (such as the Cover Page Designer).

2. Close the MultiPASS Background (see page 8-17).

3. On the Windows desktop, click Start, and then point to Programs.

4. From the Programs menu, point to Canon MultiPASS C5000, and
then click MultiPASS Uninstaller.

5. Follow the on-screen instructions.

n Be sure to restart your computer after uninstalling the Desktop Manager
and before reinstalling.
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❍ To remove the printer driver:

1. On the Windows desktop, click Start, and then point to Settings.

2. On the Settings menu, click Printers.

3. In the Printers dialog box, click the Canon MultiPASS C5000
Printer icon and press the Delete key.

Repeat this step for the Canon MultiPASS C5000 Fax icon.
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This chapter describes the routine maintenance required for your
MultiPASS C5000. It includes:

❍ MultiPASS C5000 guidelines

❍ Routine maintenance

❍ Cleaning inside the MultiPASS C5000

❍ Printing the nozzle check

❍ Cleaning the BJ cartridge print head

❍ BJ cartridge guidelines

❍ Replacing the BJ cartridge

❍ Replacing a BJ tank in the BC-21e Color BJ Cartridge

❍ Storing a BJ cartridge

❍ Transporting the MultiPASS C5000

9Maintaining the
MultiPASS C5000
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MultiPASS C5000 Guidelines
Follow these guidelines to avoid damage to your MultiPASS C5000 and
harm to you or others:

❍ Place the MultiPASS C5000 on a stable surface. Do not use an angled
stand. Avoid setting the unit in direct sunlight.

❍ Do not install the MultiPASS C5000 near devices that contain
magnets or generate magnetic fields, such as speakers.

❍ Do not subject the MultiPASS C5000 to strong physical shock or
vibration.

❍ Make sure the area where you use the unit is free from dust.

❍ Keep the MultiPASS C5000 clean. Dust accumulation can prevent
the unit from operating properly.

❍ To assure proper electrical contact, make sure the unit is firmly
plugged in.

❍ Never pull on the cord to unplug the MultiPASS C5000. Pull on the
plug itself.

❍ Do not overload the electrical outlet where the MultiPASS C5000 is
plugged in.

❍ For your safety, unplug the MultiPASS C5000 during electrical
storms.

❍ Lift the MultiPASS C5000 from the bottom only. Do not lift the unit
by the operator panel or any of its trays.

GRIP HERE
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Routine Maintenance
Your MultiPASS C5000 requires little routine maintenance. Follow these
guidelines to keep your MultiPASS C5000 in good operating condition:

❍ Before you clean the MultiPASS C5000, be sure to print any faxes
stored in memory.

❍ Do not use tissue paper, paper towels, or similar materials for
cleaning; they can stick to the components or generate static charges.

❍ Be sure to disconnect the power cord before cleaning the unit.

❍ Lightly wipe the unit’s exterior with a clean, soft, lint-free cloth
moistened with water or diluted dishwashing detergent solution.

❍ Never use thinner, benzene, alcohol or any other organic solvent, as
it may damage the surface of the MultiPASS C5000.

Cleaning Inside the MultiPASS C5000
To prevent ink spots and paper dust from accumulating inside the
MultiPASS C5000 and affecting print quality, clean the unit’s print 
area periodically. Follow these guidelines:

❍ Never use volatile liquids such as thinners, benzene, acetone,
or any other chemical cleaner to clean the interior of the 
MultiPASS C5000, or you can damage its components.

❍ Avoid touching the print head or ribbon cable inside the 
MultiPASS C5000.
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DO NOT TOUCH 
THE PRINT HEAD

DO NOT
TOUCH 
THE 
RIBBON
CABLE



❍ Disconnect the power cord from the MultiPASS C5000 before
cleaning.

❍ Open the printer cover by grasping the paper guides and lifting.

❍ Use a clean, soft, dry, lint-free cloth to remove any ink or paper
debris from the printer’s interior, especially around the platen. Make
sure not to touch the cartridge.

❍ Check the small black rollers. If they are dirty, clean them with a
soft, dry cloth.

❍ When finished, close the printer cover, and plug the MultiPASS
C5000 back in.

Cleaning the Scanner Components
Periodically check and clean the scanning components as explained here.
Be sure to disconnect the power cord from the MultiPASS C5000.

Open the 
operator panel 

by gently pulling
it toward you.
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❍ Separation guide
Wipe with a dry, soft cloth.

❍ White sheet and scanning glass
Use a clean, soft, lint-free cloth moistened with water to
clean the white sheet and scanning glass, then wipe them
with a soft, dry, lint-free cloth.

❍ Separation roller
Wipe with a soft, dry clean cloth to clean the rollers.

N ❍ If the scanning components are dirty, the documents you send or
print will also be dirty.

❍ Be sure to use a soft cloth to avoid scratching the components.

C Do not use tissue paper. Dust from the tissue paper causes static
electricity.

Clean the
components.
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❍ Dirt and dust particles that collect on the underside of
the operation panel also affect the quality of the
documents you copy or send.

❍ Use a soft, dry, clean cloth to wipe up paper dust around
the rollers.

❍ Press the center of the operator panel until it locks into
place.

❍ Plug the unit back in.

When you are
finished, close the

operator panel.

Clean the shaded
areas of the

operator panel
and the unit.
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Printing the Nozzle Check
Use this test print to check that each print head nozzle is operating
properly.

Make sure the MultiPASS C5000 is plugged in.

The pattern starts printing.

When the BC-21e Color BJ Cartridge is installed, the pattern includes all
four colors: yellow, magenta, cyan, and black. In the color pattern, you’ll
notice that lines are missing between the colors. This is normal.

The following sample shows the Nozzle Check when the optional BC-20
Black BJ Cartridge is installed.

Press 
START/COPY.

NOZZLE CHECK
Press either of the
< > buttons until

NOZZLE CHECK
appears in the LCD.

FUNCTION
Press FUNCTION.
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Cleaning the BJ Cartridge Print Head
To maintain the best possible print quality, you need to clean the 
BJ cartridge print head from time to time. Your MultiPASS C5000 is
equipped with a print head cleaning function. If you notice some
degradation in the print quality, try cleaning the print head.

C Cleaning the print head consumes a small amount of ink. Cleaning too
often reduces the amount of ink in the BJ cartridge.

❍ Make sure the MultiPASS C5000 is plugged in.

The unit cleans the print head.

❍ When cleaning ends, the MultiPASS C5000 beeps once to
let you know it is done, and returns to Standby mode.

❍ Do this five consecutive times if necessary.

❍ If the problem persists, install a new BJ cartridge.

Press START/COPY.

HEAD CLEANING
Press the < or >

button until
HEAD CLEANING

appears in the
LCD display.

FUNCTION

Press FUNCTION.
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BJ Cartridge Guidelines
You can use these cartridges with the MultiPASS C5000:

❍ BC-21e Color BJ Cartridge
Contains the print head unit and two replaceable 
BJ tanks, one color (cyan, magenta, yellow) and 
one black. You can replace the BJ tanks without 
replacing the print head unit when you run out of
ink. (A BC-21 Color BJ Cartridge will also work with
the MultiPASS C5000.)

❍ BC-20 Black BJ Cartridge
Contains the print head unit and black ink only. Use
this optional cartridge when you will be printing
with black ink only and for fast, five page per minute
printing. When you run out of ink, you replace the
complete cartridge.

❍ BC-22e Photo BJ Cartridge
Contains the print head unit and color and black inks. Use this
optional cartridge when you want to produce photo-realistic 
color printing. When used with Canon’s High Resolution Paper
(HR-101), this ink produces images comparable to your favorite
photographs. When you run out of ink, you replace the complete
cartridge. (A BC-22 Photo BJ Cartridge will also work with the
MultiPASS C5000.)

❍ BC-29F Neon BJ Cartridge
Contains the print head unit and neon color and black inks. Use this
optional cartridge when you want to add hot new colors to
everything from your business graphs to stickers for your kids.
These amazing, bright fluorescent colors make your pictures, graphs,
and fun images really stand out. When you run out of ink, you
replace the complete cartridge.
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BJ Cartridge and BJ Tank Maintenance
The most important thing you can do to extend the life of your 
MultiPASS C5000 and to ensure optimum print quality is take 
care of the BJ cartridges.

C Spilled ink can stain any surface. Open BJ cartridges and BJ tanks
carefully, and follow the guidelines presented here to protect against
spilled ink.

❍ If you are using both the BC-21e Color BJ Cartridge and any of the
optional BJ cartridges, make sure you store the cartridge not being
used in the Ink Cartridge Storage Box.

❍ Keep BJ cartridges and BJ tanks in their sealed containers until you
are ready to use them.

❍ Do not remove the BJ tanks from the BC-21e Color BJ Cartridge
unnecessarily. This may cause the ink to clog.

❍ Make sure both BJ tanks are installed in the BC-21e Color 
BJ Cartridge. Attempting to use the BC-21e Color BJ Cartridge 
with one BJ tank only may cause ink clogging.

❍ If spilled, the ink is difficult to remove. Therefore, it’s a good idea to
keep the BJ cartridges and BJ tanks out of the reach of children.

❍ Do not touch the print head area on the BJ cartridge. Ink may leak
out and cause stains.

C Hold the BJ cartridge on the sides only. Do not touch the silver plate on
the bottom of the BJ cartridge or the silver metal or circuit area on the
side. The metal area may become hot during printing.

9-10 Maintaining the MultiPASS C5000 Chapter 9
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Using Ink
Canon has more engineers dedicated to creating quality ink for
providing the best results for output on Bubble Jet printers than any
other organization. Canon does not prohibit the use of third-party 
inks and the use of third-party inks does not invalidate the product’s
limited warranty. However, Canon cannot guarantee the quality or
performance of your printer when you are using inks from other
suppliers.

Canon’s limited warranty does not cover damage caused to Canon’s
Bubble Jet products that is attributable to the use of third party parts or
supplies, including inks. The limited warranty remains in effect for its
life once that particular damage has been properly repaired.

N ❍ For optimum printing results, Canon recommends that you use only
the Canon BC-21e Color BJ Cartridge or the optional Canon 
BC-20 Black, BC-22e Photo, and BC-29F Neon BJ Cartridges with
your MultiPASS C5000.

❍ When replacing BJ tanks in the BC-21e Color BJ Cartridge, Canon
recommends that you use only Canon BCI-21 Color and BCI-21
Black BJ Tanks.

Replacing the BJ Cartridge
The actual amount of ink that you use will vary depending on the print
density of a page. If the majority of your output is graphics, you may
need to change cartridges or tanks more often than when you are
printing text only. See Appendix A, Specifications, for details on the life
expectancy of the BJ cartridges.

You may need to replace the BJ cartridge or a BJ tank when any of the
following conditions exist:

❍ You have been using the cartridge for over one year.

❍ Your printed output is not crisp and clear, and there are gaps in the
characters (missing dots) even after you have cleaned the print head
at least five times.

❍ You see the CHANGE CARTRIDGE message in the LCD.
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If you are using the BC-21e Color BJ Cartridge and your output is
blank, one of the BJ tanks is probably out of ink. See the instructions
starting on page 9-16 for replacing a BJ tank.

The following procedure describes how to replace the BC-21e Color 
BJ Cartridge with the optional BC-20 Black BJ Cartridge. Follow the
instructions in this section to replace an old BJ cartridge or to change 
BJ cartridges when you are switching between the BC-21e and any of the
optional BJ cartridges.

You only need to replace the BC-21e Color BJ Cartridge when the print
head is damaged (or after printing approximately 2000 pages). If one of
the BJ tanks (either color or black) in your BC-21e Color BJ Cartridge is
out of ink, see the next section (page 9-16) for instructions on how to
replace a BJ tank.

To replace the BJ cartridge, follow these steps:

The cartridge holder moves to the center
of the unit.

❍ Grasp both sides and lift it up.Open the
printer cover.

Press the
CARTRIDGE

button.

9-12 Maintaining the MultiPASS C5000 Chapter 9
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GUIDE RAIL
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C ❍ Do not try to move the cartridge holder manually; this may 
damage the unit. If the cartridge holder does not move and the 
unit beeps several times, unplug the MultiPASS C5000 and let it 
cool for several minutes. (The device has an automatic protection 
mode that prevents it from overheating.) After allowing it to cool,
plug the unit in again and press the CARTRIDGE button to move 
the cartridge holder to the center of the unit.

❍ Hold the BJ cartridge on the sides only. Do not touch the silver 
plate on the bottom of the BJ cartridge or the silver metal or circuit
area on the side. The metal area may become hot during printing.

❍ Gently pull up on it.

❍ Dispose of the old BJ cartridge, or store it in the 
Ink Cartridge Storage Box.

Dispose of 
or store the 

BJ cartridge.

Lift the green 
lock lever on the
cartridge holder.
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❍ Peel the protective foil off the new BJ cartridge’s
packaging, and remove the cartridge.

❍ Lift off the orange cap from the cartridge’s print head;
then remove the orange tape.

❍ Make sure the cartridge label faces you.

❍ Be careful not to touch the silver plate on the bottom 
of the BJ cartridge or the silver metal or circuit area on
the side.

Slide the
BJ cartridge

straight into the
cartridge holder. 

Remove the
protective

material
from the

BJ cartridge.

Open the
BJ cartridge

package.
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❍ The BJ cartridge locks into position.

❍ Do not apply excessive force.

The MultiPASS C5000 cleans the print head
and moves the cartridge holder to the home
position on the right side of the unit.

N Be sure to set the paper thickness lever for the type of BJ cartridge you
installed. See page 2-15 for details.

Close the 
printer cover, 
and press the

CARTRIDGE
button.

Make sure the
cartridge is

aligned against
the back of the

holder, then 
lower the green

lock lever.

M
ai

nt
ai

ni
ng

 th
e

M
ul

tiP
A

S
S

 C
50

00



9-16 Maintaining the MultiPASS C5000 Chapter 9

Replacing a BJ Tank in the BC-21e Color 
BJ Cartridge

If you perform a print operation correctly but the output is blank,
portions are missing, or colors are very wrong, a BJ tank may be out 
of ink. If the output is still blank after cleaning the print head at least
five consecutive times, replace the empty BJ tank in the BC-21e Color 
BJ cartridge.

You leave the BJ cartridge in the MultiPASS C5000 when replacing a 
BJ tank.

The cartridge holder then moves to the
center of the unit.

❍ Grasp both sides and lift it up.

C Do not try to move the cartridge holder manually, or you may damage
the unit. If the cartridge holder does not move and the unit beeps 
several times, unplug the MultiPASS C5000 and let it cool for several
minutes. (The device has an automatic protection mode that prevents it
from overheating.) After allowing it to cool, plug the unit in again and
press the CARTRIDGE button to move the cartridge holder to the center
of the unit.

Open the
printer cover.

Press the
CARTRIDGE

button.

DO NOT TOUCH THE
ROUND SHAFT

DO NOT TOUCH THE
RIBBON CABLE

DO NOT TOUCH THE
GUIDE RAIL
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❍ The color BJ tank is on the left; the black BJ tank is on the
right.

❍ Grasp the tab on the top of the tank and pull forward to
release the BJ tank.

❍ Then lift the BJ tank up and out of the BJ cartridge unit.

❍ Dispose of the BJ tank properly. You may want to place it
in a plastic bag to keep from spilling any residual ink.

❍ Remove the orange protective cap.

❍ Do not touch the bottom of the BJ tank; you may get ink
on your hands.

Take the new 
BJ tank out of 
its packaging.

Remove the 
empty BJ tank.
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❍ If you are replacing both tanks, repeat steps 3 through 6
for the other BJ tank.

❍ Make sure each tank is properly seated in its slot.

The cartridge holder then moves to the
home position on the right side of
the unit.

N Before you unplug the MultiPASS C5000, make sure the BJ cartridge 
is in the home position on the right side. If you unplug the unit while 
it is printing, or move the BJ cartridge from the home position, the
cartridge will not be capped and may dry out.

Close the printer
cover, and press
the CARTRIDGE

button.

Press firmly on
the tab on top of
the new BJ tank

until it snaps 
into place.

Slide the new 
BJ tank into 

the empty slot.
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Storing a BJ Cartridge
Whenever you unwrap a BJ cartridge, you must either install it in the
MultiPASS C5000 or store it in the Ink Cartridge Storage Box to prevent
the print head from drying and clogging.

❍ When opening the Ink Cartridge Storage Box, press in on
the release tab that locks the cover in place.

❍ You must insert the cartridge correctly or the storage box
will not close.

❍ The protective cap must be removed from the cartridge
before you set it in the storage box.

❍ Be sure the lid snaps closed.Close the 
storage box.

Carefully set 
the cartridge in
the storage box.

Open the 
Ink Cartridge
Storage Box.
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N Whenever you remove a BJ cartridge from the MultiPASS C5000, store
the cartridge in the storage box (unless you are disposing it).

If you have more than one Ink Cartridge Storage Box, you can hook
them together. Simply connect them by the slides and grooves on the
sides of the containers.

Transporting the MultiPASS C5000
If you need to transport the MultiPASS C5000, be very careful.
DO NOT remove the BJ cartridge.

❍ With the cartridge holder on the right side of the unit,
tape the BJ cartridge and cartridge holder to the side of
the unit.

❍ Unplug the power cord.

❍ Disconnect the telephone lines and parallel cable.

❍ Remove the sending document support.

❍ Remove the document support and output tray extension.

Lower the paper
rest and remove

all trays.

Disconnect 
all cables.

Make sure the 
BJ cartridge is in

the home position.
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❍ Carefully pack the unit in its original packing materials.

❍ Do not remove the BJ cartridge from the MultiPASS
C5000 or ship a BJ cartridge or a BJ tank from which
you have removed the protective cap. An opened BJ
cartridge or BJ tank that is not installed in the MultiPASS
C5000 or the Ink Cartridge Storage Box may leak, and the 
print head may dry out. Also, if you do not tape the 
BJ cartridge to the side of the unit, ink may spill into the
MultiPASS C5000.

N If you no longer have the shipping carton your MultiPASS C5000 came
in, pack the unit in a suitably sized, sturdy cardboard box, using bubble
wrap, foam peanuts, or other suitable packing materials. (If you use
foam peanuts, be sure to wrap the unit in plastic first to prevent the
packing materials from entering any openings in the unit.)

Pack the unit.
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This chapter contains information to help you solve problems you may
have when using the MultiPASS C5000. It includes:

❍ Paper jams

❍ LCD messages

❍ Printing problems

❍ Faxing problems

❍ Telephone problems

❍ Copying problems

❍ Technical notes

❍ Memory Clear Report

If you have a problem with your MultiPASS C5000 and you cannot
resolve it by referring to the information in this chapter, contact the
Canon Computer Systems Customer Care Center. See page 1-4 for
details.

Canon’s support personnel are trained in the technical support of
Canon’s products and should be able to help you with your problem. If
your printer requires service, they can provide you with the telephone
number of your local Canon Authorized Service Facility (ASF).

N Attempting to repair the MultiPASS C5000 yourself may void the limited
warranty as to that repair. See the limited warranty card for details.

Chapter 10 Troubleshooting 10-1
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If you need to contact Canon directly, make sure you have the following
information:

❍ Product name—MultiPASS C5000

❍ Serial number

❍ MultiPASS Desktop Manager version number

❍ Place of purchase

❍ Nature of problem

❍ Steps you have taken to solve the problem and the results

The serial number is located on the label on the back of the unit:

The version number of MultiPASS Desktop Manager is included in the
About information. In the Desktop Manager, click Help and then click
About.
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Paper Jams
On occasion, the document feeding into the MultiPASS C5000 or the
paper in its sheet feeder may misfeed or jam. You can usually clear the
problem easily.

N You need not unplug the MultiPASS C5000 to clear paper jams.

Jams in the Automatic Document Feeder (ADF)

Stops the operation.

❍ Gently pull the operator panel toward you.

❍ It opens only slightly.

Open the 
operator panel.

Press STOP.

CHECK DOCUMENT

Chapter 10 Troubleshooting 10-3



❍ While holding the operator panel open, remove the
document.

❍ Pull it in either direction, but DO NOT force it.

❍ If a multipage document is loaded, remove the entire
document from the ADF.

❍ Gently press the operator panel until it clicks closed.

❍ Fan and stack the sheets, and replace the stack in the ADF.

❍ Start your operation again.

Close the 
operator panel.

Remove the
document.
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Jams in the Sheet Feeder

❍ Fan the paper, and tap it on a flat surface to even out 
the stack.

❍ Reinsert the paper into the sheet feeder. Make sure you
adjust the paper guide to the stack, and that the stack
does not exceed the limit mark.

This clears the error message.

❍ If the ALARM light is on, press RESUME to eject the page
and clear the error message.

❍ If you are printing from a Windows application, follow
any instructions displayed on your computer.

If the paper jam occurred while a fax was being received, the MultiPASS
C5000 will store the fax in memory and print it when the jam is cleared.

Press STOP 
or RESUME.

Remove the stack
of paper from the

sheet feeder.

Gently pull any
jammed paper out

of the unit.

CLEAR PAPER JAM
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LCD Messages
The following messages are displayed in the LCD when the 
MultiPASS C5000 is performing a function or encounters an error.
The Error Code appears on the Activity Report.

Message Error Code Cause Action
AUTO REDIAL — The MultiPASS is Wait for the MultiPASS

waiting to redial the to try redialing. If that
other party’s number doesn’t work, wait until
because the line was the MultiPASS starts to
busy or the other dial the number, then 
party did not answer press STOP to cancel
when you tried to send redialing. Try to send
the document. the document again at a

later time.

BUSY/NO SIGNAL #005/018 The telephone number Try sending the
you dialed is busy. document at a later

time.

The fax number dialed Check the fax number
was incorrect. and dial again.

The other party’s fax is Contact the other party
not working. and have them check

their fax.

The other party is not Contact the other party
using a G3 machine. and have them send or

receive the document
using a G3 machine.

The touch tone/rotary Set your MultiPASS
pulse setting on your to the setting that
MultiPASS is incorrect. matches your telephone

line (see page 8-4).

The receiving fax did Contact the other party
not answer within 35 and have them check
seconds. their fax. You can try to

send the document
manually. For an over-
seas call, add pauses to
the registered number.

CARTRIDGE JAMMED Cartridge holder cannot Clear the paper jam or
move. This is normally whatever is obstructing
due to a paper jam. the cartridge holder 

and then press STOP.
Do not attempt to 
move the cartridge
holder manually.
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Message Error Code Cause Action
CHANGE CARTRIDGE #052 The BJ cartridge is Replace the BJ cartridge.

empty or its ink has The unit will then 
dried out. print any documents

received in memory.

CHECK DOCUMENT #001 The document is Remove the document
jammed in the ADF. you are trying to send or

copy and start again.

CHECK PAPER The size of the paper Set the correct paper 
in the sheet feeder and size in the Receive Fax
that specified in the dialog box of the 
MultiPASS setup are Setup Options in the 
different. MultiPASS Desktop

Manager (see page 8-7).

The sheet feeder is Add paper to the sheet
empty or paper is feeder or check for a
jammed. jam. Then try to print

again.

CHECK PRINTER — There may be an Check for a paper clip,
obstruction that is not paper jam, or the plastic
allowing the cartridge orange cap off the BJ
mechanism to move cartridge. Press STOP
right or left. and try your operation 

again.

The BJ cartridge may be Press STOP. Reinstall
defective. the cartridge and try

your operation again.

In either case, if the
error does not clear, try
unplugging the unit.
Wait several minutes,
then plug it back in.
Also, try installing a new
BJ cartridge.

CLEAR PAPER JAM — There is a paper jam Remove any paper from
or the sheet feeder is the sheet feeder. Clear
empty. the paper jam (see page

10-5). Then reload paper
in the sheet feeder. Press
RESUME or STOP.

COMMUNICATING — You tried to send a fax Wait until the fax is
PLEASE WAIT using Manual mode sent, or use memory

when the MultiPASS sending.
was already sending
a fax from memory.

DIALING — The MultiPASS is Press STOP if you 
dialing the receiving want to cancel the 
fax machine. transmission.
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Message Error Code Cause Action
DOC TOO LONG #003 It took more than 32 Divide the document 

minutes to send or and send or copy each 
copy a document. part separately.

It took more than 32 Contact the other party.
minutes to receive a Have them divide the
document. document and send 

each part separately.

The document is longer Use a copy machine to
than 39.4 inches (1 m). make a reduced copy of

the document and send
the copy.

DOCUMENT READY — The document in the Send the fax, scan the 
ADF is ready for faxing, document, or make the
scanning, or copying. copy.

ECM RX — The MultiPASS is ECM transmissions may
receiving a fax take longer than normal
using ECM. transmissions. Turn

off ECM if you need to
receive quickly, or if you
know your local lines
are in good condition.

ECM TX — The MultiPASS is ECM transmissions may
sending a fax using take longer than normal
ECM. transmissions. Turn off

ECM if you need to 
transmit quickly, or if
you know your local
lines are in good
condition.

HANG UP PHONE — The telephone is Place the telephone
off hook. properly into its cradle.

INSTALL BC-20/21 — The BC-22e or BC-29F Remove the BC-22e or 
BJ Cartridge is installed, BC-29F BJ Cartridge
so the MultiPASS cannot and install the BC-21e
print any received faxes, or BC-20 BJ Cartridge.
or make copies.

INSTALL BC-21 — The BC-20, BC-22e, Remove the BC-20,
or BC-29F BJ Cartridge BC-22e, or BC-29F 
is installed. BJ Cartridge and install

the BC-21e BJ Cartridge.

LOAD PAPER — The MultiPASS is out Load paper in the sheet
of paper (the sheet feeder. Make sure the
feeder is empty). stack does not exceed

the limit mark. Then 
press START/COPY.
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Message Error Code Cause Action
MEMORY FULL #037 The memory of the Print out any documents

MultiPASS is full that are stored in 
because it has received memory. Then start the 
too many documents, operation again.
or a very long or 
detailed document.

Memory is full because Divide the document 
you tried to send too and send each part 
many pages at once, separately.
or a very long or
detailed document.

MEMORY FULL — The MultiPASS is If sending a fax, the
PLEASE WAIT sending a fax and its MultiPASS continues to 

memory is full. send the fax as memory
becomes available.

MEMORY USED nn% — Shows the percentage of If you need more space,
memory currently in use. print or send any

documents in memory.

NO ANSWER #005 The receiving fax Make sure you dialed 
machine does not the correct number.
answer. Try again later.

NO RX PAPER #012 The other party’s fax is Contact the other party
out of paper or its and have them install
memory is full. paper in their fax.

NO TEL # #022 The one-touch or coded Register the number
speed dialing number (see page 3-18).
has not been registered.

NOT AVAILABLE NOW #025 In manual sending, you Use regular dialing.
entered a speed dialing
number that is assigned
to a group.

PHOTO INK USED — The BC-22e Photo BJ You must change this
Cartridge is installed cartridge to copy or
in the MultiPASS. receive a fax.

PLEASE WAIT — The MultiPASS is Wait until the date and
warming up. Receive Mode appear in

the LCD display, then
begin.

PUT IN CARTRIDGE — The BJ cartridge is Make sure the BJ 
not properly installed. cartridge is installed

correctly and the green
lock lever is down.
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Message Error Code Cause Action
REC. PAPER JAM #009 The MultiPASS C5000 Add paper or clear the 

has no paper in its sheet jam, then press STOP.
feeder, or has a paper If a document was  
jam. received in memory,

the unit will automa-
tically print it from
memory.

RECEIVED IN FILE — The computer was Turn the computer on 
off and a document to upload the file to the
was received in the Desktop Manager or 
memory of the press FUNCTION then 
MultiPASS. select FILE PRINT from

the menu to print the
document.

REC’D IN MEMORY — The paper or ink ran out, Add paper to the sheet
or a paper jam occurred, feeder, change the 
so the MultiPASS BJ cartridge, or clear 
received the document the paper jam. Press
in memory. STOP to clear the error

message. The MultiPASS
automatically prints the
document stored in
memory.

START AGAIN — An error has occurred Start the procedure 
in the phone line or in again from the 
the system. beginning.

STOP KEY PRESSED — You pressed the STOP Resume operation.
button to cancel the
current operation.

TALK — The MultiPASS is set Answer the call.
for Fax/Tel mode and
you are receiving a
telephone call.

TX/RX CANCELLED — You pressed STOP to Try sending again.
cancel the transmission.

TX/RX NO. nnnn — When the MultiPASS Write the number down 
sends or receives a fax, if you’ll need it later.
it assigns it a unique
identification number.
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Printing Problems

Problem Cause Solution

The ALARM light The MultiPASS may have a Clear any paper jams. See 
comes on and the paper jam. page 10-3.
MultiPASS C5000
beeps while printing If the MultiPASS has no 

paper jam, unplug it, wait 
5 seconds, then plug it in again.
If the problem is fixed, the
ALARM light will be off, the 
BJ cartridge will move to its 
home position, and the LCD 
display will show the date and 
Receive Mode (Standby Mode).

If the ALARM light stays on,
call the Customer Care Center.
See page 1-4.

Data from computer is The power cord may not Check that the power cord
not printed be plugged in securely. is plugged securely into the

unit and into the wall outlet.
If the MultiPASS is plugged
into a power strip, make sure
the power strip is plugged in
and turned on.

The interface cable may not Check the interface cable 
be securely connected to the connection.
MultiPASS and the computer.

The interface cable may Make sure the cable is a
not be the correct type. bi-directional parallel interface

cable less than 6.6 feet in
length.

The MultiPASS or computer Unplug the MultiPASS and
may have been turned on turn off the computer. Plug
when you connected the the unit back in and turn
interface cable. the computer back on again.

The orange tape may not be Be sure to remove the tape
removed from the BJ cartridge. from the BJ cartridge when 

you install it. See page 9-14.

The BJ cartridge may not Make sure the BJ cartridge is
have been installed properly. installed correctly. See page

9-11.
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Problem Cause Solution

Data from computer is The print head unit may need Clean the print head. See
not printed (continued) cleaning. page 9-8.

The BJ cartridge may need to be Replace the BJ cartridge. See
replaced. (It may be out of ink.) page 9-11.

The application you are Check the computer and the
printing from may not be application to make sure they 
set up properly. are configured correctly.

Make sure your application has
the MultiPASS C5000 selected
as the printer.

The MultiPASS C5000 may not Make sure the MultiPASS
be set as the default printer C5000 is selected as the default
or the selected printer. or current printer.

Make sure MultiPASS
Background is running.

The printer driver may be Make sure the MultiPASS 
configured with the wrong Printer Driver is configured
port. to use the computer’s 

parallel port. See page 2-7.

The computer’s parallel port Make sure your computer’s 
may be disabled. CMOS has the primary 

parallel port set to LPT1.
(Your computer should have
a Setup Program that lets you 
do this.) See your computer’s
documentation.

BJ cartridge moves, The BJ cartridge or a BJ tank Make sure the BJ cartridge
ink does not appear may not be installed properly. and its BJ tank(s) are properly

installed. Make sure the orange
tape is removed from the print
head area (see page 9-14).

The nozzles on the BJ Perform the print head
cartridge may be clogged. cleaning procedure (see page 

9-8) and print the nozzle check
(see page 9-7).

A BJ tank may be empty Check the BJ tanks and
(BC-21e Color BJ cartridge). replace them if necessary.

10-12 Troubleshooting Chapter 10
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Problem Cause Solution

The printed output is There may be a communication Make sure the computer 
not what you expected problem between the MultiPASS and the application are 

and your computer. configured correctly for 
communicating with the
MultiPASS.

The interface cable may not Check the interface cable’s 
be securely connected to the connections.
MultiPASS and the computer.

The interface cable may not Make sure you are using a
be the correct type. bi-directional parallel interface 

cable that is less than 6 feet 
(2 m) long.

You may not be using the Make sure you have
correct printer driver. selected the MultiPASS

printer in your application.

You may not have the best Try selecting Coated Paper
media type selected. for the Media Type rather

than Plain Paper. See page
2-8.

Previous software settings Make sure the MultiPASS
may not be cleared. was cleared of the previous 

software settings before the 
print job started. See the 
application’s documentation.

Printout does not Paper may not be loaded Make sure the paper is loaded
match paper size and aligned correctly in and aligned correctly. See

the sheet feeder. page 2-18.

The application’s page Make sure the paper size and
size and margin settings margin set in your application
may be incorrect. are correct for the paper in the

sheet feeder.

The selected printer driver Make sure you select the
may be incorrect. MultiPASS printer in your

application.

The MultiPASS suspends The print head may have Stop your print operation
print after every line is become too hot. If this and wait several minutes to
printed happens, the MultiPASS may allow the unit to cool. Then

be slowing its print speed start your operation again.
at the end of each line to 
protect the print head.
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Problem Cause Solution

Print jobs vanish or you Another Windows application In the Preferences dialog box
are printing garbage on your computer may be of the Setup Options of the

trying to communicate with MultiPASS Desktop Manager,
the printer port the MultiPASS enable the Spooler: Desktop
background is using. This Manager option. This avoids
conflict can result in strange using the Windows 95 Print
printing behavior. Spooler and sends the print

job directly to the MultiPASS.

Make sure the MultiPASS If the MultiPASS Background 
Background is loaded. icon does not appear on the

bottom of your screen, turn on
the MultiPASS Background.

The printout curls Your pages may include a Remove each sheet as it is
large amount of ink. printed. Allow it to dry, then

roll it in the opposite direction
of the curl.

Your computer indicates A device time-out occurs when Make sure the MultiPASS is
a device time-out the computer sends data to the plugged in, and that its 

MultiPASS, but the MultiPASS interface cable is securely
does not respond. The attached to the unit and to
MultiPASS may be unplugged, the computer. Clear any paper 
not connected to the computer, jams, and make sure paper is 
or have a paper jam. loaded properly in the sheet

feeder.

Print Quality Problems
Problem Cause Solution
Print quality is not what The paper you are using Make sure you are using 
you expect; print is not may not be supported by the recommended paper 
clear; splashed or missing the unit. (see page A-2).
dots, white streaks

You may be printing on the Some paper has a right side 
wrong side of the paper. for printing. If the print quality

is not as clear as you would like
it to be, try turning the paper
over and printing on the other
side.

The print head nozzles Clean the print head (see 
may be clogged. page 9-8); repeat cleaning 

if necessary. If print quality is
not recovered after executing
the cleaning five times, replace
the BJ cartridge.
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Problem Cause Solution

Print quality is not what BJ cartridge may be Make sure the BJ cartridge
you expect (continued) installed incorrectly. and/or BJ tanks are installed

correctly.

A BJ tank in the BC-21e Replace BJ tanks as necessary.
Color BJ Cartridge may be See page 9-16.
empty.

The print head may be The BJ cartridge may need
worn out. to be replaced. Replace it with

a new one (see page 9-11).

Output appears jagged The resolution selected via Check your printer driver to
printer driver may be see what Print Quality you
Draft (180 dpi). have selected. Printing in Draft

mode will give the output a
jagged look. Changing the
Print Quality to Standard
should correct this problem.

Fonts do not print as Bitmapped fonts designed Make sure you installed an
smoothly rounded for dot matrix printers do outline font manager, such
characters not print smoothly rounded as Adobe® Type Manager or

characters when used with Bitstream® Facelift, or that
high resolution printers like you are choosing a TrueType®

the MultiPASS C5000. font.

Certain MS fonts, such as Choose another font.
MS Serif, will print jagged.

Output is faint You may be using Draft Try using Standard print
print quality or Fine mode. quality.

Printing takes too You may be using Fine Turn off Fine mode.
much time mode.

Blurred or smudged ink The print medium you are Try a different paper type;
using may not be supported however, use only print media
by the MultiPASS. specified in Appendix A,

Specifications.

You may be printing on Paper has a right side for 
the wrong side of the sheet. printing. If the print quality is

not as clear as you would like,
try turning the paper over and
printing on the other side.
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Color Printing and Copying Problems
Problem Cause Solution

Printer prints only in The MultiPASS printer driver Make sure the MultiPASS is
black (you are printing may not be selected. the default printer in your  
from an application that application.
supports color printing 
but your output is 

The printer driver may not be Check that you selected Color

black ink only)
selecting color. in the Color Model dialog box 

of the Graphics tab of the 
printer driver.

The color BJ cartridge may Print the Nozzle Check pattern
not be installed or may not to make sure the BC-21e Color 
be working properly. BJ Cartridge is installed and

firing correctly.

If a BJ tank is empty, replace it.

The print head unit may Clean the print head (see
need cleaning. page 9-8).

The application you are using Make sure your application
may not support color supports color printing.
printing.

Colors are broken or The print mode may be If you are printing high 
uneven wrong. density graphics on plain

paper, set the Media Type to
Coated Paper on the Paper tab
of the printer driver.

If you are printing a thin Choose cyan, yellow,
line with a nonprimary magenta, or black instead.
color, your software may 
be telling the unit to place
a color every other dot,
with white in between.

Colors print incorrectly The MultiPASS printer Make sure the MultiPASS
driver may not be selected. is the default printer in your

application.

The driver may not be Check that you selected 
selecting color. Color in the Color Model

dialog box in the Graphics tab
of the printer driver.

The driver may not be Make sure the correct paper 
selecting the right media. type is set in the driver.

Colors are missing The print head may need to Clean the print head (see 
be cleaned. page 9-8).
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Problem Cause Solution

Colors in a line are The print settings may not If you are printing high
uneven or different be the best for the images density color graphics on
from previous lines you are printing. plain paper, change the Media

Type setting from Plain Paper
to Coated Paper.

Be sure to experiment with
different settings and different
types of paper.

Hue changes The print nozzles may be Clean the print head. See
clogged with dust. page 9-8.

A BJ tank may be empty. Replace empty BJ tanks as
needed. See page 9-16.

Blue looks like purple Blue prints out as purple Within the MultiPASS printer
because of the difference in driver, selecting Match (screen
color technology used by match) in the Color Adjustment
the screen and printer; the dialog box of the Custom Setting
screen uses RGB (Red, Green, window will result in a lighter
Blue) color and the MultiPASS blue. If you are not using
uses CMYK (Cyan, Magenta, screen matching, decreasing
Yellow, Black) color. Due to the the amount of magenta by 30%
technology differences, when produces a royal blue.
cyan and magenta are mixed
together, blue  prints dark blue

If you are just looking for a

or purple compared to the screen.
nice blue color, try cyan. It 
prints beautifully and fast 
and is available in almost all
applications that support color.

Color images are Check to see if your MultiPASS If so, change the Media Type
missing some detail printer driver is set to Plain setting from Plain Paper to

Paper, Color Mode, and Coated Paper.
Halftoning=Pattern.

Paper Feeding Problems
Problem Cause Solution

Paper does not load The sheet feeder may contain Make sure the stack of paper
too many sheets. in the sheet feeder does not

exceed the limit mark.

Paper may not be inserted Make sure the stack of paper
correctly. is inserted into the sheet feeder,

and the paper guide is adjusted
correctly. Tr
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Problem Cause Solution

Paper is loaded skewed Paper may not be stacked Make sure the stack of paper
(printing is skewed) correctly in the sheet feeder. is straight in the sheet feeder.

Make sure the right side of the
stack of paper is aligned against
the right side of the sheet
feeder and the paper guide is
aligned against the left side.

Make sure the paper exit path
is clear.

Multiple sheets load Paper may not be stacked Make sure paper is installed
into unit at the same correctly. correctly in the sheet feeder.
time

Sheets of paper may be Be sure to fan the stack of
sticking together. paper before placing it in the

sheet feeder.

Too much paper may be Make sure the paper rest is
stacked in the sheet feeder. extended and the paper is

stacked correctly in the sheet
feeder.

Make sure the stack of paper
does not exceed the limit mark.
If necessary, remove a few
sheets from the sheet feeder.

Do not stack more than 
approximately 100 sheets of
plain paper in the sheet feeder.

Do not force the stack into the
sheet feeder.

Different types of paper may Load just one type of paper.
be stacked in the sheet feeder.

Make sure you are loading
paper that matches the
specifications of this unit.
See Appendix A, Specifications,
for details.

Transparencies or back The film may not be loaded Make sure you load no more
print film do not feed correctly. than 50 sheets of transparencies
correctly or 10 sheets of back print film

in the sheet feeder.
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Problem Cause Solution

Repeated paper jams The paper you are using may Fan the paper before stacking
occur be causing the jams. it in the sheet feeder. This

keeps the sheets of paper from
sticking together.

Check that the paper you are
using and your printing
environment are within the
specifications of the unit. See
Appendix A, Specifications,
for details.

Envelopes do not load Envelopes may not be Make sure the envelopes are
loaded correctly. loaded properly. (See page 

2-24.)

Make sure there are no more
than 10 envelopes in the sheet
feeder.

You may need to choose Make sure you select the
the envelope setting in correct envelope size in the
your printer driver. Paper Setting dialog box in

your printer driver.

Envelopes may not match Envelopes must be U.S.
specifications for this unit. Commercial number 10 

(9.5 × 4.1 inches) or 
European DL envelopes 
(220 × 110 mm).

Faxing Problems
Problem Cause Solution

Cannot send a The MultiPASS may have Unplug the unit and let it
document overheated. cool for several minutes. Try

sending again.

The MultiPASS may not be If you have a pulse line, be 
set for the type of telephone sure the MultiPASS is set
line in use (pulse/tone). for pulse dialing.

The document may not Remove the document, stack
have been fed correctly it, and feed it into the unit
into the MultiPASS. correctly (see page 1-14).

Make sure the operator panel 
is closed.
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Problem Cause Solution

Cannot send a The one-touch or coded Check the one-touch or coded
document (continued) speed dialing number you speed dialing button and be

used may not be registered sure it is registered correctly.
for the feature you want 
to use.

The other party’s fax may be Call the other party and ask
out of paper. them to make sure paper is

installed.

There may be other documents Allow time for the current 
being sent from memory. document to finish sending.

The telephone line may not Make sure there is a dial tone
be working properly. when you lift the telephone.

If not, contact the local
telephone company.

The receiving fax machine may Make sure the receiving fax 
not be a G3 fax machine. machine is compatible with 

the MultiPASS (which is a G3
fax machine).

Images on faxes The receiving fax machine may Check the MultiPASS by
received from the not be working properly. making a copy. If the copy is
MultiPASS are clear, the problem may be in 
spotted or dirty the receiving fax machine.

The document may not be Remove the document and
properly inserted in the feed it correctly into the 
ADF. ADF. See page 1-14.

Cannot send or receive The other party’s fax may Some fax units do not 
using Error Correction not support ECM. support ECM transmission.
Mode (ECM) If the other party’s fax does

not support ECM trans-
mission, then the document is
sent in the normal mode
without error checking.

Errors occur frequently The phone line may be in Lower the transmission speed.
while sending or receiving poor condition, or you may See the Advanced: Send Fax

have a poor connection. dialog box (page 8-5) and the
Advanced: Receive Fax dialog
box (page 8-8).

The sending fax machine may The sending fax machine
not be functioning properly. usually determines the fax’s

quality. Call the sender and 
have them make sure the top 
cover and scanning glass on 
their fax machine are clean.
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Problem Cause Solution

Cannot receive a The MultiPASS may not be To receive faxes automatically,
fax automatically set to receive automatically. the Receive mode must be

Fax Only, Fax/Tel, or Ans.
Machine mode.

The MultiPASS may have a Print out any document 
document stored in memory. stored in memory. (See 

page 5-5.)

The MultiPass Desktop Check the In Box in the 
Manager may have Desktop Manager.
received the fax.

An error may have occured Check the LCD for an error
during reception. message. See page 10-6.

The sheet feeder may be Make sure paper is loaded
empty. in the sheet feeder.

The telephone line may not Make sure all phone line
be connected properly. connections are secure.

The MultiPASS is printing The incoming fax is stored 
a document. in memory and will print

when the print job is 
complete.

The MultiPASS does The MultiPASS may not For the MultiPASS C5000 
not switch automatically be in Fax/Tel mode. to switch automatically 
between telephone and between telephone and 
fax transmissions fax reception, the Receive

mode must be set to Fax/Tel
mode.

There may be a document Make sure you have printed
in memory. out any documents in memory.

An error may have occured Check the LCD for an error
during reception. message. See page 10-6.

The sheet feeder may be Make sure paper is loaded in
empty. the sheet feeder.

The sending fax may not Some fax units cannot send
send the CNG signal that the CNG signal that tells your
tells the MultiPASS that the MultiPASS the incoming signal
incoming signal is a fax. is from a fax. In such cases,

you will have to receive the
document manually.
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Problem Cause Solution

Cannot receive a You may have pressed Always press START/COPY
document manually START/COPY after hanging before hanging up the 

up the telephone. telephone. Do not press 
START/COPY after you hang
up the telephone; this will 
disconnect the call.

Print quality is poor You may not be using the Be sure you are using paper
correct type of paper. that meets the paper

requirements for the
MultiPASS (see page A-1).

The print head may need Clean the print head 
to be cleaned. (see page 9-8).

The sending party may be Make a copy on your
having a problem. MultiPASS. If the image is

OK, then your MultiPASS is
operating properly. Contact
the other party and have
them check their machine.

Error correction (ECM) Make sure Error correction
may be disabled. (ECM) is set to on in the

Advanced: Receive fax
dialog box of the Desktop
Manager.

Faxes do not print The BJ cartridge may not Be sure to remove the orange
be installed correctly. tape from the BJ cartridge

before you install it in the
MultiPASS (see page 9-14).

Make sure the BJ cartridge is
installed correctly (see page 
9-11).

The print head may need Clean the print head several 
cleaning. times (see page 9-8).

The BJ cartridge may need Try another BJ cartridge.
to be replaced.

Fax images print blotched The telephone lines may ECM sending/receiving should
or uneven be in poor condition, or eliminate such problems.

you may have a bad However, if the telephone 
connection. lines are in poor condition,

you may have to try again.

The other party’s fax may Remember, the sending fax
have a problem. usually determines document

quality. Be sure the other
party’s top cover and scanning
glass are clean.
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Telephone Problems
Problem Cause Solution

You cannot dial The telephone line may Be sure the telephone line is
not be connected properly. correctly connected to the

MultiPASS (see your Setup
Guide).

The unit may not be getting Make sure the power cord is
power. connected to the MultiPASS

and to an AC outlet; make
sure the AC outlet has power.

The MultiPASS may not If you have a pulse line, be 
be set for the type of sure the MultiPASS is set for
telephone line in use pulse dialing (see page 8-4).
(pulse/tone).

The phone disconnects The MultiPASS may not be Make sure the MultiPASS
while you are talking plugged in properly. is plugged in correctly.
on the line

If the MultiPASS is in Disable the Silent Receive
Answer Machine Mode and option on the Receive Fax
Silent Receive is enabled, tab of the Desktop
the unit will switch to fax Manager.
receive mode when it detects
a period of silence.

Copying Problems
Problem Cause Solution

The MultiPASS will not The MultiPASS may have a Replace the empty BJ tank.
make a copy BC-21e Color BJ Cartridge See page 9-16.

installed, and its black BJ tank
may be empty.

The MultiPASS may have a The MultiPASS will not make
BC-22e Photo BJ Cartridge copies when the BC-22e
or BC-29F Neon BJ Cartridge Photo BJ Cartridge or the
installed. BC-29F Neon BJ Cartridge 

is installed. Replace the
cartridge with a BC-21e 
Color BJ Cartridge or BC-20 
Black BJ Cartridge.

The telephone may be off hook. Make sure the telephone is 
in its cradle.
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Problem Cause Solution

The MultiPASS will not The document may not be Make sure a document is set
make a copy (continued) loaded correctly. in the ADF and the LCD

displays DOCUMENT READY.

Make sure the operator panel
is closed.

The BJ cartridge is not Make sure the BJ cartridge is
installed. installed correctly.

The MultiPASS may not be Try to print a document from
be operating properly. your computer.

MEMORY FULL The MultiPASS’s memory Print out any faxes stored in 
appears in the LCD is full. memory. Then print one copy 
when you are making at a time.
multiple copies

General Problems
Problem Cause Solution

The MultiPASS has The power cord may not be Make sure the power cord is
no power securely plugged into the unit. plugged securely into the unit

and into a wall outlet.

If the power cord is connected
to a power strip, make sure the
strip is connected to an outlet
and turned on.

The power cord may not be Check the power cord by
supplying power. substituting another, or by

using a voltmeter to test it for
continuity.

The MultiPASS will not The MultiPASS may have a Replace the empty BJ tank.
print reports BC-21e Color BJ Cartridge See page 9-16.

installed, and its black BJ
tank may be empty.

The BC-22e Photo BJ Cartridge Remove the BC-22e and install
may be installed. the BC-21e Color or BC-20

Black BJ Cartridge.

Nothing appears in the The MultiPASS may not be Check the plug and be sure it is
LCD display receiving power. firmly plugged into the power

connector and the wall outlet.

If the display remains blank,
unplug the MultiPASS, wait five
seconds, then plug it in again.
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Technical Notes

Using Other Bi-directional Devices
If you have another bi-directional device (such as a Windows Printing
System printer or a later-model laser printer) installed on your computer
and you are attempting to use the same port on which you have the
MultiPASS C5000 connected, you may experience undesirable results
when printing a document.

Be sure the MultiPASS C5000 is the only device configured to a
particular port. The MultiPASS C5000 operates properly only with 
a dedicated parallel port.

MultiPASS Hardware Cannot Initialize
1. Remove any pass-through devices, switch boxes, zip drives, tape

backups, docking stations, scanners, and any software associated
with these products.

2. Make sure that the MultiPASS C5000 is connected directly to the
computer with a bi-directional (IEEE 1284-compliant) interface
cable that is 6 feet or shorter. Do not attempt to use a longer cable.

3. Shut down the computer and unplug the MultiPASS C5000.
Disconnect and reconnect the interface cable. Plug in the MultiPASS
C5000 and wait until the LCD displays the date and Receive Mode.
Once the unit is in Standby mode (the LCD displays the date and
Receive Mode), turn on the computer.

4. Check that the parallel port is set for ECP or bi-directional mode in
the computer’s BIOS. If you do not know how to enter the BIOS or
make the changes, contact the computer manufacturer.

5. If the above procedures do not resolve the problem, please call the
Canon Computer System Customer Care Center. See page 1-4 for
details.
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Memory Clear Report
The Memory Clear Report summarizes the documents that were cleared
from memory when a power failure occurred. This report is generated
automatically.

❍ If you experience a power failure, any documents stored in memory
will be lost.

❍ When you turn on the MultiPASS C5000 after power is restored, the
MultiPASS C5000 automatically prints out a list of documents that
were stored in the memory at the time of the power failure.
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Printing Method
Bubble jet ink on-demand

Printing Resolution
720 × 360 dpi 

Paper Handling
Automatic feed
Manual feed

Sheet Feeder Capacity—auto feed only
Plain paper

(20 lb or 75 g/m2) Approx. 100 sheets 
Glossy photo paper 1 sheet
High resolution paper Approx. 10 sheets 
T-shirt transfers 1 sheet
Bubble Jet paper Approx. 100 sheets 
Fabric sheets 1 sheet
Transparencies 50 sheets
Back print film 10 sheets
Envelopes 10 envelopes (U.S. Commercial 

number 10 or European DL)

Paper Size
Letter 8.5 in × 11 in
Legal 8.5 in × 14 in
A4 210 mm × 297 mm
U.S. Commercial  

number 10 envelope 9.5 in × 4.1 in
European DL envelope 220 mm × 110 mm

ASpecifications
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Media Type Recommended
Glossy photo paper Canon Glossy Photo Paper GP-201
High resolution paper Canon High Resolution Paper HR-101
T-shirt transfers Canon T-Shirt Transfers TR-101
Greeting cards Canon Greeting Cards GC-101
Bubble Jet paper Canon Bubble Jet Paper (water-resistant) 

LC-301
Fabric sheets Fabric Sheet FS-101 for Canon Bubble 

Jet printers
Back print film Canon Back Print Film BF-102
High gloss film Canon High Gloss Film HG-101
Transparencies Canon CF-102 Transparencies
Envelopes Commercial number 10 or European DL

Paper Weight
Automatic feed 17 to 24 lb (64 to 90 g/m2) 
Manual feed 17 to 28 lb (64 to 105 g/m2) 

Print Speed 
BC-21e Color BJ Up to 2 ppm
Cartridge; black ink (1500 characters per page)

BC-21e Color BJ Up to 0.3 to 0.8 ppm at full coverage of
Cartridge; color ink printable area (print speed depends on

content of print data)

Optional BC-20 Black Up to 5 ppm
BJ Cartridge; black (1500 characters per page)
ink only

Line Feed Speed
Approximately 60 ms/line at 1/6-inch line

Printing Width
Maximum 8.2 in (203 mm)
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Printable Area—Papers
The shaded portion in the following figure shows the printing area 
for papers.

Printable Area—Envelopes
The shaded portion in the following figure shows the printing area for
an envelope.

Interface
IEEE 1284-compatible, bi-directional parallel interface

European 
DL

a 220 mm
b 6.4 mm
c 10.4 mm
d 110 mm
e 3.0 mm
f 7.0 mm

U.S. 
Commercial 
number 10

a 9.5 in
b 0.25 in
c 1.2 in
d 4.1 in
e 0.12 in
f 0.27 in

A4 size
a 210 mm
b 3.4 mm
c 297 mm
d 3.0 mm
e 7.0 mm

Legal size
a 8.5 in
b 0.13 in
c 14.0 in
d 0.12 in
e 0.27 in

Letter size
a 8.5 in
b 0.13 in
c 11.0 in
d 0.12 in
e 0.27 in
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BJ Cartridges
BC-21e Color BJ Cartridge
Print head 64 nozzles for black

24 nozzles for each color (cyan, magenta,
yellow)

Print head life Approximately 2,000 color pages at 30%
coverage 

BJ tanks BCI-21 Color (cyan, yellow, magenta) 
BCI-21 Black

Ink color Black, cyan, yellow, magenta
BJ tank yield

BCI-21 Color Standard mode—100 pages 
(at 7.5% coverage for each color)

BCI-21 Black Standard mode—150 pages
(at 7.5% coverage)

Contents
Color Glycerine 56-81-5
Black Isopropyl alcohol 67-63-0, glycerine

56-81-5, ethylene glycol 107-21-1

BC-20 Black BJ Cartridge (optional)
Print head 128 nozzles
Ink color Black
Cartridge yield 900 text pages at 5% coverage
Contents

Color Glycerine 56-81-5
Black Isopropyl alcohol 67-63-0, glycerine

56-81-5, ethylene glycol 107-21-1

BC-22e Photo BJ Cartridge (optional)
Print head 64 nozzles for black

24 nozzles each for cyan, magenta, yellow
Ink colors Black, cyan, magenta, yellow
Cartridge yield Approx. 50 pages/cartridge at 7.5% coverage

for each color

BC-29F Neon BJ Cartridge (optional)
Print head 64 nozzles for black

24 nozzles each for cyan, magenta, yellow
Ink colors Flourescent magenta, yellow, normal cyan,

black
Cartridge yield Approx. 100 pages/cartridge at 7.5% coverage

for each color
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Facsimile
Applicable line
Public switched telephone network

Compatibility
G3

Data compression system
MH, MR, MMR (ECM-MMR)

Modem type
Fax modem

Modem speed
14400/9600/7200/4800/2400 bps

Automatic fallback

Transmission speed
Approx. 6 seconds/page* at 14.4 Kbps, ECM-MMR

transmitting from memory

Transmission/reception memory
672 KB DRAM, MR storage
Up to 42 pages*
Up to 20 documents*
LCD displays memory used 
Uses direct transmission when memory full

Automatic Document Feeder (ADF)
20 pages, letter size (based on 20 lb paper)
10 pages, legal size

Fax resolution
Fine mode—203 pels/in × 196 lines/in

(8 pels/mm × 7.7 lines/mm)

Standard mode—203 pels/in × 98 lines/in
(8 pels/mm × 3.85 lines/mm)

Fax printing speed
Approx. 4 pages/minute*

*Based on the CCITT #1 Chart, Standard mode
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Dialing
Automatic dialing

One-touch speed dialing (6 locations)
Coded speed dialing (50 locations)
Group dialing (55 locations)

Manual dialing (with numeric buttons)
Automatic redialing (including error redialing)

Redial times: 1-10
Redial interval: 2-99 min

Manual redialing
Paul button (variable length: 1-15 sec)

Networking
Sequential broadcast (up to 57 locations)
Automatic receiving
Non-ring reception
Deactivate ECM
DRPD (Distinctive Ring Pattern Detection)

Report/reference
Activity report (up to 20 transactions)
Non-delivery report
TTI (Transmitter Terminal Identification)

Ink saver
Economy mode for printing received faxes extends 
cartridge life to approx. 1800 pages
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Copier
Scanning resolution
B&W Fine: 203 pels/in × 196 lines/in
B&W Photo: 203 pels/in × 196 lines/in with halftone mode
Color Fine: 360 × 360 dpi, full color
Color Standard: 360 × 180 dpi, full color
Color Snapshot: 360 × 360 dpi, full color

Printing resolution
360 × 360 dpi

Default size
100%

Reduction sizes
70%, 80%, 90%

Copy speed
Black and white copy

Initial copy—45 seconds
Subsequent copies—20 seconds

Color copy
COLOR FINE mode, Letter size—11 minutes

Multiple copies
Up to 99 copies of a document
1 copy of a color document

Scanner
Scanning method
Solid-state electronic scanning by contact image sensor

Scanning image processing
UHQ™ (Ultra High Quality image enhancement)
Halftones—256 levels of gray
Color—16.7 million colors
Photo/text auto-recognition
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Automatic document feeder
Paper size—Up to 20 letter-size or A4-size sheets

10 legal size sheets
(Based on 20 lb paper)

Paper thickness
Auto feed—0.003-0.005 in (0.08-0.13 mm)
Manual feed—Up to 0.017 in (0.43 mm)

Paper Weight
Auto feed—20-24 lb (75-90 g/m2)
Manual feed—24-90.7 lb (90-340 g/m2)

Resolution
Optical 300 dpi
Enhanced 30-600 dpi (set from within application)

Effective scanning width
8.42 in (214 mm)

Compatibility
TWAIN

Scanning speed
B&W Text (40-150 dpi)—9 sec/page 5 ms/line
B&W Text (160-300 dpi)—18 sec/page 5 ms/line
B&W Text (310-600 dpi)—35 sec/page 5 ms/line
Grayscale (40-150 dpi)—13 sec/page 7 ms/line
Grayscale (160-300 dpi)—25 sec/page 7 ms/line
Grayscale (310-600 dpi)—78 sec/page 11 ms/line
Color (40-150 dpi)—39 sec/page 21 ms/line
Color (160-300 dpi)—75 sec/page 21 ms/line
Color (310-600 dpi)—234 sec/page 33 ms/line

Document sizes
Maximum 8.5 in W × 39.3 in L (216 mm W × 1000 mm L)
Minimum 3.5 in W × 2.5 in L (88.9 mm W × 63.5 mm L)
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Scanned image
The actual scanned image size for the MultiPASS C5000 is shown below.
This information applies to documents that will be scanned for faxing
or copying.

There is a 0.12 in (3.0 mm) margin on either side of the sheet and a 
0.16 in (4.0 mm) margin on the top and bottom that are not picked 
up by the scanner.

MultiPASS Desktop Manager for Windows
System Requirements
IBM® PC or compatible computer with a 486DX 66 MHz or 

higher processor
16 MB of memory 
25 MB of free hard disk space (37 MB additional hard disk space 

for Pagis for MultiPASS)
Microsoft Windows 95 
Bi-directional Centronics-compatible parallel cable (IEEE 1284-compliant)
CD ROM drive

PC Fax
Canon proprietary MultiPASS Desktop Manager for Windows
Fax/Telephone address book
Fax Viewer
Fax Log
Fax distribution lists
Real-time MultiPASS C5000 hardware status available through computer
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General Specifications
Power Source
120V/60Hz

Power Consumption
Approx. 48W (Maximum)
Approx. 8.4W (Standby)

Dimension (W x D x H)
15.75 in × 14.4 in × 7.75 in
(400 mm × 365 mm × 197 mm)
Main unit – no trays

Weight
12.3 lb (5.6 kg)

Environmental Conditions
Temperature: 50° F - 90.5° F (10° C - 32.5° C)
Humidity: 20% to 85% RH

Liquid Crystal Display (LCD)
16 × 1

Display Languages
English, French, Spanish

Telephone
Automatic FAX/TEL switchover
Answering machine hook-up

(CNG detecting signal, no sound)
Telephone hook-up
Remote reception by telephone
Remote receiving ID (Default): 25
Tone button
Pause button (variable length: 1-15 sec)
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Space Requirements
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Receiving Faxes and Phone Calls
Automatically—Fax/Tel Mode

In Fax/Tel mode, the MultiPASS C5000 monitors all incoming calls to
see whether the call is from another fax machine or from a telephone:
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If you plan to use the MultiPASS C5000 as a stand-alone fax, and you do
not install the MultiPASS Desktop Manager, you must enter your name
and fax number from the operator panel. If you choose to use the
MultiPASS C5000 this way, you will not be able to use its many features,
such as speed dialing, PC faxing, or scanning. Canon recommends that
you install the MultiPASS software as described in the Quick Start Guide.
See Chapter 3 for details on using the MultiPASS Desktop Manager.

LCD Menu System
Default settings are shown in bold.

Option Description/Settings

USER SETTINGS

DATE & TIME Set the date and time (24-hour clock) using the
numeric buttons.

UNIT TELEPHONE # Enter your fax number using the numeric
buttons (up to 20 characters).

UNIT NAME Enter the name you want to appear at the top of
each fax page you send (up to 24 characters).

TEL LINE TYPE Sets the dialing method the MultiPASS C5000
uses to match the type of phone line you have.
TOUCH TONE or ROTARY/PULSE

COLOR COPY MEDIA Select PLAIN PAPER when printing on plain
paper, or HIGH RES. PAPER for special print
media, such as Canon’s High Resolution Paper
HR-101.

RX MODE Sets the Receive Mode.

FILE PRINT Prints documents stored in the MultiPASS
memory (when the MultiPASS Desktop
Manager is installed).

ROLLER CLEANING Cleans the rollers inside the MultiPASS.

BUsing the MultiPASS C5000 
as a Stand-alone Fax



Option Description/Settings

HEAD CLEANING Cleans the print head on the  BJ cartridge.

NOZZLE CHECK Prints a test pattern to check whether the 
BJ cartridge is functioning normally.

Entering Information in the 
MultiPASS C5000

When using the MultiPASS C5000 as a stand-alone fax machine, you
must enter your user information into the unit through the operator
panel.

When entering information through the operator panel of the
MultiPASS C5000, follow these guidelines.

❍ If you pause and do not make an entry for more than 60 seconds,
the MultiPASS C5000 returns to Standby mode. You must start the
procedure over from the beginning.

❍ If you make a mistake while entering registration information, you
can correct it in one of two ways:

• Press < or > to move the cursor under the wrong character, and
then enter the correct character.

• Press STOP and reenter the information.

Entering Your User Information
Follow the steps below to set the date and time for your MultiPASS
C5000 and to enter your fax number and your name. The date and time
appear in the LCD display as well as on the documents you send. Your
fax number and name appear on each document you send.
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❍ Use the month-day-year format (mm/dd/yy).

❍ Precede single digits with a zero.

11/15/97 00:00

Enter today’s
date and the 

time using the 
numeric buttons.

06/08/97     15:36

DATE & TIMEPress
START/COPY

twice.

USER SETTINGS
Then press  

the > button.

FUNCTION 
Press FUNCTION

on the one-touch
speed dialing

keypad.
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❍ Set the time using the 24-hour clock system.

❍ Example:

07:30 = 7:30 A.M.
17:05 = 5:05 P.M.

❍ You can enter a space with the > button to make your
number easier to read.

TEL =   6665552222

Enter your fax
number (up to 20

digits) using the
numeric buttons.

TEL = 

DATA ENTRY OKPress START/COPY
twice when the

date and time 
are entered.

11/15/97     08:15
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❍ After a few seconds, the LCD display changes to:

❍ Press the button with the letter you want to enter; for
example, press 2 three times to enter a capital C.

Button Characters
1 1
2 ABCabc2
3 DEFdef3
4 GHIghi4
5 JKLjk15
6 MNOmno6
7 PQRSpqrs7
8 TUVtuv8
9 WXYZwxyz9
0 0
# -.*#!”,;:^’_=/|’?$@%&+()[]{}<>

❍ Correct errors by moving the cursor to the error using 
< or > (on the one-touch speed dialing keypad) and
entering the correct character.

CANON FAX BACK

Enter your name
(up to 24

characters) using
the numeric

buttons.

Then press
START/COPY

again.

UNIT NAME

DATA ENTRY OKPress START/COPY
when the fax

number is entered.
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The MultiPASS C5000 returns to
standby mode.

Press STOP to
complete the
registration.

DATA ENTRY OKPress START/COPY
when you finish

entering your
name.

B-6 Using the MultiPASS C5000 as a Stand-alone Fax Appendix B
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Activity report
Journal of fax transactions, both sent and received.

Address Book
The electronic Address Book provided by the MultiPASS Desktop
Manager that allows you to create a list of people with their phone and
fax numbers.

Automatic dialing
Dialing fax or telephone numbers by using a shortcut of pressing one to
three buttons. To use automatic dialing, you must register the numbers
in the MultiPASS Desktop Manager. See also one-touch speed dialing
keypad, coded speed dialing, and group dialing.

Automatic document feeder (ADF)
Refers to the document tray in which you stack the document you want
to fax, copy, or scan.

Automatic redialing
When the receiving fax machine is busy or does not answer, or when an
error occurs while sending, the MultiPASS waits a specified amount of
time and then automatically redials the number. You define the number
of times the unit redials and the length of time between redialing.

Bi-directional parallel interface port 
An interface connection that is capable of both sending or receiving. For
example, when you print and when you send a fax from your computer,
data goes from your computer to the MultiPASS; when you scan and
when you receive a fax into your computer, data goes from the
MultiPASS to your computer.

BJ cartridge
The printing mechanism that contains the print head unit and BJ tanks.

BJ tank
The special type of ink container housed by the BJ cartridge. The 
BC-21e Color BJ Cartridge contains two BJ tanks: one color—BCI-21
Color (which includes cyan, yellow, magenta) and one black—BCI-21
Black.

GGlossary
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bps
Bits per second. Refers to the speed with which a fax machine sends and
receives data.

Broadcasting
Transmitting documents to more than one location.

Bubble Jet printing
An ink-jet type printer that heats the ink to a boiling point in a nozzle to
form a bubble. When the bubble expands, there is no room left in the
nozzle for the ink and the ink is projected onto paper.

CCITT #1 Chart
A test chart, defined by CCITT/ITU-TS, used to measure the
transmission speed as well as the transmitting and receiving memory
capacity of a fax machine.

CCITT/ITU-TS
Formerly known as CCITT, Consultative Committee for International
Telegraph and Telephone. CCITT has been replaced by the International
Telecommunications Union-Telecommunications Sector (ITU-TS), a
committee created to set international standards for
telecommunications.

Centronics
The popular name for the parallel printer port used by most printers
and personal computers.

CNG
Calling Tone. This is a signal sent by fax machines to identify the call as
an incoming document. When the receiving fax detects this signal, it
automatically starts to receive the fax transmission. The majority of fax
machines in use today can send and detect CNG signals.

Coded speed dialing
An automatic dialing method that allows you to dial a fax or telephone
number by pressing the CODED DIAL button and a two-digit code using
the numeric buttons.

cps
Characters per second. A unit of measurement that indicates the printer’s
speed.
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dB(A)
Stands for decibel level (a decibel being a unit of measurement for the
intensity of the sound coming from the unit), adjusted for background
noise.

Dialing methods
Ways of pressing one or more buttons to access a number to connect to
an outside party or fax machine. Dialing methods include one-touch
speed dialing, coded speed dialing, group dialing, and manual (regular)
dialing.

Dithering
A method by which color dots are combined on a page to produce a
wide spectrum of colors.

Document
The sheet of paper containing the data that you send to or receive from
a fax.

dpi
Dots per inch. A unit of measurement for indicating a printer’s
resolution.

DRPD
Distinctive Ring Pattern Detection. Allows you to assign up to five
different ring patterns to distinguish voice and fax calls using your
telephone company’s special services.

ECM
Error Correction Mode. The ability of your MultiPASS to reduce system
and line errors when sending or receiving from another fax with ECM
capability. ECM is most effective in areas where the telephone lines are
in poor condition or there is frequent interference on the line.

FAX/TEL switching
The ability of the MultiPASS to automatically detect whether a call is
from a fax or telephone. With this feature, one telephone line can be
shared by both the telephone and the fax.

FINE
The fax setting for documents with very small characters and lines.
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Fine mode
One of the printer’s print modes. Use this mode when printing on
transparencies or printing a halftone image that produces grayscale or
intermediate colors.

Font
A complete set of characters of the same size and style; a particular
implementation of a typeface. For example, 12-point, Courier bold.

G3, Group 3 fax machine
Defined by CCITT. Uses encoding schemes to transmit image data while
reducing the amount of data that needs to be transmitted, thus reducing
transmission time. Encoding schemes for G3 fax machines are Modified
Huffman (MH), Modified Read (MR), and Modified Modified Read
(MMR).

Grayscale
Representing color in black and white as a result of different intensities
of color. Different colors and intensities of colors appear as different
shades of gray.

Group dialing
A dialing method that enables you to dial up to 55 registered one-touch
speed dialing or coded speed dialing numbers together as a group. This
means that you can press just one to three buttons to enter numbers
when sending the same document to many destinations.

Halftone
Using this method, the MultiPASS (in printer mode) produces shades of
gray or of colors by mapping dots to be printed. For color printing,
different colored dots of ink are placed closely together to create
illusions of other colors.

IEEE 1284
IEEE 1284 is the new specification standard for computer-to-peripheral
bi-directional parallel interface communications. The new standard was
adopted by IEEE, Institute of Electrical and Electronic Engineers, Inc., in
1993. Some of the benefits it provides are: bi-directional communication
between computers and peripheral devices, a higher speed data transfer
rate, and protection against data loss due to noise interference.
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Ink Saver
You can enable or disable economy printing (ink saving feature) when
receiving faxes. By enabling the Ink Saver Mode, ink consumption can be
decreased by as much as fifty percent, resulting in a longer effective
cartridge life. You set Ink Saver Mode in the Advanced: Receive Fax
dialog box.

Intensity
The amount of color. More intense or more saturated colors are more
pure. Less intense or less saturated colors are less vivid.

Interface port
The MultiPASS comes with one IEEE 1284, bi-directional parallel
interface port, located on the back of the unit. You attach the cable that
connects your computer and MultiPASS to this port.

Jack
The telephone receptacles (RJ11 type) on your wall or in your
MultiPASS used to connect the MultiPASS to the telephone line,
telephone, answering machine, or data modem.

Landscape orientation
Refers to printing across the length of the page (as opposed to portrait
orientation printing across the width of the page).

Manual feed
A method of feeding paper into the printer one sheet at a time.

Manual receiving
A method of receiving faxes in which you answer all incoming calls
using a telephone.

Manual redialing
When you use regular dialing, you can redial a number “manually”
simply by pressing REDIAL on the operator panel. The last number
called is the number redialed.

Memory broadcast
Allows you to send a scanned fax to as many as 57 locations at once,
using a combination of one-touch speed dialing, coded speed dialing,
and regular dialing.

Modem
A device that converts (Modulates) digital data for transmission over
telephone lines. At the receiving end, this device converts the modulated
data (DEModulates) to digital format that the computer understands.
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MultiPASS Desktop Manager for Windows
Canon’s exclusive software package that allows you to use the MultiPASS
C5000 with your Windows software applications. You must install the
Desktop Manager to use your MultiPASS C5000 as a printer, scanner, or
PC fax.

Noise
A term applied to a variety of problems that impair the operation of
telephone lines used for faxing.

Noise level
See dB(A).

Nonbleed
A special mode in color print quality selection whereby the printer
changes from true black to composite black when directly adjacent to an
area of color.

Numeric buttons
The round numbered buttons on the operation panel marked the same
as a standard telephone keypad. Press them to perform manual dialing,
to enter numbers and letters when you register numbers and names, and
to enter coded speed dialing codes with two or more digits.

One-touch speed dialing keypad
The round buttons numbered 1 to 6 on the operator panel, each of
which may be registered as a fax or telephone number. Once a number is
registered, you press one button to dial the entire number.

Page orientation
Refers to the direction of print on the page. Printing across the width of
a page is called portrait orientation. Printing across the length of a page
is called landscape orientation.

Pause
A timing entry required for registering certain long distance numbers
and for dialing out through some telephone systems or switchboards.
Pressing the REDIAL/PAUSE button enters a pause between digits of a
telephone number.

PC fax
An electronic way to send and receive faxes. A PC fax is sent from or
received directly into a computer. Using the MultiPASS Desktop Manager
you can send and receive PC faxes, and save, sort, and/or print the PC
faxes.
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Portrait orientation
Refers to printing across the width of the page (letter style). This is the
opposite of landscape orientation, which is printing across the length of
the page.

Print head
The printing mechanism that contains print nozzles and ejects the ink for
printing.

Print head capping
An automatic protection function that prevents the print head unit and
BJ cartridges from drying out or becoming clogged with dust.

Printable area
The area of a sheet of paper or envelope on which a printer can
reproduce text or graphics (the printable area is smaller than the paper).

Printer driver
Software that sends printing instructions to a printer (in this case, the
MultiPASS C5000). The printer driver keeps track of the attributes of a
printer and the codes the program must send to access those attributes.

Pulse
See Rotary pulse.

RAM
Random Access Memory. Memory that is used for temporary storage of
information such as documents you want to print, scanned and received
documents, and downloaded fonts.

Receiving
Receiving faxes is also defined as RX or reception. This refers to how the
MultiPASS C5000 receives fax documents.

Redialing, automatic
See Automatic redialing.

Redialing, manual
See Manual redialing.

Reduction mode
The MultiPASS C5000’s automatic feature that reduces the received image
to ensure it fits on the page. You can turn this feature on/off with the
Reduce to Fit Paper option in the Receive Fax dialog box of the
MultiPASS Desktop Manager.
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Registering
A process by which you place fax or telephone numbers and names in
the MultiPASS’s memory for automatic dialing so that you can save time
dialing frequently called destinations. You register numbers using the
Address Book in the MultiPASS Desktop Manager.

Regular dialing
Pressing the individual numeric buttons to dial a fax or telephone
number.

Remote receiving ID
A two-digit code that enables you to manually activate a fax using a
telephone that is connected to the MultiPASS. (The default code is 25.)

Remote reception
Activating a fax by answering a telephone that is connected to the
MultiPASS, but that is not located near the unit (such as a cordless
phone). You need to dial a remote receiving ID number to start remote
reception.

Resolution
The measurement of a printer’s quality expressed in dots per inch (dpi).
Low resolution causes font characters and graphics to have a jagged
appearance. Higher resolution means smoother curves and angles as well
as a better match to traditional typeface designs. Resolution values are
represented by horizontal data and vertical data, for example,
720 × 360 dpi.

Rotary pulse
A telephone dialing system where a dial is rotated to send pulses to 
the telephone switching system. When you pulse dial, you hear clicks.
When you touch-tone dial, the most common dialing system, you 
hear tones.

RX
See Receiving.

Sender ID
Information printed at the top of a fax (also called TTI or Transmit
Terminal ID). This data appears only if the sending fax has been
programmed with the information.

Sending
Sending transmission is also defined as TX or transmit. A fax document
that has been scanned by a fax machine and sent over telephone lines, in
the form of electrical pulses, to another fax machine is a sending
transmission. The MultiPASS C5000 also allows you to send a document
directly from your computer (PC faxing).
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Sending speed
The rate at which faxes are transmitted through the phone line. See also
bps (bits per seconds).

STANDARD
A document setting for sending normal typewritten or printed
documents containing only text and no drawings, photographs, or
illustrations.

Standby
The mode in which the MultiPASS is on and ready to use. All operations
start from Standby mode when the LCD displays the date and time.

Tone/pulse setting
The ability to set the MultiPASS to match the telephone dialing system
your telephone line uses: touch-tone or rotary pulse.

Transaction number
A unique number assigned to each fax document sent (TX NO.) or
received (RX NO.) by the MultiPASS and used to identify that particular
fax document.

Transmit
See Sending.

TrueType font
The scalable font technology built into Microsoft Windows. It offers you
the same font images both on computer displays and printer outputs.

TTI
Transmit Terminal ID. See Sender ID.

TWAIN
An industry standard that allows you to input image data directly 
from a scanner or other input device. Because your MultiPASS supports
TWAIN, you can use the scanning features of the MultiPASS with any
Windows application that also supports TWAIN.

TX
See Sending.

Typeface
The printed design of characters. For instance, Courier, Script, and
Roman typefaces all print characters of different designs.

G
lo
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Typestyle
Refers to how the typeface appears: slanted (italic) or upright.

UHQ (Ultra High Quality)
An exclusive Canon digital image processing system that incorporates 64
shades of gray along with a special edge enhancement feature which
ensures that text and photos are transmitted with ultimate clarity.



Applicable line: A-5
Arrow buttons: 1-11
Assorted Paper Starter Kit: 2-3
Attention needed status: 8-16
Attributes, scanning: 6-3
Auto feed guidelines: 2-20–21
Auto start send: 8-6
Automatic dialing: 4-4–5
Automatic Document Feeder (ADF): 1-7,

1-14, 4-2, 6-1, A-5, A-8
paper jams: 10-3–4

Automatic 
report: 8-4
retries option: 8-4
settings: 2-13

Automatically feeding paper: 2-18–21

B
B&W FAX/COPY button: 1-9–10, 4-14–15
B&W Fine: A-7
B&W PHOTO mode: 6-11, A-7
B&W TEXT mode: 6-11, A-8
Back Print Film BF-102: 1-3, 2-3,

2-17–18, 2-27–29, A-2
uncurling: 2-28–29

BC-20 Black BJ Cartridge: 1-2, 2-17,
6-10, 9-9, A-2, A-4

BC-21 Color BJ Cartridge: 9-9
BC-21e Color BJ Cartridge: 1-2, 2-17,

9-9, A-2, A-4
BC-22 Photo BJ Cartridge: 9-9
BC-22e Photo BJ Cartridge: 1-2, 2-2,

2-10, 2-29, 6-10–11, 9-9, A-4
BC-22e Photo Kit: 1-4
BC-29F Neon BJ Cartridge: 1-2, 2-29,

6-11, 9-9, A-4
BCI-21 Black BJ Tank: 1-2, A-4
BCI-21 Color BJ Tank: 1-2, A-4
Bi-directional cable: 10-25, A-3, A-8

180 × 180 dpi: 2-10
180 × 360 dpi: 6-11
360 × 360 dpi: 2-10, 6-11, A-7
486DX processor: A-9
720 × 360 dpi: 2-10

A
Accessories: 1-2-4
Active job: 7-4, 7-6
Adding 

entries, Address book: 3-12–14
pages, to document: 1-16

Address Book 
adding entries: 3-12–14
entries: 3-10–14
exporting: 3-17–18
importing: 3-15–16
setting up: 3-9–18
sorting: 3-11

ADF: See Automatic Document Feeder
Advanced 

Receive Fax options: 8-8–10
Send Fax options: 8-5–6

ALARM light: 1-9–10, 10-11
Annotation(s): 7-11–26

adding: 7-18–22
copying and pasting: 7-23–24
hiding: 7-22
including: 4-19
moving: 7-23
panel: 7-13–14
removing: 7-25
resizing: 7-23
revising: 7-22–23
showing: 7-22

Answer Machine Mode: 5-4–5
options: 8-10

Answer options: 8-7
Answering machine: 5-4–5
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BJ cartridges: 1-2–3, 9-20
contents: A-4
guidelines: 9-9–11
print head: 9-8
replacing: 9-11–15
specifications: A-4
storing: 9-19–20

BJ tanks: 1-2–3, A-4
replacing: 9-16–18
yield: A-4

Bubble Jet Paper LC-301: 1-3, 2-3,
2-17, A-2

Bulletin Board Service, Canon: 1-4

C
Calls, responding: 5-9–10
Cancel sending: 4-10
Canon 

Authorized Service Facility (ASF):
1-5, 10-1

Canada: 1-4
help: 1-4
Specialty Papers: 1-3, 2-2–3, 2-17,

2-27–34
Web site: 1-4

CARTRDIGE button: 1-11, 2-16, 9-12,
9-15–16, 9-18

Cartridge holder: 1-8, 9-14
CCITT #1 chart: A-5
CD ROM: A-9
Centronics interface: A-8
CF-102 Transparencies: 1-3, 2-3, 2-17,

2-27, A-2
CHANGE CARTRIDGE message: 9-11
Cleaning, MultiPASS C5000: 9-3–6

scanner components: 9-4–6
Cleaning sheet: 2-30–32
CODED DIAL button: 1-9–10, 4-5
Color: A-8

copying: 6-11
mode: 2-10
model: 2-8, 2-12–13
standard: A-7
versus printing speed: 2-12–14

Color Bubble Jet printer, specifications:
A-1–3

COLOR COPY button: 1-9, 4-14
COLOR COPY MEDIA option: B-1
COLOR DRAFT mode: 6-11
COLOR FINE mode: 6-11, A-7
Color printing

copying problems: 10-16–17
high quality: 2-12
quick: 2-12

COLOR SNAPSHOT mode: 6-11, A-7
COM10 envelopes: 2-24
Command 

bar: 3-3–4
buttons: 3-10

Compatibility: A-5
scanning: A-8
TWAIN: A-8

Components: 1-7–8
Concealing, region: 7-19
Contrast, setting: 4-15
Copier, specifications: A-7
Copies: 6-10
Copy 

resolution: A-7
speed: A-6

COPY button, Pagis: 6-13
Copying 

documents: 1-13, 6-1, 6-10–14
documents, operator panel: 6-10–12
documents, Pagis: 6-13–14
in color: 6-11
problems: 10-23–24
while receiving: 5-6

Cover page
attaching: 4-18
previewing: 4-18
See also Fax cover page

Cover Page Designer
opening: 4-22–23
using: 4-23–24

Custom print settings: 2-9
Customer Care Center: 1-4–5, 10-1



D
Data compression system: A-5
DATE & TIME option: B-1
Date format: 8-3
Default settings: 8-5, 8-8
Delete fax, after sending: 4-19
Desktop Manager: See MultiPASS 

Desktop Manager
Destinations: 4-11
Details tab: 2-7
Diagnostics, MultiPASS: 8-20–21
Dialing

automatic: 4-4–5
fax: A-6
regular: 4-2–4

Diffusion halftones: 2-13
Dimensions, unit: A-10
Disconnecting, MultiPASS C5000: 8-20
Display language: 8-3, A-10
Display size, adjusting: 7-16
DL envelopes: 2-24
Docking stations: 10-25
Document feed lever: 1-9, 1-16, 6-1
Document(s)

adding pages: 1-16
annotating: 7-11–26
deleting: 7-8, 8-3
display area: 7-13–14
exporting: 7-10, 7-25
highlighting: 7-21
identifying: 1-17
image, reviewing information: 7-17
importing: 7-9
moving: 7-7
MultiPASS Desktop Manager: 7-1–26
orientation: 7-15
paging through: 7-17
preparing: 1-13–16
printing, MultiPASS Desktop 

Manager: 7-2–3
printing: 2-5
receiving: 5-1–5
renaming: 7-8
saving: 7-24
sending: 4-2–10

sizes, scanning: A-8
sorting: 3-9
transmitting: 4-11–13
view, adjusting: 7-15–17
viewing: 3-8–9

DOCUMENT READY message: 4-2
Document support: 1-7
Document Viewer: 7-12

default options: 7-26
window: 7-13–15

dpi: 2-10
Draft mode: 2-10, 2-14
Drawn graphic: 7-11

creating: 7-21–22
Driver settings: 2-10
DRP service: 5-4, 5-9–10
DRPD 

feature: 5-9–10
switch options: 8-10

E
Effective scanning width: A-8
E-mail 

attaching document: 7-10
support: 1-4

Entering information, LCD menu 
system: B-2–6

Envelopes: 2-19, A-2
COM 10: 2-24
DL (European): 2-24
printable area: A-3
printing: 2-24–26

Environmental conditions: A-10
Error correction (ECM): 8-5, 8-9
Error 

status: 7-5
warning status: 8-16

European DL envelopes: 2-24
Export Tiff: 7-10
Exporting

Address Book: 3-17–18
document: 7-10, 7-25

Extension phone: 5-2
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F
Fabric Sheet FS-101: 1-3, 2-3, 2-17,

2-27, 2-32–34, A-2
drying: 2-34
printing: 2-32–34

Facsimile, specifications: A-5–6
Failed status: 7-5
Fax(es)

fine resolution: 4-14–15
header: 1-17, 8-4, 8-6
information: 8-4
memo: 4-19–20
photo resolution: 4-14–15
printing speed: A-5
quality: 4-13–15
receiving: 5-1–10
resending: 4-8
resolution: A-5
sending: 4-1–31
specifications: A-5–6
standard resolution: 4-14–15

Fax cover page
background: 4-21–22
creating: 4-24–28
deleting: 4-29
designing: 4-20–31
editing: 4-28–29
printing: 4-29–31

Fax Log 
comment: 4-19
displaying: 3-21
printing: 3-22
using: 3-21–22

Fax Only Mode: 5-2
Fax Retrieval System, Canon: 1-4
Fax Sender, identifying: 4-19
Fax sending

canceling: 4-10
messages: 4-10

Fax/Tel Mode: 5-2, A-12
switching options: 8-9

Faxing 
documents: 1-13
problems: 10-19–22

Feeding paper
automatically: 2-18–21
manually: 2-22–23

FILE PRINT function: B-1
FILE PRINT message: 5-8
Fine mode

fax: A-5
printer driver: 2-8, 2-10

Fine resolution: 4-14–15
Folder(s)

creating: 7-7
deleting: 7-8
list: 3-3–4
MultiPASS Desktop Manager: 3-6
renaming: 7-8

FUNCTION button: 1-9, 1-11, 9-8, B-3

G
General 

problems: 10-24
specifications: A-10

General tab, printer driver: 2-7
Glossary: G-1–10
Glossy Photo Paper GP-201: 1-3, 2-2,

2-11, 2-17, 2-27, A-2
Graphics 

settings: 2-10
tab, printer driver: 2-8, 2-10

Grayscale: A-8
Greeting Cards GC-101: 1-3, 2-2,

2-17, A-2
Group 

address: 3-13–14
dialing: 4-6–7
entries, Address Book: 3-11

Guide rail: 2-15, 9-12, 9-16
Guidelines

auto feed: 2-20–21
MultiPASS C5000: 9-2

H
Halftones, diffusion: 2-13
Hard disk space: A-9
Hardware, cannot initialize: 10-25



HEAD CLEANING function: 9-8, B-2
Help

Canon: 1-4
Windows 95: 2-6

High Gloss Film HG-101: 1-3, 2-3, 2-17,
A-2

High mode, printer driver: 2-10
High quality color printing: 2-12
High Resolution Paper HR-101: 1-3–4,

2-2, 2-11, 2-17, 2-29–32, 9-9, A-2
Highlighting, document: 7-11, 7-21
Home position: 9-18

I
IBM PC computer: A-9
Identifying, documents: 1-17
Idle message: 8-16
IEEE 1284-compliant: 10-25, A-3, A-8
Image 

area, scanned: A-9
color matching: 2-8
contrast: 8-6
display, adjusting: 7-16
optimizer: 2-8

Import Tiff: 7-9
Importing

Address Book: 3-15–16
document: 7-9

In Box folder: 3-6, 5-7
Individual entries, Address Book: 3-11
Ink 

color: A-4
saver mode: 8-9, A-6

Ink Cartridge Storage Box: 9-13, 9-19–20
Installing, printer driver: 2-4
InstantExchange warranty program: 1-5
Interface: 10-25, A-3, A-8

J
Jams, paper: 10-3–5
Job status: 7-4–5

L
Layout area: 4-24
LCD: A-10

display: 1-9
menu system: B-1
messages: 10-6–10

Limit mark: 2-21
Line feed speed: A-2
Line jack: 1-8
Liquid crystal display: See LCD
Listen time: 8-9
LOAD PAPER message: 1-12
Loading 

documents: 1-14–16
paper: 1-12–13, 2-18–23

Lock lever: 9-13

M
Magnetic fields: 9-2
Maintaining, MultiPASS C5000: 9-1–21
Making phone call, MultiPASS Desktop 

Manager: 8-12–13
Managing documents, MultiPASS 

Desktop Manager: 7-2–10
Manual 

Mode, receiving: 5-3
sending: 4-9

Manual feed, printer
mode: 2-22
slot: 1-8, 2-23

Manually feeding paper: 2-22–23
Media type: 2-8, 2-12–14

recommended: A-2
Memory: 2-13–14, A-9

faxes stored: 6-12
printing document: 5-5
sending: 4-2

Memory Clear Report: 10-26
MEMORY FULL message: 6-12
Menu bar: 3-3, 4-23, 7-13
Messages, LCD: 10-6–10
Microsoft Windows: See Windows
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Modem 
speed: A-5
type: A-5

Monochrome 
mode: 2-10, 2-14
printing: 2-13

MultiPASS 
diagnostics, using: 8-20–21
hardware, cannot initialize: 10-25
Printer Driver: 2-22

MultiPASS Background
adding to StartUp: 8-19
closing: 8-17–19
removing from StartUp: 8-18
restarting: 8-19

MultiPASS Desktop Manager 
closing: 3-5
documents: 7-1–26
folders, using: 3-6–8
making phone call: 8-12–13
receiving faxes: 5-7–8
scanning: 6-4–8
screen: 7-1
selecting documents: 7-2
setup: 8-1–22
specifications: A-9
starting: 3-2
system requirements: A-9
uninstalling: 8-21–22
using: 3-1–22
utilities: 8-1–22
window: 3-3–5

Multiple copies: 6-12, A-6
Multitasking: 4-1, 5-6
My Folder: 3-7–8

N
Networking, fax: A-6
No answer, telephone: 8-10
Nozzle check pattern: 9-7
NOZZLE CHECK function: B-1
Number buttons: 1-9–10, 4-2, B-5

O
Off hook alarm: 8-6
On error option: 8-6
On hold status: 7-5–6
One-touch speed dialing: 4-5

buttons: 1-9–11
On-line help, Windows 95: 2-6
Opening, Cover Page Designer: 4-22–23
Operator panel: 1-7, 2-16

copying documents: 6-10–12
using: 1-9–11

Out Box folder: 3-6, 3-9, 7-3–6
Outgoing message: 5-5
Output tray: 1-7

extension: 1-7

P
Packing materials: 9-21
Page 

orientation, printer driver: 2-8
panel: 7-13, 7-15
refinements, scanning: 6-3
type, scanning: 6-3

Pagis for MultiPASS: 6-2–4
copying documents: 6-13–14
Scan Tool window: 6-2–4
toolbar: 6-2

Paper 
guidelines: 2-4
handling: 2-2–4, A-1
jams: 10-3–5
loading: 1-12–13, 2-18–23
printable area: A-3
weight: A-2

Paper feed 
limit: 2-17
method: 2-8, 2-17
problems: 10-17–19

Paper guide, sheet feeder: 1-13, 2-20
Paper guides, ADF: 1-7
Paper output guides: 1-7, 2-29–30



Paper output tray, capacity: 2-20
Paper rest: 1-7, 1-12
Paper size: 2-8, 8-7, A-1
Paper support: 2-19
Paper tab, printer driver: 2-8
Paper thickness lever: 1-8, 2-15–18,

2-22, 2-24, 2-33
setting: 2-15–17

Paper type(s): 2-8
recommended: A-2
selecting: 2-2–3

Parallel 
cable connector: 1-8
interface: A-3, A-8

Pass-through devices: 10-25
Pause duration: 8-5
PC faxes

sending: 4-16–19
specifications: A-9

Phone call, MultiPASS Desktop Manager:
8-12–13

Phone line option: 8-4
Photo Kit: 1-4
Photo resolution: 4-14–15
Photo-realistic color printing: 2-10, 9-7
Plain paper: 2-2, 2-14, 2-19
Platen: 2-21, 9-4
Power 

consumption: A-10
cord connector: 1-8
failure: 10-26
goes out: 1-18
source: A-10

Preferences, setting up: 8-3
Preparing documents: 1-13–16
Primary colors: 2-14
Print head: 1-3, 9-3, 9-10, A-4

cleaning: 9-8
life: A-4

Print media, printer settings: 2-17
Print model: 2-8, 2-12–13
Print quality: 2-8, 2-10, 2-12–13

problems: 10-14–15
Print speed: A-2

improving: 2-13–14
Printable area: A-3

Printer 
cover: 1-8, 2-15
port, defining: 2-7
settings, print media: 2-17
setup, Windows: 2-6–11

Printer driver: 2-34
installing: 2-4
Windows 95: 2-6

PRINTER MODE message: 1-11
Printer Properties dialog box: 2-6
PRINTER RESET button: 1-11
Printing: 2-1–34

document: 2-5
envelopes: 2-24–26
methods: A-1
nozzle check: 9-7
options, specifying: 2-9
problems: 10-11–12
resolution: A-1, A-7
speed, fax: A-5
speed, versus color: 2-12–14
status: 8-16
test page: 2-7
while receiving: 5-6
width: A-2

Printing documents
memory: 5-5
MultiPASS Desktop Manager: 7-2–3

Problems: 10-1
Processor, CPU: 2-14
Properties

dialog box: 2-6
scanning: 6-3–4

Q
Quality, faxes: 4-13–15
Queued job: 7-4
Quick color printing: 2-12

R
RAM: 2-14, A-9
REC'D IN FILE message: 5-8
REC'D IN MEMORY message: 5-6
Receive conditions: 8-8
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Receive fax options: 8-7–10
advanced: 8-8–10

Receive Mode: 5-1–5, 5-10, 8-7, B-1
Receiving 

documents: 5-1–5
fax status: 8-16
telephone calls: 5-2

Receiving faxes: 5-1–10
computer off: 5-7–8
computer on: 5-7
Fax/Tel Mode: A-12
MultiPASS Desktop Manager: 5-7–8
telephone: 5-3–4

Recommended graphics settings: 2-10
REDIAL/PAUSE button: 1-9–10
Redialing: 4-7–8

canceling: 4-8
Reduction 

mode: 6-12
option: 8-7
sizes: A-6

Region, concealing: 7-19
Registering, while receiving: 5-6
Registration card: 1-5
Regular dialing: 4-2–4
Remote option: 8-10
Replacing

BJ cartridge: 9-11–5
BJ tank: 9-16–18

Report/reference, fax: A-6
Reports

automatic: 8-4
receive: 8-8

Resend option: 8-6
Resending, fax: 4-8
Resolution

printing: A-1
scanning: A-7
setting: 4-13–15

RESOLUTION buttons: 1-9, 4-14–15
Responding to calls: 5-9–10
RESUME button: 1-11
Retry status: 7-5
Ribbon cable: 2-15, 9-3, 9-12, 9-16

Ring 
patterns: 5-9
time: 8-9
tone: 8-9

ROLLER CLEANING function: B-1
Round shaft: 2-15, 9-12, 9-16
Routine maintenance: 9-3
RX MODE function: B-1

S
Safety instructions: 1-5–6
SB-21 Ink Cartridge Storage Box: 1-2,

1-4
Scan 

folder: 3-7
image size: A-9
mode: 6-5
resolution: 6-6

SCAN button: 6-2
Scanner 

components, cleaning: 9-4–6
specifications: A-7–9

Scanning: 6-1–9
attributes: 6-3
black and white options: 6-7
documents: 1-13
glass: 9-5
image processing: A-7
message: 8-16
method: A-7
MultiPASS Desktop Manager: 6-4–8
Pagis: 6-2–4
properties: 6-3–4
resolution: A-7–8
speed: A-8
width: A-8
Windows application: 6-9

Scheduled job: 7-4, 7-6
Screen matched color: 2-13
Send Fax dialog box: 4-17
Send Fax options: 8-4–6

advanced: 8-5–6
defining: 4-18–19



Sending
document: 4-2–10
multiple locations: 4-11–13
PC faxes: 4-16–19

Sending document support: 1-7
Sending faxes: 4-1–31

manually: 4-9
status: 8-16

Sent Fax folder: 3-7
Separation 

guide: 9-5
roller: 9-5

Sequential broadcasting: 4-11–13
Serial number: 10-2
Servicing, unit: 1-5
Setting tab: 2-9
Setting up

Address Book: 3-9–18
speed dial assignments: 3-18–21,

8-11
Setup 

Analyzer: 2-9, 2-11
MultiPASS Desktop Manager: 8-1–22
options: 8-2–11

Sheet feeder: 1-7, 1-12-13, 2-18, 2-20
capacity: A-1
paper jams: 10-5

Silent Receive option: 5-10, 8-7
Space requirements: A-11
Specialty papers: 1-3, 2-2–3, 2-27–34

guidelines: 2-27–29
Specifications: A-1–12
general: A-10

Speed, scanning: A-8
Speed dial 

assignments, setting up: 3-18–21,
8-11

group: 3-20–21
individual: 3-19
tab: 8-11

Speed option
receiving: 8-9
sending: 8-5

Spilled ink: 9-10
Spool settings: 2-7

Stamp: 7-11
inserting: 7-20

Stand-alone fax: B-1–6
Standard mode

fax: A-5
printer driver: 2-10

Standard resolution: 4-14–15
START/COPY button: 1-9–10, 4-3, 5-3
Starter Kit (SK-101): 2-3
Status 

bar: 7-13, 7-15
line: 3-3, 3-5, 3-10
messages, Status Monitor: 8-16

Status Monitor: 3-2
messages: 8-16
minimized: 8-14
opening: 8-14
using: 8-14–16
window: 8-15

Sticky note: 7-11
adding: 7-18

STOP button: 1-9–10
Stopped job: 7-5–6
Storing, BJ cartridges: 9-19–20
Supplies: 1-2–4
Support, Canon: 1-4, 10-1
Switch boxes: 10-25

using: 1-18
System requirements, MultiPASS 

Desktop Manager: A-9
System-defined folders: 3-6

T
Tape backups: 10-25
Technical notes, troubleshooting: 10-25
Technical support, Canon: 1-4, 10-1
TEL LINE TYPE: B-1
Telephone: A-10

calls: 5-2
option: 8-3
problems: 10-23
receiving fax: 5-3–4
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Telephone/answering machine jack: 1-8
TIFF file format: 7-9–10
Toolbar: 3-3, 4-24, 7-13–14
Transmission speed: A-5
Transmission/reception memory: A-5
Transmit Terminal Identification (TTI):

1-17
Transmitting, document: 4-11–13
Transparencies: 1-3, 2-3, 2-17–18, 2-27,

A-2
Transporting, MultiPASS C5000: 9-20–21
Trash folder: 3-7

emptying: 7-9
Troubleshooting: 10-1–26
T-Shirt Transfers TR-101: 1-3, 2-2, 2-17,

A-2
TWAIN compliant: A-8

U
U.S. Commercial number 10 envelopes:

2-24
Ultra High Quality (UHQ) image 

enhancement: A-7
Uncurling, back print film: 2-28–29
Uninstalling, MultiPASS Desktop 

Manager: 8-21–22
UNIT NAME option: B-1
UNIT TELEPHONE # option: B-1
User information, entering: B-2–6
USER SETTINGS: B-1
User-defined folders: 3-7–8
Utilities, MultiPASS Desktop Manager:

8-1–22

V
Variable fields

adjusting: 4-26–27
inserting: 4-25–26

Variables bin: 4-24
Viewing documents: 3-8–9
Volume option: 8-3

W
Warranty: 1-3, 1-5, 9-11, 10-1
Water resistant paper: 1-3, 2-3, 2-17, A-2
Web sit, Canon: 1-4
Weight, unit: A-10
White out: 7-11, 7-19
Windows 95: 2-6, 3-2, A-9

on-line help: 2-6
printer setup: 2-6–11
tabs, using: 2-7–11

Windows application
scanning: 6-9
sending faxes: 4-16–19

Windows Printing System users: 10-25
Work area: 3-3–4

Z
Zip drives: 10-25
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